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The predefined users and default passwords are shown in Table 1. 

Table 1 – Default users and passwords 

Default User Login Password 

Administrator admin 0100 

Protection and control engineer engineer 0200 

Operator operator 0300 

 

  NOTICE    

In order to ensure information security, it is recommended to change the default pass-

words before operation start. 

In case of password loss one shall inform the manufacturing enterprise. 

 

 

 

 

  

Copyright © RPE Ltd EKRA 2023. All rights reserved. 

The disclosure, duplication, distribution and editing of 

this document, or utilization and communication of the 

content are not permitted, unless authorized in writing. 

All rights, including rights created by patent grant or reg-

istration of a utility model or a design, are reserved. 

Document code: EKRA.00019-01 34 02 

Edition: 05.2023 



 

EKRASMS-SP software package manual   3 
EKRA.00019-01 34 02, Edition 05.2023 

Contents 

1 Introduction .................................................................................................................................. 5 

1.1 Purpose of this manual ...................................................................................................... 5 

1.2 Target audience ................................................................................................................ 5 

1.3 Purpose and scope of EKRASMS-SP software package ................................................... 5 

1.4 Software installation .......................................................................................................... 5 

1.5 Minimum system requirements for functioning of EKRASMS-SP software package .......... 6 

1.6 Related documentation ..................................................................................................... 7 

1.7 Support ............................................................................................................................. 9 

1.8 Address of manufacturer ................................................................................................... 9 

1.9 Training ............................................................................................................................. 9 

1.10 Safety .............................................................................................................................. 9 

2 Description of Smart Monitor interface ........................................................................................ 11 

3 Description of work with the Smart Monitor program................................................................... 30 

3.1 User administration ......................................................................................................... 30 

3.2 Replacement of device configuration and software ......................................................... 33 

3.3 Display of actual values ................................................................................................... 35 

3.4 Tools ............................................................................................................................... 48 

3.5 Service menu .................................................................................................................. 53 

3.6 Tests ............................................................................................................................... 59 

3.7 Settings ........................................................................................................................... 64 

3.8 Saving settings report .................................................................................................... 111 

3.9 Writing settings .............................................................................................................. 111 

3.10 Updating settings......................................................................................................... 111 

3.11 Saving data report via IEC 61850-8-1 protocol ............................................................ 111 

3.12 Generating signals list via Modbus .............................................................................. 111 

3.13 Generating settings report in Excel .............................................................................. 113 

3.14 Generating signals list for transmission via OPC protocol ............................................ 114 

3.15 Generating signals list for transmission via IEC 60870-5-103 protocol ........................ 115 

3.16 Generating signals list for transmission via IEC 60870-5-104 protocol ........................ 116 

3.17 Importing settings ........................................................................................................ 116 

3.18 Generating files to send............................................................................................... 117 

3.19 Possible failures .......................................................................................................... 117 

4 Description of Configurator interface ........................................................................................ 118 

5 Description of work with Configurator program ......................................................................... 123 

5.1 Description of Configurator editions ............................................................................... 123 



   
 

4   EKRASMS-SP software package manual 
EKRA.00019-01 34 02, Edition 05.2023 

5.2 Opening, saving project configuration ............................................................................ 124 

5.3 Hardware part ............................................................................................................... 126 

5.4 Logic part ...................................................................................................................... 165 

5.5 IEC 61850 ..................................................................................................................... 195 

5.6 Modbus client ................................................................................................................ 201 

5.7 Calculated values .......................................................................................................... 204 

5.8 User data....................................................................................................................... 207 

5.9 103 Protocol Master ...................................................................................................... 208 

5.10 Configuration parameters ............................................................................................ 209 

5.11 Possible failures .......................................................................................................... 212 

6 Description of Health Monitor interface ..................................................................................... 214 

Annex A Logical elements and their designation ......................................................................... 232 



 

EKRASMS-SP software package manual   5 
EKRA.00019-01 34 02, Edition 05.2023 

1 Introduction 

1.1 Purpose of this manual 

The purpose of this manual is to describe the instructions for operating and configuring the 

ED2 series devices using the EKRASMS-SP software package. 

1.2 Target audience 

This manual is intended for relay protection engineers, specialists in commissioning, testing 

and maintenance of protection, automation and control devices, operating personnel of electrical 

installations of power plants and substations. 

1.3 Purpose and scope of EKRASMS-SP software package 

The Health Monitor program is designed to monitor the state of IEDs by such service signals 

as “In service”, “Error”, “Operate” and “Communication”. Health Monitor allows you to simultaneously 

monitor the state of several IEDs. Additionally, Health Monitor can download disturbance records of 

IEDs at specified intervals, send them by e-mail, and combine disturbance records manually or 

automatically. If necessary, it is possible to switch from Health Monitor to Smart Monitor for a detailed 

analysis of the state and settings of the selected IED. 

Smart Monitor program allows you to do the following: 

– view the current state of functions, measurements and state of logic in real time; 

– change settings and parameters of IEDs; 

– update software, configurations and licenses of IEDs; 

– view and download disturbance records, event records, reports, etc.; 

– test and diagnose IEDs; 

– and debug logic in the Emulation mode. 

  When viewing disturbance records in Smart Monitor, a separate dedicated Waves software 

is automatically launched. Waves features include: 

– construction of vector diagrams; 

– harmonic analysis of signals; 

– arithmetic operations with signals; 

– combining several disturbance records into one. 

Configurator program is intended for editing configurations of ED2 devices. 

1.4 Software installation 

To download the installation file, open your web browser and go to: 

https://soft.ekra.ru/smssp/downloads/software/SMForeign/?LANG=en. 

Click Download to download the setup file. Wait for the download to finish. 

https://soft.ekra.ru/smssp/downloads/software/SMForeign/?LANG=en
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Run the downloaded installation file on your computer, the installation language selection 

window will open (Figure 1). Depending on your Windows OS settings, you may need permission to 

run, in which case contact your system administrator. 

 

Figure 1 – Installation language selection window 

Follow the instructions on the screen, the installation process will start after clicking the Install 

button. During installation, all necessary components of the EKRASMS-SP software package will be 

installed. When installation is complete, click Finish to exit the installer. 

1.5 Minimum system requirements for functioning of EKRASMS-SP software package 

а) operating systems: 

– Windows Vista SP1 or later version; 

– Windows Server 2008 (not supported as server’s main role); 

– Windows Server 2008 R2 (not supported as server’s main role); 

– Windows Server 2012 R2 (not supported as server’s main role); 

– Windows 7; 

– Windows 8; 

– Windows 8.1; 

– Windows 10; 

б) supported architectures: 

– x86; 

– x64; 

в) hardware requirements: 

1) 1.7 GHz processor or faster, 2 GB (for 32-bit system) or 4 GB (for 64-bit system) or 

more RAM; 

2) minimum required space on HDD: 

- x86 – 850 MB; 

- x64 – 2 GB; 

г) preliminary requirements: 

– Internet Explorer 6 or later, Mozilla Firefox, Google Chrome; 

– Microsoft Office 2003 or later. 

http://www.microsoft.com/windows/downloads/ie/getitnow.mspx
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1.6 Related documentation 

At different stages of the life cycle of the ED2 series devices, appropriate documentation may 

be required. The list and title of the documentation covering a certain life cycle (Figure Ошибка! 

Источник ссылки не найден.): 

– certification guide. The certification manual contains the entire list of current certificates 

and requirements that the ED2 series devices comply with; 

– catalog of device types. The catalog of standard versions of devices contains all the nec-

essary information for planning and purchasing. Contains a description of the functions and applica-

tion of each specific device of the ED2 series; 

– operation manual for a series of devices. The operation manual for a series of devices 

describes the basic principles of operation, actions for the operation and installation of devices of 

the ED2 series; 

– operation manual for a specific device version. The operation manual for a specific version 

of the device contains basic information about the installation and mounting of the device, technical 

data, permissible values of inputs and outputs, conditions for preparing the device for operation;  

– EKRASMS-SP software package manual. The manual for the software complex 

“EKRASMS-SP” describes the basic principles of working with the applied software of the ED2 series 

devices;  

– Waves software manual. The manual for working with the Waves software contains com-

plete information on working with disturbance records and their analysis; 

– communication, time synchronization and network redundancy protocols manual. The 

communication, time synchronization and network redundancy protocol manual includes a descrip-

tion of communication protocols, time synchronization protocols and methods for organizing network 

redundancy in the ED2 series devices; 

– online materials and YouTube video tutorials. Online materials and video tutorials on 

YouTube, available around the clock on the Internet, describe the basic operations for working with 

application software, operation and operations with the functionality of devices. 
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Figure 2 – Use of documents at different stages of the life cycle for the ED2 series devices 
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1.7 Support 

Manufacturer’s 
website 

https://ekra.ru/ 

 

E-mail support@ekra.ru - 

Software support 
page 

http://soft.ekra.ru/smssp/en/downloads
/software/ 

- 

Operational 
documentation 

http://soft.ekra.ru/smssp/en/downloads
/documents/ 

 

Video tutorials on 
working with ED2 
series devices 

https://www.youtube.com/playlist?list=
PLSHLRtVG8WJeMyAaGOt-
NibkO_r2eyJimN 

 

 

1.8 Address of manufacturer 

Address: STE 541, 3 Yakovlev prospect, Cheboksary, Chuvashia - Chuvash Republic, 428020, 

Russia. 

E-mail: ekra@ekra.ru 

  ekra3@ekra.ru 

1.9 Training 

KRA Training Center implements advanced training programs for products manufactured by EKRA 

Group and their applications at the facilities. Requests for training courses should be sent to: 

Address: 3 Yakovlev Prospect, Cheboksary, Chuvashia – Chuvash Republic, 428020, Russia. 

E-mail: training@ekra.ru 

https://ekra.ru/
mailto:support@ekra.ru
http://soft.ekra.ru/smssp/en/downloads/software/
http://soft.ekra.ru/smssp/en/downloads/software/
http://soft.ekra.ru/smssp/en/downloads/documents/
http://soft.ekra.ru/smssp/en/downloads/documents/
https://www.youtube.com/playlist?list=PLSHLRtVG8WJeMyAaGOtNibkO_r2eyJimN
https://www.youtube.com/playlist?list=PLSHLRtVG8WJeMyAaGOtNibkO_r2eyJimN
https://www.youtube.com/playlist?list=PLSHLRtVG8WJeMyAaGOtNibkO_r2eyJimN
file:///G:/Описание%20и%20настройка%20протоколов%20обмена%20данными/22.12.21/ekra@ekra.ru
mailto:ekra3@ekra.ru
mailto:training@ekra.ru
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1.10 Safety 

1.10.1 Warnings  

This user manual uses a warning symbol to advise the user to be careful when performing certain 

operations. 

 
NOTICE A situation that is not dangerous to life and health, but fraught with other 

undesirable consequences, for example, losses 

 

1.10.2 Instructions 

In the event of questions or problems, no further action should be taken without obtaining the re-

quired approval of the manufacturer. In this case, in order to obtain required information, it is necessary to 

send a corresponding request to the technical department of the company.  

Only professionally trained and instructed personnel may be allowed to work with the device. Im-

proper handling of the device and non-observance of safety measures can be dangerous for the operating 

personnel. 
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2 Description of Smart Monitor interface 

The Smart Monitor program uses a graphical user interface.  

Graphical user interface is multi-window with support of Drag&Drop technology, in which there is 

one main window, containing several child windows. Child windows contain main functionality of the soft-

ware. The main window contains the main menu and toolbar. 

This section contains the description of graphical interface of the program and its main elements. 

 

1.1 Functionality of the Smart Monitor program 

The Smart Monitor program is designed for: 

–  operating the ED2 series devices online; 

–  viewing current values of analog signals; 

– displaying current and voltage phasor diagrams; 

– viewing the state of binary signals; 

– viewing, changing device settings and parameters; 

– saving all device parameters and events in external files; 

– viewing the event recorder; 

– downloading disturbance records; 

– viewing the state of logic. 

 

1.2 Start 

Before starting the Smart Monitor program, you must connect the device to the PC using an avail-

able communication channel. 

The software is started using menu Start. To work with multiple devices at the same time, it is 

necessary to run a separate instance of the program. 

 

1.3 Program termination 

The program is terminated using standard methods for Windows applications: 

– ALT+F4 key combination; 

– via menu                 → Exit; 

– by clicking             on the title bar of the main window.  

 

1.4 Logging in 

After starting the Smart Monitor program, the Connection to IED window is displayed on the 

screen. The window (Figure 3) consists of three tabs: 

– TCP/IP. This tab makes it possible to connect to the device via Ethernet automatically or man-

ually. You can also select from the list of previously connected devices. To connect manually, enter the 

device's IP address and press the Connect button. For automatic connection, press Search for IEDs in 

file:///C:/Users/da-tihonova/AppData/Local/Microsoft/Users/na-egorov/AppData/Roaming/1C/1cv8/6207252a-54e5-4990-8e73-5f09fa84839c/da-tihonova/AppData/Local/Microsoft/Documents%20and%20Settings/ia-nikitina/Application%20Data/1C/1cv8/oe-vorontsova/AppData/Roaming/AppData/Local/Microsoft/AppData/Local/Microsoft/NV-Ivanov/AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/nv-ivanov.EKRA/AppData/Local/Microsoft/Windows/svn/Documents/5Executing/AnalogueMeasures.htm
file:///C:/Users/da-tihonova/AppData/Local/Microsoft/Users/na-egorov/AppData/Roaming/1C/1cv8/6207252a-54e5-4990-8e73-5f09fa84839c/da-tihonova/AppData/Local/Microsoft/Documents%20and%20Settings/ia-nikitina/Application%20Data/1C/1cv8/oe-vorontsova/AppData/Roaming/AppData/Local/Microsoft/AppData/Local/Microsoft/NV-Ivanov/AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/nv-ivanov.EKRA/AppData/Local/Microsoft/Windows/svn/Documents/5Executing/VectorsView.htm
file:///C:/Users/da-tihonova/AppData/Local/Microsoft/Users/na-egorov/AppData/Roaming/1C/1cv8/6207252a-54e5-4990-8e73-5f09fa84839c/da-tihonova/AppData/Local/Microsoft/Documents%20and%20Settings/ia-nikitina/Application%20Data/1C/1cv8/oe-vorontsova/AppData/Roaming/AppData/Local/Microsoft/AppData/Local/Microsoft/NV-Ivanov/AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/nv-ivanov.EKRA/AppData/Local/Microsoft/Windows/svn/Documents/5Executing/DiscreteValuesView.htm
file:///C:/Users/da-tihonova/AppData/Local/Microsoft/Users/na-egorov/AppData/Roaming/1C/1cv8/6207252a-54e5-4990-8e73-5f09fa84839c/da-tihonova/AppData/Local/Microsoft/Documents%20and%20Settings/ia-nikitina/Application%20Data/1C/1cv8/oe-vorontsova/AppData/Roaming/AppData/Local/Microsoft/AppData/Local/Microsoft/NV-Ivanov/AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/nv-ivanov.EKRA/AppData/Local/Microsoft/Windows/svn/Documents/5Executing/ProtectsSettings.htm
file:///C:/Users/da-tihonova/AppData/Local/Microsoft/Users/na-egorov/AppData/Roaming/1C/1cv8/6207252a-54e5-4990-8e73-5f09fa84839c/da-tihonova/AppData/Local/Microsoft/Documents%20and%20Settings/ia-nikitina/Application%20Data/1C/1cv8/oe-vorontsova/AppData/Roaming/AppData/Local/Microsoft/AppData/Local/Microsoft/NV-Ivanov/AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/nv-ivanov.EKRA/AppData/Local/Microsoft/Windows/svn/Documents/5Executing/RegSaving.htm
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local network, select the necessary device from the list that appears and press the Connect button (Fig-

ure 3);  

 

Figure 3 – Connection to IED window 

– USB. This tab automatically searches for devices connected via USB. To connect, select a de-

vice from the list and click the Connect button (Figure 4); 

 

Figure 4 – USB tab 

– COM. This tab (Figure 5) makes it possible to connect to the device via the COM port. To con-

nect it is necessary to do the following: 

1) select a COM port and the port speed from the drop-down list; 

2) click on the Search button; 

3) select the required device and click the Connect button. 
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Figure 5 – COM tab 

After connecting to the device, a standard program window is displayed on the screen (Figure 6). 

The standard window contains the following elements: 

– title bar (item 1); 

– main menu (item 2); 

– toolbar (item 3);  

– bottom toolbar (item 4);  

– device “tree” (item 5); 

– work area (item 6); 

– right toolbar (item 7). 

The title bar displays the name of the device, the IP address of the connected device, and buttons 

for collapsing, expanding, and closing the window. The bottom toolbar contains information about the op-

eration mode, the left one contains the “tree” of the device. 

The work area of the main program window (Figure 6, item 6) contains brief information about the 

device, the right part (Figure 6, item 7) contains general information about the device, its state and con-

nection. 
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Figure 6 – Standard window of the program 

Without user authentication, the use of some program functions is unavailable (Figure 7). 

 

Figure 7 – Use of the program without authentication 

To authenticate the user, click button         . The user authentication form is shown in Figure 8. 

1 

3 

4 

5 6 7 

2 
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Figure 8 – User authentication form 

In order to log in, you must enter a login and a password. 

Each user has corresponding access rights. The access rights are assigned by the administrator. 

If incorrect data is entered, a message is displayed (Figure 9). The user with administrator rights 

can add, remove, and edit user rights (subsection 3.1). 

 

Figure 9 – Error window 

1.5 Title bar of the main window  

The title bar of the main window consists of the following elements (Figure 10): 

– buttons of system menu; 

– program name; 

– device name; 

– device IP-address. 

 

Figure 10 – Title bar of the main window 

 

1.6 Main menu 

The main menu is located under the title bar of the main window and looks as follows                .  

The main menu is linked to the submenu (Figure 11). The submenu appears when you press the 

left mouse button on a menu item.  
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Figure 11 – Submenu of the main menu 

Commands of the main menu and their functions are shown in Table 2. 

Table 2 – Commands of the main menu 

Command Function 

Open configuration... Opening the existing device configuration 

Open offline archive Opening the existing archive 

Recent files Displaying and opening recent projects 

Save configuration... Saving the existing device configuration 

Update configuration... Updating device configuration 

Save software... Saving the existing device software 

Update software... Updating the device software 

Export SCL file Exporting SCL file *.cid, *.icd 
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Command Function 

Export settings as xml… Exporting device settings as an xml file  

Import settings from xml… Importing settings from an xml file to the device 

Download Shlib.lzg file 
Saving the Shlib.lzg file (library file) of the device to the 
computer 

Download security log from IED 
Saving the information security event log of the device to 
the computer 

Generate files to send Saving the files to send to the computer 

Generate offline archive Generating an archive file  

Generate security log 
Generating an information security event log of the Smart 
Monitor program 

Exit Exiting the Smart Monitor program 

The command associated with the corresponding menu item is activated by pressing the left mouse 

button on the menu item. An icon (displayed to the left of the menu command name) can be associated 

with the command. 

 

1.7 Toolbar 

The toolbar provides an alternative way to access frequently used commands. It consists of the 

Main, Settings, Service and Help tabs and looks as follows (Figures 12-15): 

 

Figure 12 – Main tab 

 

Figure 13 – Settings tab 

 

Figure 14 – Service tab 
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Figure 15 – Help tab 

Commands available on the toolbar commands are shown in Table 3. 

Table 3 – Toolbar commands 

Icon Name 

Main tab 

 

Connect to the device 

 

Disconnect from the device 

 
 
, 

Communication with the device is present/absent 

 

Execute a command: 

 Start oscillography; 

 Reset alarms; 

 Set divice date and time. 

 

Refresh current page 

 

Pause page refresh 

 

Read configuration from the device. All unsaved changes will be lost 

 

Write settings to the device  

 

Generate a report on settings and communication protocols 

 
Selecting setting group 

 
Selecting the mode of displaying settings  

file:///C:/Users/da-tihonova/AppData/AppData/AppData/Local/Microsoft/Users/na-egorov/AppData/Roaming/1C/1cv8/6207252a-54e5-4990-8e73-5f09fa84839c/da-tihonova/AppData/Local/Microsoft/Documents%20and%20Settings/ia-nikitina/Application%20Data/1C/1cv8/oe-vorontsova/AppData/Roaming/AppData/Local/Microsoft/AppData/Local/Microsoft/NV-Ivanov/AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/nv-ivanov.EKRA/AppData/Local/Microsoft/Windows/svn/Documents/5Executing/SettingsUpdate.htm
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Icon Name 

 

Device state 

 

User. It contains a list of submenus: 

– User administration; 

– Change a password; 

– Exit 

Settings tab 

 

Program settings 

 

Color theme  

 

Active profile 

Service tab 

 

Conver disturbance records to COMTRADE  

 

Error report 

 

Download a log 

 

Decrypt an IS log 

 

Activation of service functions 

Help tab 

 

Information about the program 

 

Note – The Activate service functions command is available only after entering the activation key of ser-

vice functions. 
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1.7.1 Home tab 

The Commands menu includes the following elements: 

– start disturbance recorder. The command is intended for manual start of disturbance recorder 

on the device. The command execution window is shown in figure 16; 

 

Figure 16 – Start disturbance recorder command window 

– reset alarm. The command is intended to reset the state of latching signals for LEDs, relays, the 

state of output signals of latching logic for transmission to the PCS. The command execution window is 

shown in figure 17; 

 

Figure 17 – Reset alarm command window  

– set date and time. The command window is shown in figure 18. When setting the date and time, 

you must enter a password. 

 

Figure 18 – Set time and date command window 

The Reports menu contains a list of submenus for generating various types of reports (table 4). 

Table 4 – List of the Reports command submenus 

Icon Description 

Settings report Generation of a report on settings in TXT format 

Settings report in Excel Generation of a report on settings in Excel format 

Modbus data description 
Generation a list of signals for data transmission via Modbus proto-
col in Excel format 

file:///C:/Users/da-tihonova/AppData/AppData/AppData/Local/Microsoft/Users/na-egorov/AppData/Roaming/1C/1cv8/6207252a-54e5-4990-8e73-5f09fa84839c/da-tihonova/AppData/Local/Microsoft/Documents%20and%20Settings/ia-nikitina/Application%20Data/1C/1cv8/oe-vorontsova/AppData/Roaming/AppData/Local/Microsoft/AppData/Local/Microsoft/NV-Ivanov/AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/nv-ivanov.EKRA/AppData/Local/Microsoft/Windows/svn/Documents/Описание%20программ/HTMLHelp/ARM/5Executing/SettingsReportSave.htm
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Icon Description 

List of signals in PCS (OPC identifiers) 
Generation of a list of signals for data transmission via  
OPC protocol in Excel format 

IEC 60870-5-103 protocol data 
Generation of a list of signals for data transmission via  
IEC 60870-5-103 protocol in Excel format 

IEC 60870-5-104 protocol data 
Generation of a list of signals for data transmission via  
IEC 60870-5-104 protocol in Excel format 

IEC 61850-8-1 protocol data 
Generation of an Excel file with a list of signals transmitted via  
IEC 61850-8-1 protocol 

Settings sheet Generation of a settings sheet 

Modbus parameters in xml Generation of Modbus parameters 

 

1.7.2 Settings tab 

The Settings command window consists of two tabs. The description of parameters is shown in 

table 5. 

Table 5 – Description of parameters of the Settings command 

Parameters Description 

General tab (figure 19) 

Auto connect upon start 
Select Auto connect when starting the Smart Monitor program. 
The connection is made to the device with which communication 
was carried out during the last session 

Send statistics and errors to developers Selection of sending statistics and errors to developers 

Show “Information” panel Selection of display of the “Information” panel 

Interface scale Selection of the interface scale 

Program language 

Selection of the program language. The following languages are 
available: 
– Ru (Russian); 
– En (English) 

Disturbance record viewer Selection of the viewer of disturbance records 

IEDs 2xx tab (figure 20) 

Expand logic for protections 
Selection of expanding logic for protections (the Logic menu 
item will contain sub-items corresponding to the frames in the 
general diagram) 

Disable advanced file transfer features via 
Modbus 

Disable advanced Modbus file transfer features  
(used for compatibility with protocol converters) 

Create and edit profiles Create and edit profiles 

 



   
 

22   EKRASMS-SP software package manual 
EKRA.00019-01 34 02, Edition 05.2023 

 

Figure 19 – General tab 

 

Figure 20 – IEDs 2xx tab 

The Create and edit profiles command (figure 21) allows adding and deleting profiles using but-

tons           and          . Methods for editing the device tree menu are presented in table 6. 
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Figure 21 – Create and edit profiles window 

Table 6 – Methods for editing the menu field 

Icon Description 

 
Minimize the menu 

 
Maximize the menu 

 
Move the item up 

 
Move the item down 

 
Move one level up 

 

The Color theme command (Settings tab) is used to select the program theme. The following 

color schemes are available: 

– Dark 1; 

– Dark 2; 

– Light; 

– Grey 1; 

– Grey 2; 

– Blue. 

Using the Profile command (Settings tab), it is possible to select a device tree profile that will be 

used when Smart Monitor is running. 
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1.7.3 Service tab 

The Convert to COMTRADE command is used to convert disturbance records from the internal 

format to the Comtrade format. 

You can use the Error report command to report a bug in the Smart Monitor program or a sugges-

tion for improving Smart Monitor. To do this, it is necessary to fill out the form (figure 22). 

 

Figure 22 – Service tab 

The Download log commandallows saving log files maintained by the Smart Monitor program as 

an archive in *.zip format. 

The Activate service functions command after entering the registration key allows you to access 

additional tools (for example, Memory card, File manager, IED logs, etc.). 

 

1.7.4 Help tab 

Using the About command you can obtain brief information on this program (figure 23). 

 

Figure 23 – About command window 
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1.8 Status bar 

The status bar (figure 24) is located in the lower part of the main window. 

By default, the status bar displays information on the mode. The following operating modes are 

provided for the device: 

– No connection – mode in which there is no connection to the device; 

– Adjustment – mode with extended functionality; 

– File – mode when opening a configuration file or opening an offline archive. 

 

Figure 24 – Status bar 

 

1.9 Function windows 

Function windows are the main window’s child windows which are opened when selecting the ele-

ments in the device tree. 

Function windows may contain additional panels (pop-up windows), which can be hidden via con-

text menu of windows. They can also be embedded in various parts of the function window (right, left, top, 

bottom, etc.) by dragging through the window titles (figure 25). To the right of the title, pop-up windows 

have a button , that can be used to minimize the window. 

Options for setting the user interface make it possible to arrange program windows and panels in 

the most convenient way. 

The Drag&Drop technology allows the user to adjust the size of program windows using the mouse. 

To perform this operation, move the mouse pointer to the border of the target window until the shape of 

the mouse pointer changes to a double-sided arrow. From now on, you can resize by pressing the left 

mouse button and moving it in the desired direction. Then release the left mouse button. 

Arrangement of windows can be changed using mouse by dragging the window by its title or using 

functions of the system menu.  
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Figure 25 – Example of a function window 

1.10 Menu panel of the device 

The menu window of the device is located in the left part of the program window. The default tree 

menu for the ED2 series devices is shown in figures 26, 27. To go to the previous window or one level up, 

use buttons  respectively. 
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Figure 26 – ED2 series device tree menu 
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Figure 27 – ED2 series device tree menu
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The operations will be activated by selecting the corresponding element of the tree. 

You can minimize/maximize the tree by clicking the right mouse button on the tree element and 

selecting the corresponding command (figure 28) or by double-clicking the left mouse button on the ele-

ment. To open a menu/submenu in a new window, right-click on the element of the tree. Next, a copy of 

the application is launched with the installation of the selected menu item.  

 

Figure 28 – Context menu of the tree 

The tree provides the user with the ability to conveniently navigate between program modes. A 

single click of the left mouse button on an element opens the element in the current child window.  

“Opening a tree element” means opening the content corresponding to the given tree element in a 

child window. 

The tree elements are divided into two groups: 

1) Mode group element, which contains a group of modes and function windows. It is a branch of 

the tree. 

The purpose of the element is a logical grouping of modes. Each element is visually connected to 

the tree through icon  or . Icon  stands in front of a minimized group, and  – in front of a maximized 

one. Pressing the left mouse button on this icon will cause the corresponding group to minimize/maximize. 

Opening this element in a child window is a listing of the contents of the group. 

2) Mode element, which represents a specific mode of the program (function window). It is a leaf 

of the tree. 

The purpose of the element is to activate the required mode of the program. Opening of this ele-

ment is the opening of corresponding function windows. 
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3 Description of work with the Smart Monitor program 

3.1 User administration 

Administration of system users is intended for adding, changing, deleting users and groups, as well 

as setting access rights for user groups.  

User administration is available only after administrator authentication. 

The administration center window is opened by users from the main window with button on 

the toolbar.  

The window (figure 29) consists of three tabs: 

– Users; 

– Groups; 

– Rights. 

 

Figure 29 – User administration window 

3.1.1 Users 

Operations on user accounts are performed in this tab. 

Operations are available via toolbar . 

Editing, deleting and changing user password are available only after selecting the corresponding 

user from the list.  
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Login can consist of the following characters: “A – Z”, “a – z”, “0 – 9”, “_”. The maximum quantity 

of login characters is 16. The password can only consist of characters “0 – 9”. Quantity of password char-

acters is 4 – 16. 

A new user is added by pressing button . In this case, in the displayed window (figure 30) it is 

necessary to enter the data of the new user. 

 

Figure 30 – Create a new user command window 

A user is deleted by pressing button . A dialog box will appear to confirm deletion. 

The password and the number of active sessions is changed by pressing button . In this 

case, in the displayed window (figure 31) it is necessary to enter a new password. 

 

Figure 31 – New password command window 

After entering a new password, it is necessary to enter the quantity of active sessions (figure 32). 

The Set number of active sessions command sets a limit on the maximum quantity of parallel sessions 

with the device. 

 

Figure 32 – Set number of active sessions window 
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Entering the password expiration date is shown in figure 33. In this case, in the displayed window, 

it is necessary to enter the quantity of days during which the password will be active. Quantity of days: 

1) 0 – password never expires; 

2) 999 – maximum value. 

  

Figure 33 – Password expiration window 

3.1.2 Groups 

This tab is used to perform operations on groups. 

Operations are available via toolbar .  

Editing and deleting a group is available only after selecting the corresponding group from the list. 

The name of the group can be edited by clicking the left mouse button on the name. 

A new group is added by pressing button . In this case it is necessary to enter a name for the 

new group in the displayed window (figure 34). Once added, the new group will appear on the Users and 

Rights tabs in the Groups column. 

 

Figure 34 – Create a new group window 

A group is deleted by pressing button  after excluding all users from the group. A dialog box 

will appear to confirm deletion. 
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3.1.3 Rights 

This tab (figure 35) is designed for assigning permissions and access rights for user groups. 

 

Figure 35 – Rights tab 

The permission is controlled by setting/clearing the pluses “+” in the cell of the rights table in the 

column of the required group. 

3.2 Replacement of device configuration and software 

Device configuration1) and software can be replaced only if you have the corresponding access 

rights (see 3.1.3). The device communication port used to work with Smart Monitor must have write per-

mission. 

 

 

 

 

                                                

1) Configuration file is a file of device software settings that contains a description of the hardware, set 
of functions, logic and mimic diagram. 
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NOTICE 

Before replacing the configuration and software, it is necessary to take the device out of  

operation or prevent false influence of the device on external circuits! 

 

3.2.1 Replacement of software 

3.2.1.1 Start the Smart Monitor program and establish connection with the device. 

3.2.1.2 Device software is replaced via menu item               → Update software…. When you 

select this item (figure 11) a dialog box (figure 36) is displayed in which you must specify the path to the 

core.arh or sh.rtb file, then confirm the selection by clicking the Open button. If the version of the selected 

file is incorrect, a corresponding entry will appear in the dialog box. 

 

Figure 36 – IED software update window 

3.2.2 Wait until the file is copied. 

3.2.2.1 When copying is completed, an information window is displayed.  

3.2.2.2 Restart the device by power supply. 

 

3.2.3 Replacement of configuration 

3.2.3.1 Start the Smart Monitor program and establish connection with the device. 

3.2.3.2 Device configuration is replaced via menu item → Update configuration…. 

When this item is selected, a dialog box (figure 37) is displayed in which you must specify the path to the 

xxxx.arh configuration file. The name of the loaded configuration file must match the name of the config-

uration file on the device. If the configuration contains incorrect versions, an error message will be dis-

played. 
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Figure 37 – IED configuration update window 

3.2.3.3 Wait until the file is copied.  

3.2.3.4 When copying is completed, an information window is displayed (figure 38).  

 

Figure 38 – Information window 

3.2.3.5 Restart the device by power supply. 

3.3 Display of actual values 

3.3.1 Actual values of analog inputs 

The Analog inputs window (figure 39), device tree menu Actual values → Analog inputs, is 

designed to display the actual values of analog inputs (circuits). The Analog inputs window consists of a 

table of measurements of circuit values and an additional window of phasor diagram. 

By clicking the right mouse button on the required analog measurement, the base phasor (fig-

ure 39, item 1) is selected in the tab, relative to which current values of the angles of other phasors are 

calculated. When you press the left mouse button in the tab, other analog measurements are highlighted 

in green (figure 39, item 2). It is possible to decrease or increase the digit capacity of values using buttons 

 (figure 39, item 3). 
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Figure 39 – Analog inputs window 

Fields of the circuit value measurement table are shown in table 7. 

Table 7 – Circuit value measurement table 

Name Designation 

Base angle Base angle, relative to which the calculation is made for other analog values 

No. Sequence number of the circuit  

Name Circuit name 

Primary value Secondary value of the analog signal multiplied by the transformation ratio 

Secondary value Values of current or voltage coming to analog inputs of the device 

Relative value Ratio of the actual value of the signal to its circuit rating 

Angle, ˚ Phase angle of the analog signal relative to the base phasor, in degrees 

Frequency 
Frequency of a signal in Hz: 
– for frequency groups – measured frequency; 
– for zero frequency group – allocated frequency 

Color Phasor color on the phasor diagram 

 

The phasor diagram is located on the right side of the Analog inputs window. Using button  it 

is possible to control location of the open Phasor diagram tab (figure 40) on the page. To display a phasor 

on a phasor diagram, you need to set a color for it (figure 39, item 4).  

1 

2 

4 

3 
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Figure 40 – Phasor diagram tab 

3.3.2 Actual values of data sets 

The Data sets window (figure 41), device tree menu Actual values → Data sets, is designed to 

display actual values of the specified data sets. 

 

Figure 41 – Data sets window 
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3.3.3 Actual values of binary signals 

3.3.3.1 Logic signals 

The Logic signals window (figure 42), device tree menu Actual values → Binary signals → 

Logic signals, is designed to display actual values of logic signals. 

 

Figure 42 – Logic signals window 

The description of parameters of logic signals is given in table 8. 

Table 8 – Description of parameters of logic signals 

Parameter Description 

No. Sequence number of the logic signal 

Name Name of the logic signal 

Value Current value of the logic signal 

Alarm type 

Alarm of the logic signal: 
– Warning alarm (yellow square); 
– Emergency alarm (red square); 
– No alarm 
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3.3.3.2 Binary inputs 

The Binary inputs window (figure 43), device tree menu Actual values → Binary signals → 

Binary inputs, is designed to display actual state of binary inputs. 

 

Figure 43 – Binary inputs window 

3.3.3.3 Binary outputs 

The Binary outputs window (figure 44), device tree menu Actual values → Binary signals → 

Binary outputs, is designed to display actual state of binary outputs. 

 

Figure 44 – Binary outputs window 
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3.3.3.4 CP signals 

The CP signals window (figure 45), device tree menu Actual values → Binary signals → CP 

signals, is designed to display actual state of communication processor signals. 

 

Figure 45 – CP signals window 

The description of parameters of CP signals is given in table 9. 

Table 9 – Description of parameters of CP signals 

Parameter Description 

No. Sequence number of the CP signal 

Name Name of the CP signal 

Value Actual value of the CP signal 

Alarm type 

Alarm of the CP signal: 
– Warning alarm (yellow square); 
– Emergency alarm (red square); 
– Information (green square) 

 



 

EKRASMS-SP software package manual   41 
EKRA.00019-01 34 02, Edition 05.2023 

3.3.3.5 FP signals 

The FP signals window (figure 46), device tree menu item Actual values → Binary signals → 

FP signals, is designed to display actual state of functional processor signals. 

 

Figure 46 – FP signals window 

The description of parameters of FP signals is given in table 10. 

Table 10 – Description of parameters of FP signals 

Parameter Description 

No. Sequence number of the FP signal 

Name Name of the FP signal 

Value Value of the FP signal 

Alarm type 

Alarm of the FP signal: 
– Warning alarm (yellow square); 
– Emergency alarm (red square); 
– Information (green square); 
– No alarm 
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3.3.3.6 LEDs 

The LEDs window (figure 47), device tree menu Actual values → Binary signals → LEDs, is 

designed to display actual state of device LEDs.  

 

Figure 47 – LEDs window 

The description of parameters of the LEDs window is given in table 11. 

Table 11 – Description of parameters of the LEDs window 

Parameter Description 

No. Sequence number of the LED 

Color LED color 

Latching Latching of the LED 

Name Name of the LED 

Value Actual state of the LED 
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3.3.3.7 SV diagnostic signals 

The SV diagnostic signals window (figure 48), device tree menu Actual values → Binary sig-

nals → SV diagnostic signals, is designed to display diagnostic signals of sampled values module (pro-

tocol of the IEC 61850 standard). 

 

Figure 48 – SV diagnostic signals window 

 

3.3.4 Calculated values 

The Calculated values window (figure 49), device tree menu Actual values → Calculated val-

ues, is designed to display actual calculated values. Calculated values are values added by the user that 

are calculated during operation of the device. There are two types of calculated values: analog and logic. 

  

Figure 49 – Calculated values window 
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3.3.5 ADC measurements 

The ADC measurements window (figure 50), device tree menu Actual values → ADC measure-

ments, is designed to display actual values of the signals coming to analog to digital converter channels. 

The latest version devices use only fine channels (even channel numbers of the corresponding ADC). 

 

Figure 50 – ADC measurements window 

The description of parameters of the ADC measurements window is given in table 12. 

Table 12 – Description of parameters of the ADC measurements window 

Parameter Description 

Base angle Base angle 

No.  Channel number of the corresponding ADC 

Absolute value  Absolute value of the signal component coming to the corresponding ADC channel  

Angle, ˚  Angle of the signal component coming to the corresponding ADC channel, in degrees 
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3.3.6 HF channel measurements 

The HF channel measurements window (figure 51), device tree menu Current values → HF 

channel measurements, is designed to monitor the states of the HF channel and its own HF transmitter. 

The menu available only in devices with teleprotection equipment functionality. 

 

Figure 51 – HF channel measurements window 

The description of parameters of the HF channel measurements window is given in table 13. 

Table 13 – Description of parameters of the HF channel measurements window 

Parameter Description 

SS level at HF input Level of the security signal at the HF input 

Command signal level at HF input 
Estimated level of the command signal at the HF input (determined by the 
difference between the set command level and current level of the security 
signal) 

Noise level in 4 kHz band Level of noise in the operating 4 kHz band 

SS level margin 
Estimated margin of the security signal level. Margin is defined as the dif-
ference between the SS level at the HF input and sensitivity of  
the HF receiver 

Command signal level margin 
Estimated margin of the command level. Margin is defined as  
the difference between the estimated level of a command signal  
at the HF input and sensitivity of the HF receiver 

SNR margin 
Estimated margin of the SNR level. The margin is defined as the difference 
between the estimated SNR level and the SNR threshold for blocking 

SNR level 
Estimated level of SNR. The SNR level is defined as the difference  
between the estimated level of command signal and noise level in the 
4  kHz band 

Voltage at HF output Voltage at the HF output of the IED, measured by the built-in voltage meter 

Current at HF output Current at the HF output of the IED, measured by the built-in current meter 

 

3.3.7 State of measuring elements 

The Measuring elements status window (figure 52), device tree menu Actual values → Meas-

uring elements status, is designed to monitor the state of measuring elements. The Measuring elements 

status window consists of a table of measurements of circuits, logic, phasor diagram and characteristic 
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curve. The availability and the set of measuring elements depends on device configuration. Work with a 

phasor diagram is described in 3.3.1.  

 

Figure 52 – Measuring elements status window 

The description of measuring elements status parameters is given in table 14. 

Table 14 – Description of measuring elements status parameters 

Parameter Description 

Name Name of the value 

Value Value of the variable 

Rel. value Relative value of the variable 

Color Phasor color on the phasor diagram 
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3.3.8 Logic 

The Logic window (figure 53), device tree menu item Actual values → Logic, displays the state 

of all logic components in real time. The red color indicates the state of signals corresponding to the logical 

“1”. 

 

Figure 53 – Logic window 

The toolbar allows you to scroll the diagram using the Hand tool, zoom and search the logic dia-

gram (figure 53, item 1).  

When you click on button   a search field will appear (figure 53, item 2). The search is possible 

by the name of elements or by the name of addresses. The search result is highlighted in blue (figure 53, 

item 3). 

Also, the scale of the logic diagram can be changed using buttons ,  (figure 53, item 4).  

 

1 

2 

4 

3 
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3.4 Tools 

3.4.1 Event recorder 

The Event recorder window (figure 54), device tree menu item Tools → Event recorder, is de-

signed to display records of the event recorder. 

 

Figure 54 – Event recorder window 

Parameters of the Event recorder window are shown in table 15. 

Table 15 – Parameters of the Event recorder window 

Name Description 

View 

Display options: 
– Table; 
– Diagram; 
– Table and diagram 

Period Filtering events by time (issue events for a specified time interval) 

Displayed Displayed events 

Groups 

Filtering events by groups. Only those events that belong to the selected 
group are displayed: 
– All; 
– Service FP signals status; 
– Logic signals; 
– Binary inputs; 
– Measuring elements input/output; 
– Binary outputs; 
– Service CP signals status; 
– Calculated values; 
– Incoming GOOSE 

Export Saving events in Excel or Html format 

Filter by name Filtering events by name 

No. Number of the event 

Date  Date of the event 

Time Time of the event 

Group Group of the event 
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Name Description 

Status State of the event 

Name Name of the event 

Value Value of the event 

 

3.4.2 Disturbance records 

The Disturbance records window (figure 55), device tree menu item Tools → Disturbance rec-

ords, is designed to work with disturbance records of the device. 

 

Figure 55 – Disturbance records window 

Parameters of the Disturbance records window are shown in table 16. 

Table 16 – Parameters of the Disturbance records window 

Column Description 

File Name of the generated disturbance record 

 
Disturbance record overwrite protection 

Size  Size of the disturbance record in bytes 

Date/Time Date and time of disturbance record generation 

 

A disturbance record can be opened by right-clicking on the file of the required disturbance record 

and selecting the corresponding command (figure 56) or by double-clicking the left mouse button on the 

file of the required disturbance record. The disturbance record opens in the viewer program, the path to 

which was specified in line “Disturbance record viewer” (figure 19).  

 

Figure 56 – Context menu of the Disturbance records window 

Commands of the context menu of the Disturbance records window are shown in table 17. 
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Table 17 – Commands of the context menu 

Column Description 

Open Open the disturbance record 

Open in Comtrade Open the disturbance record in Comtrade format 

Save 
Save the disturbance record in .a0011 format (internal format that is converted to 
Comtrade) 

Save as Comtrade Save the disturbance record as Comtrade 

FLOC report FLOC report (available if the device has the FLOC function) 

 

3.4.3 Switching devices 

The Switching devices window (figure 57) is designed to view the settings of switching devices 

and monitor the switching and mechanical service life of SD. The Switching devices window consists of 

two parts. The upper part of the window contains brief information about the SD settings, the bottom part 

of the window contains information about events of the selected switching device and service life of the 

selected SD setting.  

 

Figure 57 – Switching devices window 

Parameters of the Switching devices window are shown in table 18. 

Table 18 – Parameters of the Switching devices window 

Parameter Description 

No. Number of the switching device 

Name Name of the switching device 

Type 

Type of the switching device: 

– Circuit breaker; 

– Disconnector 

Position signaling 

Signaling of the position: 

– Three-phase; 

– Single-phase 

Switching device Events Events belonging to the selected switching device 

Switching device Service life 
final 

Service life belonging to the switching device at the time of the event selected 
on the Switching device Events window 
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Parameter Description 

Position  
There are four SD positions (Closed (10), Tripped (01), Undefined (00),  
Failure (11)) 

Enable closing 

Displays the state of related signals (Imos) that have been set  
for the switching device. If Imos is specified, then “1” or “0” is displayed 

Enable tripping 

Local control 

 

3.4.4 File Manager 

The File Manager window (figure 58), device tree menu Tools → File Manager, is designed to 

work with the file system. The window consists of two panels. The left panel refers to the file system of the 

local disk, the right panel refers to the file system of the IED. 

 

Figure 58 – File Manager window 

Parameters of the File Manager window are shown in table 19. 

Table 19 – Parameters of the File Manager window 

Column Description 

File name Name of the file system element (file, directory) 

Type File extension 

Size  File size in bytes 

Date Date and time the file was last modified 

 

Note – The File Manager window is available when you enter the service function activation key. 
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3.4.5 Working with IED documents 

The IED documents window (figure 59), device tree menu item Tools → IED documents is de-

signed to work with documents that have been loaded into the device by the user. Here you can store 

circuit diagrams, function diagrams, setting lists and other files related to the device. 

 

Figure 59 – IED documents window 

Parameters of the IED documents window are shown in table 20. 

Table 20 – Parameters of the IED documents window 

Column Description 

File name Name of the file system element (file, directory) 

Type File extension 

Size  File size in bytes 

Date Date and time the file was downloaded to the device 

 

The context menu (figure 60) allows you to open, save, load and delete files. The context menu 

can be opened by right-clicking on the required file. You can download the required file by double-clicking 

the left mouse button on the file. 

 

Figure 60 – Context menu of the IED documents window 

When deleting files, a confirmation request for deletion opens (figure 61). If the answer is yes, 

marked files will be deleted from the file system. 
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Figure 61 – Confirmation request for file deletion 

3.4.6 IED logs 

The IED logs window (figure 62), device tree menu item Tools → IED logs, is designed to view 

event records. 

-  

Figure 62 – IED logs window  

3.5 Service menu 

3.5.1 ADC calibration  

To open the Factors and Zero offsets windows, click “Get started”. 

3.5.1.1 Factors  

The Factors window (figure 63), device tree menu item Service → ADC calibration → Factors, 

is designed for setting the values of ADC factors.  
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Figure 63 – Factors window 

Commands available on the toolbar are shown in table 21. 

Table 21 – Toolbar commands 

Icon Name 

 

Enable calibration mode 

 

Write the values of ADC factors to the module 

 

Return previous values of ADC factors 

 

Export values of ADC factors 

 

Import values of ADC factors 

 

Set the value of all ADC factors 

 

Check all channels of the current module in the current range 
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3.5.1.2 Zero offsets 

The Zero offsets window (figure 64), device tree menu item Service menu → ADC calibration → 

Zero offsets, is designed to calculate the zero offset. 

 

Figure 64 – Zero offset window 

Commands available on the toolbar are shown in table 22. 

Table 22 – Toolbar commands 

Icon Name 

 

Calculate offsets for selected channels for all bands 

 

Write values to the module 

 

Return previous values 

 

Export values 

 

Import values 

 
Reset the value  

 

Check all channels of the current module in the current range 
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3.5.2 Memory card 

The Memory card window (figure 65), device tree menu item Service menu → Memory card, is 

designed to view the IED memory. 

 

Figure 65 – Memory card window 

Parameters of the Memory card window are shown in table 23. 

Table 23 – Parameters of the Memory card window 

Column Description 

HEX address 

Address of the beginning of the viewed memory area in decimal and hexadecimal form 

DEC address 

Word count Quantity of words viewed 

Mode 

Memory data display modes: 
– Word16 (in the form of words occupying 16 bits in memory); 
– Word32 (in the form of words occupying 32 bits in memory); 
– Float (as a floating-point number); 
– InvFloat (as a floating-point number in inverse form: the low and high bytes  
in the word are swapped) 

Set Entering a new area in the memory card 

Add Creating a new memory area 

Note – The Memory card window is available when you enter the service function activation key. 

 

3.5.3 Communication diagnostics 

The Communication diagnostics window (figure 66), device tree menu item Service menu → 

Communication diagnostics, is designed to view statistics of the operation of the device’s communica-

tion protocols. The window contains a drop-down list of protocol selection and a table of counters. When 

the protocol is selected, the program automatically starts polling and displaying information on the screen 

with a frequency of 1 s. 
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Figure 66 – Communication diagnostics window 

3.5.4 FP diagnostics 

The FP diagnostics window (figure 67), device tree menu item Service menu → FP diagnostics, 

is designed to view parameters of the function processor. 

 

Figure 67 – FP diagnostics window 
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3.5.5 Hardware configuration of modules 

The Hardware configuration window (figure 68), device tree menu item Service menu → Hard-

ware configuration, allows you to view service parameters of device modules. 

 

Figure 68 – Hardware configuration window 

The description of columns is given in table 24. 

Table 24 – Description of columns of the Hardware configuration window 

Name Description 

Name Name of the module 

Type Type of the module 

Bar code Bar code of the module 

Code Code of the module 

Module group/number Number of the module 

Module PL version/number Number of module packing list 

Board version Version of the board 

Module loader version, hex Version of the module loader 

Module HC version Version of hardware configuration of the module 
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3.5.6 Module diagnostics 

In the Module diagnostics window (figure 69), device tree menu Service menu → Module diag-

nostics, the health of device modules is displayed. 

 

Figure 69 – Module diagnostics window 

The description of columns is given in table 25. 

Table 25 – Description of columns of the Module diagnostics window 

Name Description 

Name Name of the module 

Type Type of the module 

Status State of the module 

 

3.6 Tests 

3.6.1 Logic testing 

The Logic testing window (figure 70), device tree menu Tests → Logic testing, allows you testing 

logic elements – time delays. It also allows you to output any logic signal to the test relay. 

In order to switch to the test mode, click the Enable button. The “Test mode Enabled” message will 

appear. 

 

NOTICE 

When testing the logic, in order to avoid unwanted shutdown of the primary equipment,  

it is recommended to exclude the possibility of influence of output relays on external circuits! 
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Figure 70 – Logic testing window 

Description of parameters of the Logic testing window is shown in table 26. 

Table 26 – Description of parameters of the Logic testing window 

Name Description 

Dist. recorder block Disabling disturbance recording during testing 

Input signal 
The point of logic is specified from the list, which will be sent to the input of 
the element with a delay, specified in the list “Time delays and monostable 
constants” 

Control output 

The “Measuring elements output” is indicated, which will be issued to the 
test relay. Or an element with a delay is specified from the list “Time delays 
and monostable constants”, from the output of which the signal will be sent 
to the test relay 

Status Terminals of the test relay are indicated 

 

3.6.2 Matrix inputs emulation 

The Matrix inputs emulation window (figure 71), device tree menu Tests → Matrix inputs emu-

lation, is designed to emulate operation of the matrix and to check the passage of signals through digital 

communication channels. 

 

Figure 71 – Matrix inputs emulation window 

The description of parameters of the Matrix inputs emulation window is given in table 27. 
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Table 27 – Description of parameters of the Matrix inputs emulation window 

Parameter Description 

Emulation mode disabled Enable /  
Emulation mode enabled Disable 

Enabling/disabling the emulation mode 

Reset all Unchecking all the boxes in the Value column 

Set all to 1 Checking all the boxes in the Value column  

Auto mode Sequential checking of all the boxes of the Value column 

 

The Matrix inputs emulation window allows you to set signals at the matrix input. Signals are 

controlled as follows: 

1) check the box – set the signal; 

2) uncheck the box – release the signal.  

Emulated signals in the IED take the value in accordance with those specified in the Smart Monitor 

program. 

 

3.6.3 Logic emulation 

The Logic emulation window (figure 72), device tree menu item Tests → Logic emulation, is 

designed to emulate logic. 

 

Figure 72 – Logic emulation window 

In order to switch to the emulation mode, click the Enable button. In this case, the “Emulation mode 

Enabled” message will appear. Signals are controlled as follows: 

1) check the box – set the signal; 

2) uncheck the box – release the signal.  

The emulated signals in the device take the value in accordance with those specified in the Smart 

Monitor program. 
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3.6.4 Data set testing 

The Data set testing window (figure 73), device tree menu item Tests → Data set testing, allows 

you to test data sets. 

 

Figure 73 – Data set testing window 

The description of parameters of the Data set testing window is given in table 28. 

Table 28 – Description of parameters of the Data set testing window 

Parameter Description 

Emulation mode disabled Enable /  
Emulation mode enabled Disable 

Enabling/disabling the emulation mode 

Matrix test / Logic test Selection of matrix/logic testing  

Reset all Unchecking all the boxes in the Value column 

Set all to 1 Checking all the boxes in the Value column  

Auto mode Sequential checking of all the boxes of the Value column 

 

3.6.5 LED testing 

The LED testing window (figure 74), device tree menu item Tests → LED testing, allows you to 

test the LEDs. To switch to the test mode, click the Enable button. The “Test mode Enabled” message will 

appear. Signals are controlled in three modes (column, cell, all).  

Tested signals in the IED take the value in accordance with those specified in the Smart Monitor 

program. 
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Figure 74 – LED testing window 

3.6.6 Relay testing 

 

 

NOTICE 

When issuing test influences on the device relay, it is possible to disconnect the operating equipment! 

 

The Relay testing window (figure 75), device tree menu item Tests → Relay testing, allows you 

to test output relays by simulating closed and tripped states. In order to switch to the test mode, click the 

Enable button. The “Test mode Enabled” message will appear. 

 

Figure 75 – Relay testing window 

The description of parameters of the Relay testing window is given in table 29. 
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Table 29 – Description of parameters of the Relay testing window 

Parameter Description 

Emulation mode disabled Enable /  
Emulation mode enabled Disable 

Enabling/disabling the test mode 

Reset all Unchecking all the boxes in the Value column 

Set all to 1 Sequential checking of all the boxes in the Value column  

3.7 Settings 

3.7.1 Analog inputs 

The Analog inputs window (figure 76), device tree menu item Settings → Analog inputs, is de-

signed to set the base value, transformation ratio and measurement range of analog inputs of the device. 

 

Figure 76 – Analog inputs window 

Parameters of the Analog inputs window are shown in table 30. 

Table 30 – Parameters of the Analog inputs window 

Parameter Description 

No. Sequence number of the signal 

Name Signal name 

Base value Base value of the corresponding electrical quantity 

Trans. ratio Transformation ratio of the corresponding electrical quantity 

Harmonic Displayed signal harmonic 

Sample 
Number of the sample on which the signal phasor is created  
(used to allocate processor time when calculating phasors) 

Sensor Name of the sensor 

Sensor output Name of the sensor output of the selected sensor module 

Range Selecting the measurement range of the sensor 

Visible The checked box enables display of analog input measurement on IEDs screen 

Revers current 180˚ The checked box reverses current by 180˚ 
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3.7.2 Binary inputs 

The Binary inputs window (figure 77), device tree menu item Settings → Binary inputs, is de-

signed to specify the settings for binary inputs, and also determines technological time delays for operate 

and release. 

 

Figure 77 – Binary inputs window 

Parameters of the Binary inputs window are shown in table 31. 

Table 31 – Parameters of the Binary inputs window 

Parameter Description 

No. Number of the binary input 

Name Name of the binary input 

Binary input Enabled Whether the binary input is enabled or not  

Value when disabled 
Value of the binary input when it is in its disabled position. Available for editing 
if there is no checkbox in column Binary input Enabled 

Invert When the box is checked, the signal is allowed to be inverted 

Operate DT, ms Technological time delay for operate in milliseconds 

Return DT, ms Technological time delay for return in milliseconds 

 

3.7.3 Binary outputs 

The Binary outputs window (figure 78), device tree menu item Settings → Binary outputs, is 

designed to specify the settings for binary outputs, including technological time delays for release, as well 

as settings for virtual binary outputs. 
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Figure 78 – Binary outputs window 

Parameters of the Binary outputs window are shown in table 32. 

Table 32 – Parameters of the Binary outputs window 

Parameter Description 

No. Number of the binary output 

Name Name of the binary output 

Latching 
Checked box indicates that the binary output is latched (if this box is checked,  
to return to its initial position, it is necessary to send the Reset alarm command) 

Return DT, ms 
Return time delay in milliseconds (this field does not apply to  
virtual binary outputs) 

 

3.7.4 LEDs 

The LEDs window (figure 79), device tree menu item Settings → LEDs, is designed for specifying 

LED settings. 

 

Figure 79 – LEDs window 
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Parameters of the LEDs window are shown in table 33. 

Table 33 – Parameters of the LEDs window 

Parameter Description 

No. Number of the LED 

Name Name of the LED 

Color Color of the LED (green/red) 

Latching 
Checked box indicates that the LED is latched (if this box is checked,  
to return to its initial position, it is necessary to send the Reset alarm command) 

 

3.7.5 Calculated values 

The Calculated values window (figure 80), device tree menu item Settings → Calculated values, 

is designed for viewing and editing the smoothing factor. The smoothing factor is used to smooth out 

changes (ripples) in the calculated value when calculating analog values. The factor value is set in the 

range of 0.01 to 1.00.   

 

Figure 80 – Calculated values window 

3.7.6 Measurements for indication 

The Measurements for indication window (figure 81), device tree menu item Settings → Meas-

urements for indication, is designed to set the parameters for displaying information when the Call ser-

vice signal is triggered. 
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Figure 81 – Measurements for indication window 

3.7.7 Switching devices 

The Switching devices window (figure 82), device tree menu item Settings → Switching de-

vices, is designed to specify settings for switching devices.  

 

Figure 82 – Switching devices window 
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Parameters of the Switching devices window are shown in table 34. 

Table 34 – Parameters of the Switching devices window 

Parameter Description 

No. Number of the switching device 

Name Name of the switching device 

Type Circuit breaker or disconnector 

Position signaling Signaling of the position 

Communication interface Communication interface 

Program protocol Used program protocol 

Control model Type of the model for control of the switching device according to IEC 61850 

Remaining life calculation type 
Type of calculation of the remaining life: 
– Mechanical; 
– Switching 

Parameter Tripped/Closed state Parameter name 

Value Setting values of the switching device 

Remaining life calculation Calculation of remaining life is carried out by IED software 

 

3.7.8 Calculated value parameters 

The Calculated value parameters window (figure 83), device tree menu item Settings → Calcu-

lated value parameters, is designed for viewing and editing parameters of calculated values. 

 

Figure 83 – Calculated value parameters window 

Parameters of the Calculated value parameters window are shown in table 35. 

Table 35 – Parameters of the Calculated value parameters window 

Parameter Description 

Parameter Parameters of calculated values 

Setting group 1 (2, 3, 4...) Number of the group of settings 
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Parameter Description 

Unit Measurement unit 

Range Range of parameters 

 

3.7.9 Measuring elements enable/disable 

The Measuring elements enable/disable window (figure 84), device tree menu item Settings → 

Measuring elements enable/disable, is designed to enable/disable MEs, if it is allowed by the configu-

ration. 

 

Figure 84 – Measuring elements enable/disable window 

3.7.10 Measuring element parameters 

3.7.10.1 Parameters 

The Parameters window (figures 85, 86), device tree menu item Settings → Measuring element 

parameters → Measuring elements1) → Parameters, is designed to set measuring element parameters. 

 

Figure 85 – Measuring element settings tab 

                                                

1) Indicated nominally. The availability of protetions depends on device configuration. 
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Figure 86 – Logic elements settings tab  

The description of columns of the Parameters window is given in table 36. 

Table 36 – Description of columns of the Parameters window 

Parameter Description 

Parameter Parameter of the measuring element 

Value Value of the parameter 

Unit Measurement unit 

Range Range of parameter change 
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3.7.10.2 Event and disturbance recording 

The Event and disturbance recording window (figure 87), device tree menu item Settings → 

Measuring element parameters → Measuring element1) → Event and disturbance recording, is de-

signed to set parameters for event and disturbance recording of measuring element signals. 

 

Figure 87 – Event and disturbance recording window 

The description of columns of the Event and disturbance recording window is given in table 37. 

Table 37 – Description of columns of the Event and disturbance recording window 

Parameter Description 

No. Number of the signal 

Signal Name of the signal 

Name as per IEC 61850 Signal name according to IEC 61850 

Event rec. 
Recording of the signal. When the box is checked, this signal is recorded by the 
event recorder 

Display Displaying events in the event recorder menu on the device display 

Disturb. rec. Disturbance recording of the signal 

Disturb. rec. edge-trig. 
start 

Start of the disturbance recorder on signal front 

Disturb. rec. fall-trig. start Start of the disturbance recorder on signal fall 

Latch. in PCS Latching in PCS 

Warning alarm Warning alarm 

Emergency alarm Emergency alarm 

 

                                                

1)  Indicated nominally. The availability of measuring elements depends on device configuration. 
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3.7.10.3 Oscillography of calculated parameters  

The Oscillography of calculated parameters window (figure 88), device tree menu item   

Settings → Measuring element parameters → Measuring element1) → Oscillography of calculated 

parameters, is designed to set up oscillography of calculated internal measuring element parameters. 

 

Figure 88 – Oscillography of calculated parameters window 

The description of columns of the Oscillography of calculated parameters window is given in 

table 38. 

Table 38 – Description of columns of the Oscillography of calculated parameters window 

Parameter Description 

Numder Numder of the parameter  

Name Name of the parameter 

Unit Unit of the parameter 

Disturb. rec. Selection the parameter for disturbance recorder 

                                                

1)  Indicated nominally. The availability of measuring elements depends on device configuration. 
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3.7.10.4 Outputs table 

The Outputs table window (figure 89), device tree menu item Settings → Measuring element 

parameters → Measuring element1) → Outputs table, is designed to control the table of device outputs. 

 

Figure 89 – Outputs table window 

The cell filled with turquoise  means that the table has been modified, but has not yet been 

written to the device (settings have not been written). This window provides an opportunity for each logic 

signal (vertical column on the left) to set the effects on device outputs (upper horizontal line) in accordance 

with the matrix of output circuits of the functional diagram of the measuring element set. If several signals 

correspond to one output, the influencing signal is determined by the “OR” gate. 

 

                                                

1)  Indicated nominally. The availability of measuring elements depends on device configuration. 
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3.7.10.5 LEDs table 

The LEDs table window (figure 90), device tree menu item Settings → Measuring element pa-

rameters → Measuring element1) → LEDs table, is designed to control the table of device LEDs. 

 

Figure 90 – LEDs table window 

The cell filled with turquoise  means that the table has been modified, but has not yet been 

written to the device (settings have not been written). This window provides an opportunity for each logic 

signal (vertical column on the left) to set the effects on display outputs (upper horizontal line) in accordance 

with the alarm matrix of the functional diagram of the measuring element set. If several signals correspond 

to one output, the influencing signal is determined by the “OR” gate. 

 

                                                

1)  Indicated nominally. The availability of measuring elements depends on device configuration. 
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3.7.10.6 Logic 

The Logic window (figure 91), device tree menu item Settings → Measuring element parame-

ters → Measuring element1) → Logic, is designed to view the logic diagram. 

 

Figure 91 – Logic window 

3.7.10.7 Tripping matrix 

The Tripping matrix window (figure 92), device tree menu item Settings → Measuring element 

parameters → Measuring element1) → Tripping matrix, is designed for editing tripping circuits. The 

tripping matrix is a compact form of recording matrices of output circuits and indication. Its operation 

principle is to create tripping circuits – groups of output circuits to which the same signal will be applied. 

Output circuits may include both relays of output modules and LEDs of indication modules. Such a group-

ing significantly reduces the matrix record. 

                                                

1) Indicated nominally. The availability of measuring elements depends on device configuration. 
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Figure 92 – Tripping matrix window 

3.7.10.8 Differences by setting groups 

The Differences by setting groups window, device tree menu item Settings → Differences by 

setting groups is designed to display parameters that differ in different setting groups. 

 

Figure 93 – Differences by setting groups window 
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Note – The window is only applicable if multiple setting groups are used in the device. 

3.7.11 Event and disturbance recording  

3.7.11.1 Disturbance recorder parameters 

The Disturbance recorder parameters window (figure 94), device tree menu item Settings → 

Event and disturbance recording → Disturbance recorder parameters, is designed to configure the 

disturbance recorder parameters. 

 

Figure 94 – Disturbance recorder parameters window 

The description of disturbance recorder parameters is given in table 39. 

Table 39 – Description of disturbance recorder parameters 

Parameter Description 

Pre-fault time Disturbance recording time before fault in seconds 

Maximum fault time Maximum fault recording time in seconds 

Post-fault time Disturbance recording time after fault in seconds 

Maximum dist. record duration 
Maximum disturbance recording time in seconds  
(calculated depending on the amount of free memory on the device) 

Quantity of disturbance recorder 
Quantity of disturbance records stored in the device. If the specified value 
is exceeded, the disturbance records in the device will be overwritten 

Max. quantity of disturbance re-
corder 

Maximum quantity of disturbance records that can be stored in the device 
(calculated based on the free memory of the device) 

 

3.7.11.2 Analog inputs 

The Analog inputs window (figure 95), device tree menu item Settings → Event and disturbance 

recording → Analog inputs, is designed to configure recording of analog signals in the disturbance re-

corder. 
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Figure 95 – Analog inputs window 

3.7.11.3 Logic signals 

The Logic signals window (figure 96), device tree menu item Settings → Event and disturbance 

recording → Logic signals, is designed for setting the parameters for event and disturbance recording 

of logic signals. 

 

Figure 96 – Logic signals window 

Parameters of the Logic signals window are shown in table 40. 
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Table 40 – Parameters of the Logic signals window 

Parameter Description 

No. Number of the signal 

Signal Name of the signal 

Event rec. Event recording of the signal 

Display Displaying events in the menu on the device display 

Disturb. rec. Disturbance recording of the signal 

Disturb. rec. edge-trig. start Start of the disturbance recorder on signal front 

Disturb. rec. fall-trig. start Start of the disturbance recorder on signal fall 

 

3.7.11.4 Binary inputs 

The Binary inputs window (figure 97), device tree menu item Settings → Event and disturbance 

recording → Binary inputs, is designed to configure recording of binary input signals in the event re-

corder and display. In this menu item, you can configure recording for binary hardware signals, digital 

binary inputs, modules of digital software inputs.  

 

Figure 97 – Binary inputs window 

Parameters of the Binary inputs window are shown in table 41. 

Table 41 – Parameters of the Binary inputs window 

Parameter Description 

No. Number of the signal 

Name Name of the signal 

Event rec. Event recording of the signal 

Display Displaying events in the event recorder menu on the device display 
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3.7.11.5 Calculated values 

The Calculated values window (figure 98), device tree menu item Settings → Event and dis-

turbance recording → Calculated values, is designed for setting signal recording in the disturbance 

recorder, event recorder and on the display. 

 

Figure 98 – Calculated values window 

The description of columns of the Calculated values window is given in table 42. 

Table 42 – Description of columns of the Calculated values window 

Parameter Description 

No. Number of the signal 

Name Name of the signal 

Event rec. Event recording of the signal 

Display Displaying events in the event recorder menu on the device display 

Dist. Disturbance recording of the signal 

 

3.7.11.6 Matrix outputs 

The Matrix outputs window (figure 99), device tree menu item Settings → Event and disturb-

ance recording → Matrix outputs, is designed for setting signal recording in the event recorder and on 

the display. 
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Figure 99 – Matrix outputs window 

3.7.11.7 FP signals 

The FP signals window (figure 100), device tree menu item Settings → Event and disturbance 

recording → FP signals, is designed to configure the recording of diagnostic signals of IED's functional 

processor in the event recorder and on the display. 

 

Figure 100 – FP signals window 
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3.7.11.8 CP signals 

The CP signals window (figure 101), device tree menu item Settings → Event and disturbance 

recording → CP signals, is designed to configure recording of communication processor signals in the 

event recorder and on the display.  

 

Figure 101 – CP signals window 

3.7.11.9  Incoming GOOSE 

The Incoming GOOSE window (figure 102), device tree menu item Settings → Event and dis-

turbance recording → Incoming GOOSE, is designed to set signal recording in the event recorder and 

on the display.  

 

Figure 102 – Incoming GOOSE window 

3.7.12 System parameters 

3.7.12.1 Parameters of IED 

The IED parameters window (figure 103), device tree menu item Settings → System parame-

ters → IED parameters, is designed for viewing and editing general parameters of the device. 
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Figure 103 – IED parameters window 

Parameters of the IED parameters window are shown in table 43. 

Table 43 – Parameters of the IED parameters window 

Parameter Description 

Testing 
It sets a test relay for automated testing. In the drop-down list, it is necessary to se-
lect a relay module, after selecting the module, specify the desired circuit 

Memory 
This section displays the size of the memory card installed in the device, in mega-
bytes 

Display 
This section sets the localization language and the time until the access password is 
reset, as well as the window that is displayed by default on the device display 

Operation frequency 

This parameter specifies the frequency of the device's functional processor cycle. 
Possible parameter values: 
– 1,000 Hz;  
– 1,200 Hz; 
– 2,000 Hz.  
The value of 1,000 Hz is set in case of using the Sample Value reception report 
block according to the IEC 61850-9-2LE protocol, as well as in control IEDs.  
The value 2,000 Hz is set for the functional purpose "Communication device".  
In all other cases, the value is set to 1,200 Hz. 
For parameter of Disturbance recording frequency availoble regular and double fre-
quencies.  
Rated circuit frequency – 50/60 Hz 

Supply parameters 
In the Object name field, select the station/substation to which the device will be 
supplied. The IED functionality code field identifies the device by its functions 
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Parameter Description 

Binary input process time 
compensation 

The function is designed for recording the time of change in the state of binary in-
puts at the moment of arrival at device terminals. When the event is saved to the re-
corder, the time of change in the state of binary inputs is corrected, then the CP, ac-
cording to the IEC 61850 standard, transmits the state change event of binary inputs 
using timestamps from the event recorder  
In the field Enable time correction compensation of processing time of binary inputs 
is enabled. 
The On switch to 1 field specifies the time in milliseconds that will be  
compensated upon switching from logical 0 to 1 
The On switch to 0 field specifies the time in milliseconds that will be  
compensated upon switching from logical 1 to 0 

Analog value display in 
IED 

Mode of display of analog values: 
– Primary; 
– Secondary 

 

3.7.12.2 Setting groups 

The Setting groups window (figure 104), device tree menu item Settings → System parame-

ters → Setting groups, is designed for viewing parameters of setting groups. 

 

Figure 104 – Setting groups window 

Parameters of the Setting groups window are shown in table 44. 

Table 44 – Parameters of the Setting groups window 

Parameter Description 

Quantity of setting groups Quantity of setting groups specified in the device 

Active setting group by default Active setting group from the assigned quantity of setting groups 

Setting group switching source Switching sources 

Common tripping matrices for all 
setting groups 

Flag at which the tripping matrix is common for all setting groups 

Password request when switch-
ing setting group via ES 

Flag, at which a password is requested when switching a group of settings 
with electronic switch 
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Parameter Description 

No. Number of the setting group 

Name  Name of the setting group 

Activation signal Signal of activation of the setting group 

 

3.7.13 Digital communication channels 

3.7.13.1 Communication parameters 

The Communication parameters window (figure 105), device tree menu item Settings → Digital 

communication channels → Communication parameters, is designed for viewing and editing commu-

nication parameters of the device.  

 

Figure 105 – Communication parameters window 

Parameters of the System parameters window are shown in table 45. 

Table 45 – Parameters of the System parameters window 

Parameter Description 

Parameter Setting parameter 

Value Parameter value 

Unit Measurement unit 

Description Description of parameter change 
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3.7.13.2 Redundancy parameters 

The Redundancy parameters window (figure 106), device tree menu item Settings → Digital 

communication channels → Redundancy parameters, is designed for viewing and editing parameters 

of communication channels’ redundancy. 

 

Figure 106 – Redundancy parameters window 

Parameters of the Redundancy parameters window are shown in table 46. 

Table 46 – Parameters of the Redundancy parameters window 

Parameter Description 

Parameter Parameter of redundancy protocol 

Value Parameter value 

Unit Measurement unit 

Description Description of parameters 

 

3.7.13.3 Analog input parameters 

The Analog input parameters window (figure 107), device tree menu item Settings → Digital 

communication channels → Analog input parameters, is designed for viewing and editing the param-

eters of analog inputs. 

 

Figure 107 – Analog input parameters window 
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Parameters of the Analog input parameters window are shown in table 47. 

Table 47 – Parameters of the Analog input parameters window 

Parameter Description 

No.  Number of the analog input 

Name Name of the analog input 

Deadband, % of base value 
Deadband, percentage of nominal and absolute value 

Deadband 

Value Value of the deadband 

Step Step of changing the corresponding value 

Alarm and validity thresholds Threshold values of alarm and validity 

Maximum 
If the analog value is greater than the setting, the range value becomes  
high-high and the quality – questionable 

Uppermost 
If the analog value is greater than the setting, the range value becomes  
high-high and the quality – good 

Upper 
If the analog value is greater than the setting, the range value becomes  
high-high and the quality – good 

Lower 
If the analog value is greater than the setting, the range value becomes  
normal and the quality – good 

Lowermost 
If the analog value is greater than the setting, the range value becomes  
low and the quality – good 

Minimum 
If the analog value is less than the setting, the range value becomes  
low-low and the quality – questionable 

 

3.7.13.4 Calculated value parameters 

The Calculated value parameters window (figure 108), device tree menu item Settings → Digital 

communication channels → Calculated value parameters, is designed for viewing and editing param-

eters of calculated values. 

 

Figure 108 – Calculated value parameters window 
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Parameters of the Calculated value parameters window are shown in table 48. 

Table 48 – Parameters of the Calculated value parameters window 

Parameter Description 

No. Number of the calculated value 

Name Name of the calculated value 

Dist. Disturbance recording 

Smoothing factor 

Used to smooth out changes (ripples) in the calculated value when calculating analog 
values. The factor value is set in the range of 0.01 to 1.00.   
Calculation of X value with account for smoothing ratio is calculated by the formula 
X = XPREV + k·ΔX, 
where  
XPREV – previous value; 
k – smoothing factor; 
ΔX – increment calculated as a difference between the current and previous values: 
ΔX = XCURR– XPREV 
The value of 0.1 means that the current value will change by 10 % of the difference 
between the new value and the previous value.  
The value of 0 is an invalid value, no smoothing. 
The smoothing factor is set for each calculated value. 

Maximum value Maximum calculated value is specified. 

Deadband, % 
Specifies an integer from 0 to 100,000. One unit corresponds to 0.001 % of  
“Max. value” 

Deadband 
Real value that determines the signal change limit, above which a report on the 
change in the signal value will be sent. It is equal to the product of parameter  
“Deadband, % of max. value” of the sensor input to the value of 0.00001 

Use thresholds Use threshold values of alarm and validity 

Maximum 
If the calculated value is greater than the setting, the range value becomes high-high 
and the quality – questionable 

Uppermost 
If the calculated value is greater than the setting, the range value becomes high-high 
and the quality – good 

Upper 
If the calculated value is greater than the setting, the range value becomes high and 
the quality – good 

Lower 
If the calculated value is greater than the setting, the range value becomes normal 
and the quality – good 

Lowermost 
If the calculated value is greater than the setting, the range value becomes low and 
the quality – good 

Minimum 
If the calculated value is less than the setting, the range value becomes low-low and 
the quality – questionable 

 

3.7.13.5 Time synchronization 

3.7.13.5.1 Control 

The Control window (figure 109), device tree menu item Settings → Digital communication 

channels → Time synchronization → Control, allows you to add or remove time synchronization proto-

cols using buttons ,  respectively. 
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Figure 109 – Control window 

3.7.13.5.2 Parameters 

The Parameters window (figure 110), device tree menu item Settings → Digital communication 

channels → Time synchronization → Parameters, is designed to configure software and hardware time 

synchronization parameters.  

  

Figure 110 – Parameters window 

Software synchronization  

Parameters of software synchronization are shown in table 49. 

Table 49 – Software time synchronization 

Parameter Description 

Interface Selection of interface for software synchronization 

Protocol Protocol for selected interface 

Correction Correction of time synchronization in hours 

Adjust for daylight saving time 
automatically 

Checked box indicates automatic switch to summer/winter time 

 

PPS hardware synchronization 
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Parameters of PPS hardware synchronization are shown in table 50. 

Table 50 – PPS hardware synchronization 

Parameter Description 

Synchronization enabled Enable use of PPS hardware synchronization 

Synchropulse period Selection of synchropulse period in seconds 

Registred transition 
Selection of transition to fall or front (parameter determines when time syn-
chronization occurs) 

Minimum pulse duration 
Selection of minimum duration of the pulse (for protection from interference 
and bounce) in milliseconds 

Calibration value Selection of calibration value in milliseconds 

Permissible deviation of synchro-
pulse period 

Selection of permissible deviation of synchropulse period in milliseconds 

Synchronization source PPS time synchronization source 

 

IRIG-B hardware synchronization 

Parameters of IRIG-B hardware synchronization are shown in table 51. 

Table 51 – IRIG-B hardware synchronization 

Parameter Description 

Synchronization enabled Enable use of IRIG-B hardware synchronization 

Standard Synchronization standard  

Version Version of the IRIG-B standard. B003 or B007 available for selection  

Synchronization source Selection of IRIG-B time synchronization source 
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3.7.13.5.3 SNTP 

The SNTP window (figure 111), device tree menu item Settings → Digital communication chan-

nels → Time synchronization → SNTP, is designed to configure parameters of the SNTP protocol. 

 

Figure 111 – SNTP window 

Parameters of the SNTP protocol are shown in table 52. 

Table 52 – Parameters of the SNTP protocol 

Parameter Description 

Protocol name Name of the protocol 

Protocol enabled Enabling data transmission via protocol  

Select server 

– By priority (user additionally sets a priority value for each server. If the set pri-
orities are the same , the first one declared in the device configuration is consid-
ered the main one); 

– Automatically (server is selected by position in the server hierarchy. The most 
accurate server is at the top level of the hierarchy. When located at the same 
level of the hierarchy, the first one declared in the device configuration is consid-
ered the main one) 

Server 1 (2, 3, 4) 

Enabled Box checked – server 1 (2, 3, 4) is enabled for time synchronization 

Priority 

It sets the priority level of the server when synchronizing time, if Select server is 
By priority: 

– Very low; 

– Low; 

– High; 

– Very high 

Server IP Address of the server with which the time is synchronized 
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Parameter Description 

Server port 
Port on the server through which the time is synchronized  
(123 standard port for SNTP) 

Synchronization period, s 
Time interval (value must be in the range of 1 to 4,096 s) after which synchroni-
zation is repeated 

Response wait time, s 
Time to wait for a response from the server (value must be in the range of  
1 to 60 s)  

 

3.7.13.5.4 PTP 

The PTP window (figure 112), device tree menu item Settings → Digital communication chan-

nels → Time synchronization → PTP, is designed to configure parameters of the PTP protocol. 

 

Figure 112 – PTP window 

Parameters of the PTP protocol are shown in table 53. 

Table 53 – Parameters of the PTP protocol 

Parameter Description 

Protocol name Name of the protocol 

Protocol enabled Checkbox means that the protocol is enabled 

Synchronization period, s Time interval in seconds after which synchronization is repeated 

Clock type It sets the synchronization algorithm (Boundary, Transparent) 

Management via PTP Enabling/disabling the PTP control 

Sync lower bound  
Minimum time difference between local clock and reference time source in 
nanoseconds 



   
 

94   EKRASMS-SP software package manual 
EKRA.00019-01 34 02, Edition 05.2023 

Parameter Description 

Sync upper bound  
Maximum time difference between local clock and reference time source in 
nanoseconds 

(Boundary) domain  Linking a device to a specific PTP domain 

(Boundary) priority1  Specifies the priority for port 1 

(Boundary) priority2  Specifies the priority for port 2 

(Boundary) utc offset  Difference between PTP and UTC timeline in seconds 

(Boundary) utc offset is valid Offset of timeline 

(Transparent) delay mechanism 
Measurement algorithm of delay in the device transmitted in PTP  
messages 

(Transparent) is multi domain Operation of PTP synchronization independent from the domain 

(Transparent) network protocol Network protocol through which synchronization messages are transmitted 

(Transparent) primary domain  Linking a device to a PTP domain 

(Transparent) is sync local clock Synchronization of local clock 

(Transparent) vlan 
Operation of PTP in a specified virtual network (VLAN ID), virtual network 
No 

(Transparent) vlan-priority  
Priority with which the device transmits messages of PTP synchronization 
related to this VLAN ID 

 

Note – The availability of the PTP protocol depends on the device type. 

 

3.7.13.6 Communication protocols 

3.7.13.6.1 Control 

The Control window, device tree menu item Settings → Digital communication channels → 

Communication protocols → Control, is designed for adding, deleting and configuring protocols. Add-

ing, deleting is carried out using buttons ,  respectively (figure 113).  

 

Figure 113 – Control window 
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General parameters of protocols are shown in table 54. 

Table 54 – General parameters of protocols 

Name Description 

Protocol name 
61850 (IEC 61850), ModbusTCP, ModbusRTU*, 60870-5-103*  
(IEC 60870-5-103), 60870-5-104* (IEC 60870-5-104), IEC103Master 
(IEC 60870-5-103) 

Protocol enabled Indicator of using the protocol in the configuration 

 
* The common parameter is only the Protocol name. 

Note – The list of communication protocols may differ depending on the device type. 

3.7.13.6.2 Parameters of the IEC 60870-5-103 protocol (figure 114) 

 

Figure 114 – Parameters of the IEC 60870-5-103 protocol 

The description of parameters of the IEC 60870-5-103 protocol is given in table 55. 

Table 55 – Description of parameters of the IEC 60870-5-103 protocol 

Parameter Description 

Protocol name Name of the protocol 

Measurement transmission type 

It sets the type of analog signal transmission: 

– Cyclic (after a specified time interval); 

– Sporadic (when signal changes); 

– Cyclic & sporadic (after a specified time interval and when the signal 
changes); 

– Disabled (information is not transmitted) 

Measurement transmission period, s Time setting delay in seconds when transmitting measurements 

Measurement data type 

Format of measurements: 

– Floating point (asdu 4); 

– Fixed point (asdu 9) 

Analog data Analog values / Calculated values / Protection phasors 

Binary data Logic signals / Binary outputs 

Base address of logic signals Decimal value which sets the base address of logic signals 

Base address of binary outputs Decimal value which sets the base address of binary outputs 
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Parameter Description 

Base address of analog values Decimal value which sets the base address of analog values 

Basic address of calculated values Decimal value which sets the base address of calculated values 

Omit zeros in INF field 
When the value of the address parameter for the IEC 60870-5-103  
protocol is set, fieldless INF = 0 is generated 

 

3.7.13.6.3 Parameters of the IEC 60870-5-104 protocol (figure 115). 

 

Figure 115 – Parameters of the IEC 60870-5-104 protocol 

The description of additional parameters of the IEC 60870-5-104 protocol is given in table 56. 

Table 56 – Description of parameters of the IEC 60870-5-104 protocol 

Parameter Description 

Protocol name Name of the protocol 

Protocol enabled Indicator of using the protocol in the configuration 

Quantity of clients 
Maximum possible quantity of clients (value must be in the range of 1 to 10)  
simultaneously connected to the device using the IEC 60870--104 protocol 



 

EKRASMS-SP software package manual   97 
EKRA.00019-01 34 02, Edition 05.2023 

Parameter Description 

Measurement transmission 
type 

It sets the type of analog signal transmission: 

– Cyclic (after a specified time interval); 

– Sporadic (when signal changes); 

– Cyclic & sporadic (after a specified time interval and when the signal 
changes); 

– Disabled (information is not transmitted)  

Client time-out, s 
Time interval in seconds (value must be in the range of 1 to 120 s) after which it 
is considered that there is no connection with the client if no data was received 
from the client 

Measurement data type 

It sets the data type of analog signals: 

– Normalized; 

– Scalable; 

– Floating point 

Sending period, s 
Time interval in seconds (value must be in the range of 1 to 900 s) during which 
the transmission of cyclic measurements is repeated 

Analog data* Analog values / Calculated values / Protection phasors 

Binary data* Logic signals / Binary outputs 

Base address of logic signals 

Base address of logic signals (value must be in the range of 1 to 16,777,215) 
according to IEC 60870-5-104 protocol. It is not recommended to change the 
value without agreement with the developers of device software. Default value is 
257 

Base address of binary out-
puts 

Base address of binary signals (value must be in the range of 1 to 16,777,215) 
according to IEC 60870-5-104 protocol. It is not recommended to change the 
value without agreement with the developers of device software. Default value  
is 1,281 

Base address of analog val-
ues 

Base address of analog measurements (value must be in the range of 1 to 
16,777,215) according to IEC 60870-5-104 protocol. It is not recommended to 
change the value without agreement with the developers of device software.  
Default value is 2,561 

Basic address of calculated 
values 

Base address of calculated values (value must be in the range of 1 to 
16,777,215) according to IEC 60870-5-104 protocol. It is not recommended to 
change the value without agreement with the developers of device software.  
Default value is 3,073 

Base address of protection 
phasors 

Base address of protection phasors (value must be in the range of 1 to 
16,777,215) according to IEC 60870-5-104 protocol. It is not recommended to 
change the value without agreement with the developers of device software.  
Default value is 3,329 

Transmission mode Protocol operation mode. By default – Balanced 

ASDU address size  By default – 2 

Size of transmission reason 
field 

By default – 2 

Size of information object ad-
dress 

By default – 3 

k Max. quantity of APDU with-
out acknowledgment 

Value of k indicates the maximum quantity of consecutively numbered Format I 
APDUs that can be transmitted without acknowledgment 

W Sending an ACK after re-
ceiving w APDU 

W value is the quantity of APDUs read before an ACK should be sent 

ASDU address By default – 1 ((value must be in the range of 1 to 247) 

 
          * It is permitted to select multiple items. 
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3.7.13.6.4 IEC 61850 protocol 

1) Parameters of the IEC 61850 protocol (figure 116). 

 

Figure 116 – Parameters of the IEC 61850 protocol 

The description of additional parameters of the IEC 61850 protocol is given in table 57. 

Table 57 – Description of additional parameters of the IEC 61850 protocol 

Parameter Description 

Protocol name Name of the protocol 

Protocol enabled Indicator of using the protocol in the configuration 

Enable outgoing GOOSE 
It is planned to exchange binary data between devices via GOOSE 
messages Data transmission is planned for this device 

Enable incoming GOOSE 
It is planned to exchange data between IEDs using GOOSE mes-
sages. Data reception is planned for this device 

IED name Name (ID) of the device 

Sign of using an extended protocol 
If a documented possibility of IEC 61850 to add its data types and at-
tributes used 

Encoding of COMTRADE file names Encoding used for COMTRADE file names (Windows-1251 or UTF-8) 

 

2) Parameters of outgoing GOOSE (figure 117). 

 

 

Figure 117 – Parameters of outgoing GOOSE 
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The description of parameters of outgoing GOOSE is given in table 58. 

Table 58 – Description of outgoing GOOSE parameters 

Parameter Function 

 
Adding, deleting an outgoing GOOSE message, respectively 

Name Name of outgoing GOOSE message 

GOOSE message class 

Classes of GOOSE messages: 

– none; 

– I (Type 1A); 

– II (Type 1B); 

– III (Type 1B) 

MAC address  MAC address to which GOOSE packets will be sent 

AppID (hex) 
Identifier of the application that uses messaging: 
– hex – hexadecimal representation of the field; 
– dec – unsigned integer.  
Must be unique for all GOOSE messages at the substation for proper operation 
of the device 

AppID (dec) 

Control block Name of control block responsible for GOOSE messaging 

DataSet Name of GOOSE data set 

GOOSE ID (GoID) Unique indicator of an object that distinguishes it from other objects 

GOOSE configuration version 
Version of GOOSE configuration is necessary to keep track of the number of 
changes to the GOOSE configuration 

Standard GOOSE send  pe-
riod, ms 

Period of cyclic sending when there are no signal changes. Periodic sending is 
used to control the presence of communication. Permissible value range is from 
100 to 65,000 ms 

Minimum GOOSE send period, 
ms 

Minimum period of cyclic sending in the absence of signal changes. Permissible 
value range is from 4 to 10,000 ms 

Message count with minimum 
send period, pcs 

Quantity of messages with a minimum sending period. Permissible value range 
is from 2 to 10 

Doubled period until standard 
send period 

When the box is checked, the send period is doubled until it reaches the stand-
ard sending period. 
If the box is not checked, the send period is doubled for the number of messages 
specified in the “Message count with doubled send period” parameter, after 
which the sending period is immediately taken as equal to the standard 

Message count with doubled 
send period, pcs 

Quantity of messages with a doubled sending period. Permissible value range is 
from 1 to 10 

Enable VLAN Enabling the use of VLAN in outgoing GOOSE messages 

VLAN ID Integer value (0 to 4,095) which is used in VLAN for identification  

VLAN priority Integer priority value for outgoing GOOSE messages using VLAN  

Network interface Ethernet interface through which GOOSE message is sent 

Lock encoding Checkbox for encoding lock 
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3) Parameters of incoming GOOSE (figure 118). 

 

Figure 118 – Parameters of incoming GOOSE 

The description of parameters of incoming GOOSE is given in table 59. 

Table 59 – Description of parameters of incoming GOOSE 

Parameter Function 

 

Adding, deleting or importing from the cid file of the incoming GOOSE 
message, respectively 

Name Name of incoming GOOSE message 

MAC address MAC address from which GOOSE packets will be received 

AppID (hex) Identifier of the application that uses messaging: 
– hex – hexadecimal representation of the field; 
– dec – unsigned integer AppID (dec) 

Control block Name of control block responsible for GOOSE messaging 

Data set 
Name of the GOOSE data set. Analogue signals with a time stamp and 
service ones are not implemented  

ID GOOSE (GoID) Unique indicator of an object that distinguishes it from other objects 

GOOSE configuration version 
Version of GOOSE configuration is necessary to keep track of the number 
of changes to the GOOSE configuration 

Enable VLAN Enabling the use of VLAN in incoming GOOSE messages 

ID VLAN  Integer value which is used in VLAN for identification 

Value for no connection / bad qual-
ity / TEST label in non-TEST mode 

Value for no connection / bad quality / TEST label in non-TEST mode: 
– default value; 
– previous value 

Fixed coding checkbox Enables fixed coding mode for GOOSE packets 

 
Adding, deleting, editing, activating of input or setting input signals respec-
tively 
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Parameter Function 

No. Number of the input signal 

Signal name  Name of the input signal 

Data type  Type of the input signal data 

 

4) Parameters of incoming SV (figure 119). 

 

Figure 119 – Parameters of incoming SV 

The description of parameters of incoming SV is shown in table 60. 

Table 60 – Description of parameters of incoming SV 

Parameter Description 

Permissible age of obsolete packets, 
ms 

Permissible age of obsolete packets in milliseconds 

No. Number of SV stream 

svID Identifier of SV stream 

MAC MAC address of SV stream 

Note – The availability of this protocol depends on the IED type. 
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5) Parameters of data sets (figure 120). 

 

Figure 120 – Parameters of data sets 

The description of parameters of data sets is given in table 61. 

Table 61 – Description of parameters of data sets 

Parameter Description 

Name Name of the data set 

Type Type of the data set 

Data structure type 

Type of data structure: 

– data object; 

– value; 

– value, quality; 

– value, quality, time 

 
Adding, deleting a data set 

Available signals 

No. Number of the signal 

Signal Name of the signal 

Selected data set signals 

No. Number of the signal 

No. in group Signal number in the group 

Signal Name of the signal 
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Parameter Description 

Group Name of the group 

,  
Add, delete selected signals to/from the set, respectively 

 
Add signals in front of the selected one in the set 

,  
Add, delete all signals to/from the set, respectively 

,  
Move signals up, down 10 positions respectively 

,  
Move signals up, down one position respectively 

 

6) Parameters of report blocks (figure 121). 

 

Figure 121 – Parameters of report blocks  

Table 62 – Description of report block parameters 

Parameter Function 

Parameter Parameter of the report block 

Value Parameter values 

Unit Measurement unit 

Description Description of parameters 

Name Identifier of the report block 

Type:  

– Unbuffered binary; 

– Buffered binary; 

unbuffered – in the absence of a connection the transmitted data 
are not stored; 
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Parameter Function 

– Unbuffered analog; 

– Buffered analog; 

– Unbuffered service; 

– Buffered service; 

– Unbuffered mixed; 

– Buffered mixed 

buffered – for the period of absence of a connection the data are 
stored in the volatile memory of the device and transmitted to the 
client when the connection is restored 

Data set Name of the data set transmitted by the report 

Report send time Time of periodic sending of current values 

Data buffering time 
Data accumulation time before reporting on signal changes in the 
data set in milliseconds 

Report block configuration version Version of report block configuration 

Report block copy count Quantity of identical report blocks 

Report block identifier Text designation of the data report block 

Fields List of fields (optional) transmitted in the report 

Modes List of transmission modes 

 

3.7.13.7 User data 

The User data window (figure 122), device tree menu item Settings → Digital communication 

channels → User data, is designed for adding user data. 

 

Figure 122 – User data window 

The description of parameters of the User data window is given in table 63. 

Table 63 – Description of parameters of the User data window 

Parameter Description 

No. Number of the user data element 

Signal group Group to which the user data element belongs 

Group signal Signal based on which the user data element will be generated 

Source data type Type of the source signal data 

Destination data type 
Type of user data element: 

– bool; 
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Parameter Description 

– int8; 

– int16; 

– int32; 

– int64; 

– uint8; 

– uint16; 

– uint32; 

– uint64; 

– float; 

– double 

New signal address Address of the user data element in the ModBus memory map 

New signal name Name of the user data element 

,  
Adding, deleting a signal, respectively 

 

3.7.13.8 Administration of management 

The Administration of management window (figure 123), device tree menu item Settings → 

Digital communication channels → Administration of management, is designed for adding IP ad-

dresses for device control, setting a name in the Name field and an administration level in the Control 

level field. 

 

Figure 123 – Administration of management window 

The description of parameters of the Administration of management window is given in table 64. 

Table 64 – Description of parameters of the Administration of management window 

Parameter Description 

Number Number of the control administration element 

IP address IP address of the computer 

Name Name of the element 

Control level 
Levels of device control: 
– Dispatching; 
– Station  

Allowed to manage only from IP addresses 
specified in the current list 

Control is only possible from the IP addresses specified in the list 

,  
Adding, deleting an element, respectively 
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3.7.14 Transceiver1) 

3.7.14.1 General parameters 

The General parameters window (figure 124), device tree menu item Settings → Transceiver → 

General parameters, is designed for configuring the main parameters of the receiver and transmitter of 

the emergency and control signal transmission IED. 

 

Figure 124 – General parameters window 

Parameters of the General parameters window are shown in table 65. 

Table 65 – Parameters of the System parameters window 

Parameter Description 

Receiver 

Enable receiver Enabling or disabling the receiver 

Rated bandwidth Selection of the receiver bandwidth in kHz 

Center frequency Adjusting the center frequency of the receiver in kHz 

Spectrum Selection of spectrum for the receiver bandwidth 

Sensitivity Adjusting sensitivity level of the receiver in dBm 

                                                

1) This item is available by default only in teleprotection equipment devices. 
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Parameter Description 

Attenuator 20 dB Turn the attenuator on or off by 20 to 22 dB  

Receiver calibration Calibration of the receiver meter in dB 

Telemetry Enabling or disabling the telemetry function 

Digital transmission 
Enabling or disabling the digital transmission function (digital  
retransmission) 

Transmitter 

Enable transmitter Enabling or disabling the transmitter 

Rated bandwidth Selection of the transmitter bandwidth in kHz 

Center frequency Adjusting the center frequency of the transmitter in kHz 

Spectrum Selection of spectrum for the transmitter bandwidth 

Command signal level Adjusting the command signal level at the HF output in dBo 

SS level relative to command Adjusting the SS level relative to the command level in dB 

Telemetry Enabling or disabling the telemetry function 

Digital reception Enabling or disabling the digital reception function (digital retransmission) 

Control 

Start Switching the receiver to the “Operation” state 

Reset Reset the IED alarm 

 

Note – The presence or absence of this item depends on the function of the device. 

3.7.14.2 Receiver 

The Receiver window (figure 125), device tree menu item Settings → Transceiver → Receiver, 

is designed for configuring the parameters of the emergency and control signal transmission receiver com-

mands. 
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Figure 125 – Receiver window 

Parameters of the Receiver window are shown in table 66. 

Table 66 – Parameters of the Receiver window 

Parameter Description 

Security signal frequency Adjusting frequency of the security signal in Hz 

Telemetry frequency Adjusting frequency of the telemetry in Hz 

Set operate delay for all  
commands, ms 

Entering a receive delay for all HF commands 

No. Number of the HF command of the receiver 

Name Name of the HF command  

Enable/Disable Enabling or disabling the command 

Operate delay, ms Adjusting a receive delay for the HF command 

Frequency 1, ms Adjusting the first frequency of the HF command 

Frequency 2, ms 
Adjusting the second frequency of the HF command. The second frequency 
of the HF command is displayed when the two-frequency transmission 
method is selected in the transceiver module 

Digital transmission 
Enabling or disabling digital transmission. When digital transmission is ena-
bled, the IED retransmits the received HF command in digital form through 
the RS-422 port 
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3.7.14.3 Transmitter 

The Transmitter window (figure 126), device tree menu item Settings → Transceiver → Trans-

mitter, is designed for configuring parameters of the emergency and control signal transmission transmit-

ter commands. 

 

Figure 126 – Transmitter window 

Parameters of the Transmitter window are shown in table 67. 

Table 67 – Parameters of the Transmitter window 

Parameter Description 

Security signal frequency Adjusting frequency of the security signal in Hz 

Telemetry frequency Adjusting frequency of the telemetry in Hz 

“Tracking” command without duration limits 
Enabling or disabling the mode of transmission of the “tracking” 
command without time limit 

“Tracking” command level reduction 
Enabling or disabling the function to reduce the level of the  
“tracking” command by 6 dB after 15 s of continuous transmission 

Set the duration of transmission for all com-
mands, ms 

Entering the duration of transmission for all HF commands 

No. Number of the HF command of the receiver 

Name Name of the HF command 

Input binding Binding of signals occurs by pressing button   

Input name Name of the selected input or logic signal 

Enable/Disable Enabling or disabling the command 

Group Selecting the priority group for the command  

Priority in group 
Selecting the priority in the group for the command. Commands 
cannot have the same priorities in the same group 

HF command transmission duration, ms Adjusting the duration of transmission of the HF command 
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Parameter Description 

“Tracking” command 
Enabling or disabling the mode of transmission of the HF  
command during the time of presence of the operate signal of the 
bound input 

Frequency 1, Hz Adjusting the first frequency of the HF command 

Frequency 2, Hz 
Adjusting the second frequency of the HF command. The second 
frequency of the HF command is displayed when the two-fre-
quency transmission method is selected in the transceiver module 

Digital reception 

Enabling or disabling digital reception. When digital reception is  
enabled, the IED receives a digitally retransmitted command 
through the RS-422 port and generates a command at the HF out-
put 

 

3.7.14.4 Alarm parameters 

The Alarm parameters window (figure 127), device tree menu item Settings → Transceiver → 

Alarm parameters, is designed for configuring the parameters of the emergency and control signal trans-

mission IED alarm. 

 

Figure 127 – Alarm parameters window 

Parameters of the Alarm parameters window are shown in table 68. 

Table 68 – Parameters of the Alarm parameters window 

Parameter Description 

Receiver 

SS margin for warning 
Adjusting the warning margin in dB. When the margin of the SS level reduces, warn-
ing alarm operates 

SNR threshold  
for warning 

Adjusting the warning threshold of SNR in dB. When the SNR level reduces below 
this threshold, the receiver is blocked and failure alarm operates 

SNR threshold  
for blocking 

Adjusting the SNR threshold for blocking the receiver in dB. When the SNR level  
reduces below this threshold, warning alarm operates 

Receiver blocking 
Enabling or disabling the receiver block function. Disabling the blocking makes the 
command reception window unlimited 
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Parameter Description 

Transmitter 

Output level control Enabling or disabling HF output signal level control function 

SS threshold for warning 
Adjusting the warning threshold of SS in dBm. When the SS level at the HF output  
reduces below this threshold, warning alarm operates 

Meter correction Opens the HF output signal meter calibration window 

 

3.8 Saving settings report 

Settings report is a file containing information about the configuration. Unlike *.czg files, this file is 

more readable and not used by the device.  

The operation of saving the report on settings can be activated using command Reports → Set-

tings report on the control panel. When executing the command, it is necessary to specify the save di-

rectory and file name. 

3.9 Writing settings 

Settings can be written to the device using command       . When the command is executed, the 

settings specified in the Smart Monitor program will be written to the device. The command is not active if 

there are no changes in the device setting.  

After writing the settings, the current open window will be updated and new settings will be loaded. 

3.10 Updating settings 

The settings update button           , which is available on the toolbar of the main program window, 

is designed for forced update of settings. When this command is executed, current settings are loaded 

from the device and displayed in the Smart Monitor program. 

3.11 Saving data report via IEC 61850-8-1 protocol 

In order to generate a list of binary signals and analog measurements of the device available via 

61850 protocol, it is necessary to generate a corresponding report (Reports → IEC 61850-8-1 protocol 

data). The report file is downloaded from the device in *.xml format. 

3.12 Generating signals list via Modbus 

In order to generate a list of binary signals and analog measurements of the device available via 

Modbus protocol, it is necessary to generate a corresponding report (Reports → Modbus data descrip-

tion). In order to generate a report Microsoft Excel is required.  

When generating reports in Excel format, it must be taken into account that Engineering functions 

must be connected. All functions in this category are available in versions of Excel earlier than 2007 only 

after connecting the Analysis ToolPak add-in. 

file:///C:/Users/da-tihonova/AppData/AppData/Roaming/AppData/Local/Microsoft/Users/na-egorov/AppData/Roaming/1C/1cv8/6207252a-54e5-4990-8e73-5f09fa84839c/da-tihonova/AppData/Local/Microsoft/Documents%20and%20Settings/ia-nikitina/Application%20Data/1C/1cv8/oe-vorontsova/AppData/Roaming/AppData/Local/Microsoft/AppData/Local/Microsoft/NV-Ivanov/AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/nv-ivanov.EKRA/AppData/Local/Microsoft/Windows/svn/Documents/3GraphEnvironment/MainToolStrip.htm
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An example of a report is shown in figure 128. 

 

Figure 128 – Example of the Modbus data description report 
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3.13 Generating settings report in Excel 

To generate a report on settings in Excel format, it is necessary to generate a corresponding report 

(Reports → Settings report in Excel). An example of a report is shown in figure 129. The Excel report 

contains measuring element settings and a tripping matrix.  

In order to create a detailed settings report, it is necessary to use report generation function in text 

form. 

 

Figure 129 – Example of a settings report in Excel 
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3.14 Generating signals list for transmission via OPC protocol 

In order to generate a list of binary signals available for transmission via OPC protocol, it is neces-

sary to generate a corresponding report (Reports → List of signals in PCS (OPC identifiers)).  The 

OPC identifiers of binary signals of the device will be presented in the report. An example of a report is 

shown in figure 130.  

 

Figure 130 – Example of a report List of signals in PCS (OPC identifiers) 
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3.15 Generating signals list for transmission via IEC 60870-5-103 protocol 

In order to generate a list of signals available for transmission via IEC 60870-5-103 protocol, it is 

necessary to generate a corresponding report (Reports → IEC 60870-5-103 protocol data). An example 

of a report is shown in figure 131.  

 

Figure 131 – Example of a report IEC 60870-5-103 protocol data 
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3.16  Generating signals list for transmission via IEC 60870-5-104 protocol 

In order to generate a list of signals available for transmission via IEC 60870-5-104 protocol, it is 

necessary to generate a corresponding report (Reports → IEC 60870-5-104 protocol data). An example 

of a report is shown in figure 132.  

 

Figure 132 – Example of a report IEC 60870-5-104 protocol data 

3.17 Importing settings 

The window for importing settings from a file is activated through the main menu             → Import 

settings from xml. Then, select the configuration file using the Open button. 
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3.18 Generating files to send 

The Generate files to send command is designed to generate an archive file containing files 

downloaded from the device, as well as Smart Monitor service files from the user's local machine. In case 

of emergency situations, the generated archive is designed to be sent to the technical support service for 

further analysis and identification of the causes of device malfunctions. 

To generate files to send, it is necessary to activate item               → Generate files to send. Then, 

select a location for saving and click the Save button. 

3.19 Possible failures 

Causes of errors when establishing connection: 

1) The operating system does not have the Modbus TCP/IP protocol installed. In this case, it is 

necessary to close the program, activate the Control panel, select the Network shortcut and install the 

Modbus TCP/IP protocol. 

2) A message may appear saying “The computer with the IP address of the communication server 

specified in the object structure description file is not found”. In this case, it is necessary to make sure that 

the PC with which you want to establish a connection is working, and check that the name or IP address 

of this PC is set correctly. Another possible reason for the above messages to appear is that when config-

uring the Modbus TCP/IP protocol on the local computer, the IP address of this PC was not set.  

3) It may turn out that a PC at the specified name or IP address is found, but the PC is using a 

different TCP port than that specified in the program. In this case, it is necessary to determine which TCP 

port is used to connect to the program. 

If there are any difficulties please address system administrator of the company LAN. 
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4 Description of Configurator interface 

The Configurator program is designed to create and edit off-line configurations of devices based 

on ED2 series devices. 

The Configurator program has a graphic interface as user interface.  

The type of interface used by the program is a standard MDI type interface with support for 

Drag&Drop technology, which has one main window containing several child ones. Child windows contain 

the main functionality of the program. In accordance with the standards for Windows applications, the main 

window contains the main menu and a toolbar. 

This section contains a description of the graphic environment of the program and its main compo-

nents. 

 

3.1 Start 

The program is started using menu Start → All programs → EKRA → Configurator. 

 

3.2 Shutdown 

The program is shutdown in the standard ways for Windows applications: 

– through menu File → Exit; 

– by clicking             on the title bar of the main window.  

 

3.3 Title of main window 

The title text of the window consists of the name of the program, version of the program, type of 

the edition of the program and has a form shown in figure 133, item 1. 

 

Figure 133 – Main window of the Configurator program 

2 

3 
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2 
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3.4 Main menu 

The main menu is located under the title bar of the main menu and has a form shown in figure 133, 

item 2. 

Each item on the main menu has a submenu associated with it. The submenu appears when the 

corresponding item of the main menu is selected (by pressing the left mouse button on the menu item). 

For some sub-items, hot keys are also indicated. 

3.4.1 File menu 

Commands of the File menu are shown in table 69. 

Table 69 – Commands of the File menu 

Command Description 

Open project...  Opening the current configuration 

Close project Closing the current configuration 

Save Ctrl+S Saving the current configuration 

Save as  Saving the current configuration with a location and name 

Recent project Displaying and opening recent projects 

Exit Exiting the program 

 

3.4.2 Edit menu 

Commands of the Edit menu are shown in table 70. 

Table 70 – Commands of the Edit menu 

Command Description 

Undo Ctrl+Z Undo a previous action 

Redo Ctrl+Y Redo an undone action 

Action control Enables/disables rollback of actions 

Logging Writing logs to a file 

 

3.4.3 View menu 

Commands of the View menu are shown in table 71. 

Table 71 – Commands of the View menu 

Command Description 

Library window 
Displaying the library of modules available for the project (you must be on the 
Modules form in the project tree to display it) 

Project tree Displaying the project tree 

Output window Displaying the window of message output 
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Command Description 

Imported data sets Displaying the window of imported data sets 

Logic library Viewing the logic library with possible addition of elements to the Logic form 

Configuration errors Displaying the window of configuration errors 

Special characters table Displaying the table of special characters 

Logic Checking the “Display grid” box activity 

 

3.4.4 Configuration menu 

Commands of the Configuration menu are shown in table 72. 

Table 72 – Commands of the Configuration menu  

Command Description 

Check configuration  
integrity 

Check the configuration for errors. There is a certain set of rules that the  
configuration must comply with. If the configuration does not comply with the  
specified rules, then an incorrect configuration message will be displayed and it will 
need to be corrected 

 

3.4.5 Service menu 

Commands of the Service menu are shown in table 73. 

Table 73 –  Commands of the Service menu 

Command Description 

Reports 

Generation of reports: 

– Modbus data description; 

– Settings report; 

– Settings report in Excel; 

– List of signals APCS (OPC IDs); 

– IEC 60870-5-103 protocol data; 

– IEC 60870-5-104 protocol data; 

– IEC 61850-8-1* protocol data; 

– Settings sheet 

Settings 

Selection of program language:  

– Russian (ru);  

– English (en); 

– Spanish (es) 
Associate *.czg and *.arh 

* To create a report, go to the window. 

 

3.4.6 Help menu 

Commands of the Help menu are shown in table 74. 

Table 74 – Commands of the Help menu 

Command Description 

About Displaying the name of the program, version of the program, hardware code  
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3.5 Toolbar 

The toolbar provides an alternative way to access the most commonly used commands (figure 133, 

item 3).  

Toolbar commands are shown in table 75. 

Table 75 – Toolbar commands 

View Name 

 Open 

 Save 

 
Undo 

 
Redo 

 Autosave (at specified interval) 

 
Language localization (used to set parameter names for each language of the created  
configuration) 

 
DebugInfo (Displaying additional information of logical nodes on the logic diagram) 

      (      ) Settings display mode (primary/secondary values) 

 Settings report... 

 Settings report in Excel 

 

Notes  

1 Some forms have additional tools which are dynamically added to the main toolbar. 

2 When generating reports in Excel format, it must be taken into account that Engineer functions must be 

connected. These functions are used in engineering and scientific calculations. All functions of this category are 

available in Excel versions earlier than 2007 only after connecting Analysis ToolPak add-in.  

 

3.6 Output window and status bar 

3.6.1 Output window 

The output window (figure 134), menu item View → Output window, is designed to display mes-

sages about the progress of the program. To view the contents of the window, hover the mouse pointer 

over the window or open it through the menu. 
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Figure 134 – Output window 

3.6.2 Status panel 

The status panel (figure 135) is designed to display intermediate information about the progress of 

the program to the user. 

 

Figure 135 –  Status panel of the Configurator program
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5 Description of work with Configurator program 

5.1 Description of Configurator editions 

The following acronyms are used in table 76: 

– X – the function is available in full; 

– Y – the function is available, but with limitations. Limitations are described; 

– “–” – the function is not available. 

Table 76 – Description of editions 

Configurator program edition Free Protection Int Free Bay Controller Int 

Device functionality code Protection Int Bay Controller Int 

Distribution terms 
The edition is selected automatically when opening a configu-

ration with the corresponding functional purpose code and does not 
require additional settings 

O
p
ti
o

n
s
 

Changing composition of  
hardware modules 

Y 
(Available only for  

indication modules) 

Y 
(Available only for  

indication modules) 

Changing composition of virtual 
software input/output modules 

X X 

Switching devices 

Y 
(It is inhinited to add new 

SDs;  
it is inhibited to edit the SD 
“Type” parameter) 

X 

Configuring device system  
settings 

X X 

Configuring programmable 
logic 

X X 

Adding new functions and  
measuring elements 

– – 

Setting parameters of functions 
and measuring elements 

X X 

Configuring all communication 
protocols available in project 

X X 

Editing signals table X X 

Ranking matrix of output relays X X 

Ranking matrix of LEDs X X 

Mimic diagram X X 

Creating display pages and 
icons 

X X 

Setting parameters of event 
and disturbance recorder 

X X 

Comparing setting groups X X 

Calculated values 
Y 

(It is inhibited to add new  
calculated values) 

X 
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5.2 Opening, saving project configuration 

5.2.1 Project opening 

An existing project is opened through menu File → Open project or by clicking button  on 

the toolbar. 

 

NOTICE 

The project must be opened with the measuring element library file with which it was created! 

 

After opening, a project tree will be added (figure 136, item 1) and the default form About will open 

(figure 136, item 2). When opening subsequent projects, they will be added to the project tree in the same 

way. There are no limitations on the quantity of simultaneously open projects. 

 

Figure 136 – Main window of the Configurator program 

The recommended order for entering data and parameters when creating a configuration is shown 

in table 77. 

1 2 
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Table 77 – Order of configuration formation 

Part Configuration parameter 

H
a
rd

w
a
re

 p
a
rt

 

Modules 

Cabinet digital outputs 

Analog inputs 

Terminal block of analog inputs 

Binary input 

Switching device remaining life 

System parameters 

S
o
ft
w

a
re

 (
lo

g
ic

) 
p
a
rt

 

Measuring elements 

Logic 

IED signals table 

Matrix of binary outputs 

Indication matrix 

Tripping matrix 

Event recorder 

Disturbance recorder 

Measurements for indication 

Mimic diagram 

Management 

Differences by setting groups 

IE
C

 6
1
8
5

0
 

Outgoing GOOSE 

Incoming GOOSE 

Data sets 

Report blocks 

Data model 

 

5.2.2 Saving project 

The project is saved through menu File → Save Ctrl+S or through menu File → Save as, or by 

clicking button  on the toolbar. When you close the main window of the program or the project tree, a 

confirmation window will open for saving changes if the configuration was changed during work (fig-

ure 137). When saving the project, the logic is recompiled if changes were made to it during work. 
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Figure 137 – Configuration closing 

5.3 Hardware part 

5.3.1 Modules 

The Modules window, device tree menu Hardware part → Modules, is designed for configuring 

hardware (physically existing modules in the IED) and virtual (used to expand functionality) IED modules 

in accordance with order requirements. 

5.3.1.1 General parameters of modules 

For all types of modules, there are general parameters for configuration (figure 138). 

 

Figure 138 – General parameters of modules 

The description of general parameters is given in table 78. 

Table 78 – General parameters of modules 

Parameter Description Limitation 

Name Name of the module 
For all types of modules 

Library module Name of the module in the logic library 

Cassette Selection of the IED cassette 

Only for hardware modules Module address on 
bus 

Address of the module on the IED bus 

 

5.3.1.2 Specific parameters of modules 

5.3.1.2.1 Input/output module (Combined module) (figure 139) 

Module of binary inputs/outputs (Combined module) receives binary signals from external devices 

and switches external control and alarm circuits. 
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Figure 139 – Signals of input/output module (combined module) 

The description of bit parameters of the combined module is given in table 79. 

Table 79 – Description of parameters of combined module signals 

Parameter Description 

No. Number of the signal 

Name Signal name in the configuration 

Oper.DT, ms Time delay for operate in milliseconds 

Return DT, ms Time delay for release in milliseconds 

Relay action Indicator of relay presence (only for modules with output relays) 

 

5.3.1.2.2 Module of virtual analog inputs (figure 140) 

The virtual analog input module is designed to convert analog input current and voltage signals into 

digital data and transmit them to the logic module for further processing.  

 

Figure 140 – Parameters of virtual analog input module 

The description of parameters of virtual analog inputs is given in table 80. 
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Table 80 – Description of parameters of virtual analog inputs 

Parameter Description 

No. Sequence number of the input value 

Name of input value Name of the input value 

Type of input value 

Type of the input value 

– Voltage; 

– Current  

Max. input value Maximum input value 

SI reduction factor Factor of reduction to SI system (B, A). By default – 1 

 

5.3.1.2.3 Module of virtual inputs (figure 141) 

The virtual inputs module is designed to receive binary signals via digital communication channels. 

Reception of signals is available via IEC 61850, IEC 60870-5-103 and Modbus protocols. 

 

Figure 141 – Signals of virtual inputs module 

The description of virtual input modules parameters is given in table 81. 

Table 81 – Description of virtual input modules parameters 

Parameter Description Limitation 

No.  Number of the signal in the module For all software digital inputs 
modules Name Name of the signal in the configuration 

Pulse mode 
Mode in which module signals are reset to 0 after  
processing received data   

Only for “VInput” module 
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5.3.1.2.4 Time synchronization module (figure 142) 

Module B1281 provides time synchronization of the IED according to the IRIG-B standard.  

 

Figure 142 – Time synchronization module 

Simultaneous use of IRIG-B hardware synchronization (figure 143) and PPS is not allowed, there-

fore, if using IRIG-B synchronization, PPS hardware synchronization should be disabled.  

 

Figure 143 – Hardware synchronization (IRIG-B) 

The description of parameters of the time synchronization module is given in table 82. 

Table 82 – Description of parameters of the time synchronization module 

Parameter Description 

Hardware synchronization enabled Indicator of enabling hardware synchronization  

Standard Standard of time synchronization  

Modification Modification of the time synchronization standard  

Synchronization source Selection of a synchronization source 

 

5.3.1.2.5 Analog input module (figure 144) 

The analog input module is designed to receive electrical analog signals of currents and voltages. 

 

Figure 144 – General parameters of the analog input module 



   
 

130   EKRASMS-SP software package manual 
EKRA.00019-01 34 02, Edition 05.2023 

5.3.1.2.6 Transceiver module (figure 145) 

The transceiver module provides communication between the IED and external devices via RS-

485 interface. 

 

Figure 145 – General parameters of the transceiver module 

The description of parameters of the transceiver module is given in table 83. 

Table 83 – Description of parameters of the transceiver module 

Parameter Description 

Function 

Function of the module: 
– Receiver; 
– Transmitter; 
– Transceiver 

Signal count 

Quantity of signals 
– 8; 
– 16; 
– 24; 
– 32; 
– 64 

Transmission method 

Method of signal transmission: 
– Single-frequency; 
– Double-frequency serial; 
– Double-frequency parallel 

 

5.3.1.2.7 Sampled Values reception module (figure 146) 

The Sampled Values reception module is designed to receive analog signals via IEC 61850-9-2 

protocol. 

  

Figure 146 – General parameters of the Sampled Values reception module 

The description of parameters of the Sampled Values reception module is given in table 84. 

Table 84 – Description of parameters of the Sampled Values reception module  

Parameter Description 

Stream No. Serial number 

svID String identifier of instantaneous values 

1 
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Parameter Description 

MAC address Destination address 

Data sets Current and/or voltage data of ASDU 

Type Opening the Value type window 

 

When you click the button with image  a new ASDU of the Sampled Values reception module is 

added. When you click the button with image  the selected ASDU is deleted. 

When you click button “…” (figure 146, item 1) the Value type window appears (figure 147). 

 

Figure 147 – Value type window 

The description of parameters of the Value type window is given in table 85. 

Table 85 – Description of parameters of the Value type window  

Parameter Description 

Name  Name of the value type 

Direct current/voltage Value type (direct current or voltage) 

 

5.3.1.2.8 Logic module (figure 148) 

Logic module provides operation of IED software, external connection via Ethernet and RS-485 

interfaces, connection of the IRIG-B time synchronization signal. 
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Figure 148 – General parameters of the logic module (logic module) 

5.3.1.2.9 Power supply module (figure 149) 

The power supply module provides all components of the device with a stabilized voltage, as well 

as protection of electronic elements from interference and overvoltage. It performs galvanic isolation of 

internal circuits of the device from the power circuit. 

 

Figure 149 – General parameters of the power supply module 

5.3.1.2.10 Binary output module (figure 150)  

The binary output module contains output relays for generating control signals for external tripping 

and alarm circuits, the contacts of which are galvanically isolated from the internal circuits of the device. 

 

Figure 150 – Signals of binary output module 

The description of parameters of output module signals is given in table 86. 
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Table 86 – Description of parameters of output module signals 

Column Description 

No. Number of the signal in the module 

Name Name of the signal in the configuration 

Return DT, ms Time delay for return in milliseconds 

Relay action Indicator of relay presence 

 

5.3.1.2.11 Indication module (figure 151) 

The indication module is designed for displaying, monitoring the current state, editing settings, 

checking operation of the device, making an external connection of the device to the computer. 

 

Figure 151 – Signals of the indication module 

The description of signal parameters of the indication module is given in table 87. 

Table 87 – Description of signal parameters of the indication module 

Column Description 

No. Number of the signal in the module 

Name Name of the signal in the configuration 

A, B, C, D… LED columns 
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5.3.1.2.12 Binary input module (figure 152) 

 

Figure 152 – Signals of binary input module 

The description of parameters of binary input module signals is given in table 88. 

Table 88 – Description of parameters of binary input module signals 

Parameter Description 

No. Number of the signal in the module 

Name Name of the signal in the configuration 

Oper.DT, ms Technological time delay for operate in milliseconds 

Return DT, ms Technological time delay for release in milliseconds 

 

5.3.2 Analog inputs 

Analog inputs are a combination of real signals (which are bound to the output of the sensor mod-

ule), calculated signals (allows you creating signals from other signals using a certain function), virtual 

signals (allows you creating signals from other signals with different ratings and transformation ratios) and 

telemetry signals. 

The Analog inputs window, device tree menu Hardware part → Analog inputs, are used as input 

data in the measuring element operation logic and in the formulas of the Calculated values tree node.  
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Figure 153 – Analog inputs window 

Commands of analog input panel (figure 153, item 1) are shown in table 89. 

Table 89 – Commands of analog input panel 

Icon Command 

 Move up 

 Move down 

 
Frequency groups… 

 Grouping of analog inputs 

 Create a telemetry signals 

 

General parameters of analog signals are shown in table 90. 

2 

3 

4 

1 
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Table 90 – General parameters 

Parameter Description 

Signal name Name of the signal 

Signal phase name Name of the signal phase 

Signal type Signal type (real) 

Signal mode  Mode (type) of signal (phase, linear, null, undefined) 

Base value 
Base value of the input signal of the sensor module input (without measure-
ment unit) 

Transformation ratio 
Ratio of the nominal value of the signal in the primary circuit to the rated 
value of the signal at the sensor input (for example, when connecting a signal 
from the current transformer or voltage transformer) 

Visible 
The set flag allows displaying measurements in the Analog inputs item on 
the device display 

 

Signal setting (figure 153, item 2) 

The section is designed for binding the real signals to the physical output of the sensor module. 

The description of parameters of the signal section is given in table 91. 

Table 91 – Parameters of the Signal setting section 

Parameter Description 

Sensor Sensor module from the general list 

Sensor output Sensor output of the selected sensor module 

Range Selecting the sensor output range 

Reverse current 180˚ The set flag turns the current by 180 degrees 

Do not change the range for 
the same sensor outputs 

The set flag forbids to change change the range for the same sensor outputs 

 

Forced phasor creation (figure 153, item 3) 

Forced creation of a phasor is necessary to set the option of using the analog input value in the 

IED if it is not used in any of the measuring elements. If the analog input is used in any measuring element, 

then the phasor will be created inside the measuring element and this parameter does not need to be set. 

If no phasor is created for the analog input, the value of the analog input will not be displayed on 

the IED or in the Smart Monitor program. 

The description of parameters of forced phasor creation is given in table 92. 

Table 92 – Forced phasor creation  

Parameter Description 

Create phasor Selecting the option of phasor creation 

Harmonic Selecting a signal harmonic (selection of a harmonic for display) 

Sample 
Number of the sample on which the signal phasor is created (used to allocate processor 
time when calculating phasors) 

 

Parameters of signal transmission to PCS (figure 153, item 4) 

The section is designed for setting parameters of IEC 61850-8-1 and IEC 60870-5-104 protocols: 

values of analog data transmission and attributes of analog signal range. 
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The description of deadband parameters is given in table 93. 

Table 93 – Parameters of signal transmission to PCS 

Parameter Description 

Deadband, % of base value 

Value that determines the limit of signal change, above which a report on the 
change in the signal value will be sent. 
Value in relative units, 1 relative unit equals to 0.00001 of the maximum value 
of the sensor input range. 

Deadband, A  
Value in absolute units. The value is calculated automatically by the program.  
It is equal to the product of the parameter in absolute units by the maximum 
value of the sensor input and 0.00001 

 

The description of settings of the analog signal range is given in table 94. 

Table 94 – Alarm and validity thresholds 

Parameter Description 

Maximum 
If the analog value is greater than the setting, the range value becomes high-high and  
the quality – questionable 

Uppermost 
If the analog value is greater than the setting, the range value becomes high-high and  
the quality – good 

Upper 
If the analog value is greater than the setting, the range value becomes high and  
the quality – good 

Lower 
If the analog value is greater than the setting, the range value becomes normal and  
the quality – good  

Lowermost 
If the analog value is greater than the setting, the range value becomes low and  
the quality – good  

Minimum 
If the analog value is less than the setting, the range value becomes low-low and  
the quality – questionable 

 

5.3.2.1 Frequency groups 

To operate the relay protection and automation functions in an extended frequency range (from 3 

to 95 Hz), the digital signal processing algorithms must be adapted to the current network frequency. In 

the ED2 series devices, this adaptation is achieved by combining signals into frequency groups.  

5.3.2.1.1 General 

The configuration program is provided with the option to use a signal from one analog input of the 

IED in several frequency groups. 

Frequency signal group is a variety of currents and voltages generated by the same source of 

electric power and used in the IED as a group of signals of the same frequency.  

In the software configuration of IEDs, up to six frequency groups can be created numerated starting 

with zero.  

Zero frequency group of signals is created automatically. Adaptation of signal processing algo-

rithms of the zero frequency group to the current network frequency is not performed. Therefore, signals 

of the zero frequency group are intended for use in measuring elements (ME) operating in the frequency 

range from 45 to 55 (from 54 to 66) Hz. 

To operate the ME in an extended frequency range (from 3 to 95 Hz), it is necessary to supply the 

signals included in a non-zero frequency group. 
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NOTICE 

All signals fed to the measuring element must be in the same frequency group.  

The exception is measuring element SC, SC (L), SC (BC), AS, RE < (VD) and RE < 17! 

The frequencies of all signals of a non-zero frequency group are estimated based on the base 

signals of the frequency group. Base signals are selected when creating the software configuration of the 

IED in the frequency group editor. 

The disadvantage of this method is that the frequency is calculated relative to the basic signal 

(current or voltage) and in the absence of this signal at the input, it will be impossible to correctly calculate 

the frequency. Therefore, the use of three base signals increases the reliability of the relay protection 

functions, since the frequency estimate remains available as long as at least one signal is present. To use 

three base signals, all three signals must be in the same three-phase group of signals. 

5.3.2.1.2 Order of combining signals 

To combine signals into frequency groups, it is required to: 

–  select frequency domains on the network diagram – network sections, the frequencies of cur-

rents and voltages for which are always equal; 

– combine the signals used in the relay protection functions of the elements of each frequency 

domain into a separate non-zero frequency group. 

To use three signals, the first signal of the three-phase group is marked in the editor of frequency 

groups (for example, voltage of phase A of the three-phase voltage group, figure 154). 

 

Figure 154 – Frequency groups window 
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5.3.2.1.3 Recommendations on selection of base signals of frequency groups 

The reliability of RPA functions operating in the extended frequency range is determined by the 

possibility of estimating the frequency of base signals. Therefore, the signals that are present in all non-

emergency modes of operation of the power facility (with changes in the diagram, mode, etc.) should be 

selected as base signals of the frequency group.  

It is recommended to use phase or line voltages as base signals, since their level practically does 

not change with changes in diagrams and modes. 

It is recommended to use three base signals. 

If three phase voltages are used as base signals, then when creating a configuration, in order to 

increase reliability, it is recommended to activate the function of determining the frequency based on cal-

culated line signals (figure 155). 

 

Figure 155 – Activating the function of estimating the frequency determination  

based on calculated line signals 

5.3.2.1.4 Example 

It is required to distribute signals measured in the power circuit to frequency groups and to select 

base signals (figure 156).   

In the diagram under consideration, two frequency regions can be distinguished: 

– generator-transformer unit; 

– excitation circuits – earth. 

Measuring transducers CT1, CT2, CT3 and VT1 are used to protect the generator and transformer, 

and CT4 and VT2 are used to protect the excitation winding. Therefore, in the diagram under considera-

tion, signals must be combined into frequency groups according to table 95. 

In frequency domain No. 1, a three-phase group of voltages from VT1 is selected as the basic 

signal. In frequency domain No. 2, the voltage from VT2 is selected as the basic signal.  
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Figure 156 – Diagram  

Table 95 – Frequency groups 

 

5.3.2.2 Grouping analog inputs 

The function is required for grouping analog inputs. It is used in cases where ungrouped circuits 

are grouped to bind them to measuring elements. When you click on the Grouping analog inputs button 

, located on the toolbar, an editor (figure 157), is displayed in which you can group ungrouped analog 

inputs. In this window, you can add, remove groups of analog inputs using the buttons on the toolbar of 

the window. 

 

Figure 157 – Groups of analog inputs window 

Frequency group No. 
Sources of signals  

included in frequency group 
Source of basic signal 

of frequency group 

1 CT1, CT2, CT3, VT1 VT1 

2 CT4, VT2 VT2 
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5.3.3 Binary inputs 

The Binary inputs window, device tree menu Hardware part → Binary inputs (figure 158), is 

designed for configuring binary inputs of the device (circuits of binary input and virtual input modules). 

Technological binary input time delays (designed for offset from interference): 

– for operate; 

– for return. 

Note  Changing time delays in binary inputs or input modules in the Modules menu item is synchronized. 

Allows you to set the total value of time delays for operate and return for all inputs (figure 158, 

item 1). 

Enable inverting (figure 158, item 2): All inputs – when the box is checked, binary inputs of all 

modules are enabled for inverting. 

 

Figure 158 – Binary inputs window 

Parameters of inputs are shown in table 96. 

Table 96 – Parameters of binary input 

Parameter Description 

BI No. Number of the binary input in the list of binary input 

Module type Name of belonging of the binary input module 

Module  Name of the module of binary inputs 

Bit No. Sequence number of the binary input on the device board 

Name  Name of the binary input in the configuration 

BI enabled Indicator of processing the binary input by the device 

Value when disabled Binary input value when it is disabled 

1 

2 
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Parameter Description 

Invert Checked box indicates inversion of module’s binary input 

Oper.DT, ms Operate time in milliseconds (only for physical binary input modules) 

Return DT, ms Return time in milliseconds (only for physical binary input modules) 

 

5.3.4 System parameters 

5.3.4.1 Communication parameters 

The tab is designed for configuring communication parameters of the IED. 

5.3.4.1.1 Interfaces 

The checked box allows you writing settings when connected to the terminal via the selected inter-

face (figure 159). 

 

Figure 159 – Interfaces 

 

NOTICE 

In order to increase the level of information security and prevent unauthorized access to the device,  

it is recommended to assign service functions to the Ethernet 0 port,  

which is located on the front panel of the device. 

 

5.3.4.1.2 TCP/IP parameters 

Setting the parameters for checking the connection and parameters for TCP requests (figure 160).  

 

Figure 160 – TCP/IP parameters 

Parameters of TCP/IP are shown in table 97. 
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Table 97 – Parameters of TCP/IP 

Parameter Description 

Connection check pa-
rameters (KeepAlive) 

– Check period (idle time of the line, after which the connection check will start) in 
seconds; 

– Packet send intereval (time between sending service packets) in seconds; 

– Packet send time (time for sending service packets) in seconds 

Parameters of TCP re-
quests 

– Maximum time between TCP request and response in milliseconds; 

– Minimum time between TCP request and response in milliseconds; 

– Time of repeated TCP requests in milliseconds 

 

5.3.4.1.3 Network interface settings 

IP addresses are configured for communication interfaces such as Ethernet (figure 161). 

 

Figure 161 – Network interface settings 

Note – Each port must have its own subnet, except for ports that are reserved for each other. 

 

5.3.4.1.4 Serial ports 

Communication settings for all serial ports (figure 162). The Protocol parameter specifies the se-

lected communication protocol for the operation of the serial port. For the USB port, the settings are fixed 

and cannot be changed. The IED address parameter allows you to select an IED address for each serial 

port. 

  

Figure 162 – Serial port 
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5.3.4.2 Time synchronization 

The tab is designed for configuring parameters of software and hardware time synchronization. 

5.3.4.2.1 Software time synchronization (figure 163) 

 

Figure 163 – Software time synchronization 

Parameters of software time synchronization are shown in table 98. 

Table 98 – Software time synchronization 

Parameter Description 

Interface Selection of interface for software time synchronization 

Protocol Protocol for the selected interface 

Correction (in hours) Correction of time synchronization in hours 

Adjust for daylight saving time 
automatically 

Checked box indicates automatic switch to summer/winter time 

 

5.3.4.2.2  Hardware synchronization (PPS) (figure 164) 

 

Figure 164 – Hardware synchronization (PPS) 

Parameters of PPS hardware synchronization are shown in table 99. 
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Table 99 – Hardware synchronization (PPS) 

Parameter Description 

Hardware sync enabled Enable use of hardware synchronization 

Synchropulse period, s Selection of synchronization pulse period in seconds 

Registred transition 
Selection of transition to fall or rise  
(parameter determines when time synchronization occurs) 

Minimum pulse duration, ms 
Selection of the minimum pulse duration in milliseconds  
(for protection from interference and chatter) 

Calibration value, ms Selection of the calibration value in milliseconds 

Permissible deviation of synchro-
pulse period, ms 

Selection of permissible deviation of the syncropulse period in milliseconds 

Synchronization source Time synchronization source 

 

Note  Hardware synchronization must be disabled if IRIG-B time synchronization is enabled in the config-

uration. 

 

5.3.4.3 Hardware synchronization (IRIG-B) (figure 165) 

 

Figure 165 – Hardware synchronization (IRIG-B) 

Parameters of IRIG-B hardware synchronization are shown in table 100. 

Table 100 – Parameters of IRIG hardware synchronization 

Parameter Description 

Hardware sync enabled Enable use of hardware synchronization 

Standard Time synchronization standard  

Modification Version of the time synchronization standard  

Synchronization source Time synchronization source 

 

5.3.4.4 Ethernet protocols 

The tab is designed for configuring protocols. Adding and deleting protocols is carried out using 

buttons                     and        (figure 166, item 1).  
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Figure 166 – Ethernet protocols tab 

Note – The composition of protocols may differ depending on the type of device. 

General parameters of protocols are shown in table 101. 

Table 101 – General parameters of protocols 

Parameter Description 

Protocol name ModbusTCP, 60870-5-104, 61850, SNTP, ModbusTCP c-t, PTP 

Protocol enabled Indicator of enabling protocol operation in IED software 

 

5.3.4.4.1 Configuring the ModbusTCP data transmission protocol (figure 166, item 2) 

5.3.4.4.2 Configuring the 60870-5-104 (IEC 60870-5-104) data transmission protocol (figure 167) 

1 

2 
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Figure 167 – Parameters of the IEC 60870-5-104 protocol 

The description of parameters of the IEC 60870-5-104 protocol is shown in table 102. 

Table 102 – Parameters of the IEC 60870-5-104 protocol  

Parameter Description 

Quantity of clients 
Maximum possible quantity of clients that can be connected to the IED using the 
IEC 60870-5-104 protocol 
(default – 3, maximum – 10) 

Measurement transmission 
type  
 

– Cyclic (periodic) – 0; 

– Sporadic (when signal is changed) – 1; 

– Cyclic & Sporadic – 2 (by default); 

– Disabled – 3 

Client time-out, s 
Time interval in seconds, after which it is considered that there is no connection 
with a client if no data was received from the client (60 by default) 

Measurement data type 

– Normalized – 1; 

– Scalable – 2; 

– Floating point – 3 (by default) 

Sending period, s 
Time interval in seconds during which the transmission of cyclic measurements 
is repeated 
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Parameter Description 

Binary data 

Composition of transmitted binary data: 

– Logic signals – 1; 

– Binary outputs – 2; 

– All signals – 3 

Analog data 

Composition of transmitted analog data: 

– Analog values – 1; 

– Calculated values – 2; 

– Protection phasors – 3; 

– All measurements – 4 

Base address of logic signals 

Base address of logic signals (value must be in the range of 1 to 16,777,215)  
according to IEC-60870-5-104 protocol. It is not recommended to change the 
value without agreement with software developers of the ED2 series device.  
Default value 257 

Base address of binary out-
puts 

Base address of binary outputs (value must be in the range of 1 to 16,777,215) 
according to IEC-60870-5-104 protocol. It is not recommended to change the 
value without agreement with software developers of the ED2 series device.  
Default value 1281 

Base address of analog val-
ues 

Base address of analog values (value must be in the range of 1 to 16,777,215) 
according to IEC-60870-5-104 protocol. It is not recommended to change the 
value without agreement with software developers of the ED2 series device. De-
fault value 2561 

Basic address of calculated 
values 

Base address of calculated values (value must be in the range of 1 to 
16,777,215) according to IEC-60870-5-104 protocol. It is not recommended to 
change the value without agreement with software developers of the ED2 series 
device. Default value 3073 

Base address of protection 
phasors 

Base address of protection phasors (value must be in the range of 1 to 
16,777,215) according to IEC-60870-5-104 protocol. It is not recommended to 
change the value without agreement with software developers of the ED2 series 
device. Default value 3329 

Transmission mode 
Protocol operation mode 
Constant parameter 
By default – Balanced 

ASDU address size 
Constant parameter 
By default – 2 

Size of transmission reason 
field 

Constant parameter 
By default – 2 

Size of information object ad-
dress 

Constant parameter 
By default – 3 

k Max. quantity of APDU 
without ACK 

Value of k indicates the maximum quantity of consecutively numbered Format I 
APDUs that can be transmitted without acknowledgment (value must be in the 
range of 1 to 32,767 in increments of 1). Default value 12 

w Sending an ACK after re-
ceiving w APDU 

Value of w is the quantity of APDUs read, after which an ACK should be sent 
(value must be in the range from 1 to 32,767 in increments of 1). Default value 8 

ASDU address By default – 1 ((value must be in the range of 1 to 247) 

 

The list of transmitted signals via IEC 60870-5-104 protocol is shown in table 103. It can be gener-

ated via main menu Service → Reports → IEC 60870-5-104 protocol data. 

Table 103 – List of signals transmitted via IEC  60870-5-104 protocol 

Signal Transmission method 

Binary signals 
These signals are transmitted via ASDU 30 (IEC 60870-5-101). 
The size of the address field of the information object is 3 bytes. The signal value is 
represented by the SPI bit of the SIQ field of size 1 byte (IEC 60870-5-101) 
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Signal Transmission method 

Analog measurements 
Measurement data is transmitted via ASDU 13 (IEC 60870-5-101). 
Size of the address field of the information object is 3 bytes. The measurement value 
is represented by a short floating point format of 4 bytes (IEC 60870-5-101) 

Commands These signals are transmitted via ASDU 45 and ASDU 46 (IEC 60870-5-101) 

Analog channels These signals are transmitted via ASDU F_SG_NA_1 (IEC 60870-5-101) 

 

5.3.4.4.3 Configuring the IEC 61850 (IEC 61850-8-1) data transmission protocol (figure 168) 

 

Figure 168 – Parameters of the IEC 61850 protocol 

Description of parameters of the IEC 61850 protocol is shown in table 104. 

Table 104 – Description of parameters of the IEC 61850 protocol  

Parameter Description 

Enable outgoing GOOSE 
It is permitted to exchange binary data between IEDs via GOOSE messages.  
Data transmission is planned for this device 

Enable incoming GOOSE 
It is permitted to exchange binary data between IEDs via GOOSE messages.  
Data reception is planned for this device 

IED name Device name (identifier) available only via IEC 61850-8-1 protocol 

Sign of using an extended 
protocol 

If the documented option of IEC 61850-8-1 to add its data types and attributes  
(protocol extension) is used 

Encoding of COMTRADE 
file names 

Encoding used for COMTRADE file names (Windows-1251 or UTF-8) 

 

When adding the IEC 61850 (IEC 61850-8-1) protocol to the configuration, the IEC61850 menu 

item will appear in the project tree. 

 

5.3.4.4.4 Configuring the SNTP time synchronization protocol  

Quantity of servers used for time synchronization via SNTP protocol is no more than four.  
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The SNTP protocol is described in the Configurator with the following parameters (figure 169): 

– Enabled; 

– Priority (Very low, Low, High, Very high); 

– Server IP address; 

– Server port; 

– Synchronization period, s; 

– Response wait time, s. 

 

Figure 169 – Parameters of the SNTP protocol 
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5.3.4.4.5 Configuring the ModbusTCP c-t data transmission protocol (Modbus TCP client) (fig-

ure 170) 

 

Figure 170 – Parameters of the ModbusRTU c-t protocol  

The description of parameters is shown in table 105. 

Table 105 – Description of additional parameters of the Modbus TCP client protocol 

Parameter Description 

Additional parameters 

Server index 
Client number from “ModbusClients” (1 by default). The parameter is not directly editable. 
The value is set by selecting one of the values in the "Modbus TCP client parameters" ta-
ble 

Server IP address IP address of the server to which the client is connecting (128.0.0.1 by default) 

Server port TCP port of the server to which the client is connecting (502 by default) 

Modbus TCP client parametersПараметры клиента Modbus TCP 

Server name 
The name of the server to which the client is connecting. Configured in the 
ModbusClients tab 

Usage Selecting the appropriate server for a given client 
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5.3.5 Configuring the PTP data transmission protocol (figure 171) 

 

Figure 171 – Parameters of the PTP data transmission protocol 

The description of parameters of the PTP data transmission protocol is given in table 106. 

Table 106 – Parameters of the PTP data transmission protocol 

Parameter Description 

Synchronization  
period, s 

Time interval in seconds (value must be in the range of 2 to 3,600 s)by the expiration of 
which synchronization is repeated 

Clock type 

It sets the synchronization algorithm: 

– Boundary; 

– Transparent 

Management via PTP Enable/disable PTP control 

Sync lower bound 
(1..999,999,999  
nanoseconds) 

Minimum time difference between local clock and source of reference time  
in nanoseconds (value must be in the range of 1 to 999,999 999 ns) 

Sync upper bound 
(1..999,999,999  
nanoseconds) 

Maximum time difference between local clock and source of reference time  
in nanoseconds (value must be in the range of 1 to 999,999 999 ns) 

(Boundary) domain 
0..255  

Binding of the device to a specific PTP domain (value must be in the range of 0 to 255) 

(Boundary) priority 1 
0..255  

It determines the priority for port 1 (value must be in the range of 0 to 255) 

(Boundary) priority 2 
0..255  

It determines the priority for port 2 (value must be in the range of 0 to 255) 
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Parameter Description 

(Boundary) utc offset 
-32,768..32,768 

Difference between PTP and UTC timeline in seconds (value must be in the range of  
minus 32,768 and plus 32,767 s) 

(Boundary) utc offset 
is valid 

Offset from timeline: 

– box checked – timeline offset; 

– box not checked – no timeline offset 

(Transparent) delay 
mechanism 

Algorithm for measuring the delay of the transmitted messages: 

– e2e; 

– p2p; 

– e2e-optimized; 

– none 

(Transparent) is multi 
domain 

Operation of the PTP synchronization independent of the domain: 

– box checked – operation of PTP synchronization enabled; 

– box not checked – operation of PTP synchronization disabled 

(Transparent) net-
work protocol 

Network protocol, through which synchronization messages are transmitted: 

– ieee802.3; 

– udp-ipv4 

(Transparent) primary 
domain 0…255 

Binding of the device to a PTP domain (value must be in the range of 0 to 255) 

(Transparent) is sync 
local clock 

Synchronization of the local clock: 

– box checked – local clock synchronized; 

– box not checked – local clock not synchronized 

(Transparent) vlan 

Operation of PTP in a specified virtual network (VLAN ID), number of the virtual network: 

– none; 

– 0; 

– 1 

(Transparent)  
vlan-priority 1…7 

Priority with which the device transmits messages of the PTP synchronization related to 
this VLAN ID (value must be in the range of 1 to 7) 

 

5.3.5.1 Serial protocols 

The tab is designed to configure communication protocols which are available for operation via 

serial communication ports (COM): 

– ModbusRTU; 

– 60870-5-103 (IEC 60870-5-103); 

– ModbusRTU c-t (Modbus RTU client); 

– IEC 103Master (IEC 60870-5-103Master); 

– Transparent port. 

All serial protocols have a uniform parameter – protocol name (figure 172). 

 

Figure 172 – Parameters of the protocol 

Note – The ModbusRTU protocol has no additional parameters. 
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5.3.5.1.1 Additional parameters of the IEC 60870-5-103 protocol (figure 173) 

 

Figure 173 – Parameters of the IEC 60870-5-103 protocol 

The description of parameters of the IEC 60870-5-103 protocol is given in table 107. 

Table 107 – Description of parameters of the IEC 60870-5-103 protocol  

Parameter Description 

Measurement transmission 
type 

It sets the type of measurement transmission:  

– Cyclic; 

– Sporadic; 

– Cyclic & Sporadic; 

– Disabled (no transmission) 

Measurement transmission 
period, s 

Time setting the delay in seconds when transmitting measurements 

Measurement data type With floating point (asdu 4), with fixed point (asdu 9) 

Analog data 
Set of transmitted measurements which consists of the following groups: analog 
measurements, calculated measurements, protection phasors 

Binary data 
Set of transmitted binary measurement groups which consists of the following 
groups: logic signals and binary outputs  

Base address of logic sig-
nals 

Decimal value, which sets the base address of logic signals 

Base address of binary out-
puts 

Decimal value, which sets the base address of binary outputs 

Base address of analog 
values 

Decimal value, which sets the base address of analog values 

Basic address of calculated 
values 

Decimal value, which sets the base address of calculated values 

Omit zeros in INF field 
Omission of zeros in the information field. When the value of the address  
parameter for the IEC 60870-5-103 protocol is set, fieldless INF = 0 is generated 
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5.3.5.1.2 Parameters of the ModbusTCP Master protocol 

In the Modbus RTU Master parameters group (figure 174) used Modbus clients are set, which 

are added in the Modbus Client tab (item 5.6).  

 

Figure 174 – Parameters of the ModbusRTU Master protocol 

5.3.5.1.3  Parameters of the IEC60870-5-103 Master protocol (figure 175) 

 

Figure 175 – Parameters of the IEC 103Master protocol 

The description of parameters of the IEC 103Master protocol is given in table 108. 

Table 108 – Description of parameters of the IEC 103Master protocol  

Parameter Description 

Set of slave devices Polled slave device is selected, which is added in the 103 protocol master tab 
(item 5.9) 

 

5.3.5.1.4 Parameters of theTransparent port protocol (рисунок 176) 

The description of parameters of theTransparent port protocol is given in table 109. 
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Figure 176 – Parameters of theTransparent port protocol 

Table 109 – Description of parameters of theTransparent port protocol 

Parameter Description 

Tcp port Base port of TCP protocol for connection client’s applications.  

 

5.3.5.2 Setting groups 

The tab is designed for configuring the switching of setting groups. 

For fast switching of the settings required for the protected facility, setting groups are implemented 

in one configuration file. 

In each group one can specify individual settings for measuring elements, logic elements, tripping 

matrix and calculated values. All other parameters (hardware settings, PCS, etc.) are the same for all 

setting groups. It is possible to switch the group of settings by changing the electronic switches and logic 

signals in the “local” and “remote” control modes. It is possible to assign a binary input of cabinet for each 

setting group for activation, in case of its operation a setting group with the index of this group number is 

applied automatically. 

By default, the name of the setting group should be: “Setting group X”, where X is the sequence 

number of the setting group. The maximum length of the setting group name must not exceed 23 charac-

ters. 

Values from one setting group to another are copied by pressing the Copy button (figure 177). 

Pressing this button copies the selected settings from the From group to the To group. After the copying 

is completed, an information window appears about the successful completion of the operation. 

One can select settings in the Measuring elements, Logic elements, Calculated values, Tripping 

matrix groups. 

When the box is checked in field Common tripping matrices for all setting groups, all setting 

groups have a common tripping matrix. 

When the box is checked in field Password request when switching setting group via el. 

switch, the switching of settings is accompanied by a password request. 
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Figure 177 – Setting groups window 

Parameters of the Setting groups tab are shown in table 110. 

Table 110 – Parameters of the Setting groups window 

Parameter Description 

Quantity of setting groups 
Quantity of setting groups (minimum – 2, maximum – 100, “none” – there is 
only one setting in the project) 

Active setting group by default 
Selection of an active setting group from the assigned quantity of setting 
groups 

Setting group switching source 

Switching sources 
– Electronic switch (when changing electronic switches on the indication 
module); 

– Logic signal (when the logic signal changes); 

– Logic signal decoder (when switching a setting group with a wafer 
switch) 

No. Number of the setting group 

Setting group name Name of the setting group 

Activation signal Signal of activation of the setting group 
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5.3.5.3 IED parameters 

The figure 178 shows a form for setting device parameters. 

 

Figure 178 – IED parameters tab 

Test relay (figure 178, item 1) 

The ED2 series devices have a special test relay that is not controlled by enabling/disabling of the 

IED. 

It sets the position of the test relay for automated testing using external programs (for example, 

using the Smart Monitor program). 

In the drop down list select a relay module, after relay module selection, specify a required circuit. 

 

Memory card (figure 178, item 2) 

It sets the type of memory card that is installed inside the device, in megabytes. The allowed 

memory range is from 32 to 32,768 MB. 
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Language (figure 178, item 3) 

This section sets the IED language (Russian or English or Spanish). 

 

Display (figure 178, item 4) 

This section sets the time until the IED display switches to the standby mode, the time until the 

password is reset, and the default menu item. 

 

Operation frequency (figure 178, item 5) 

The Operation frequency parameter specifies the operation frequency of IED's functional proces-

sor. Possible parameter values: 

– 1,000 Hz;  

– 1,200 Hz; 

– 2,000 Hz.  

The value of 1,000 Hz is set in case of using the Sample Value reception report block according 

to the IEC 61850-9-2LE protocol, as well as in control IEDs. The value 2,000 Hz is set for the functional 

purpose "Communication device". In all other cases, the value is set to 1,200 Hz. 

Possible values for frequency of logic execution: 

– default (on each sample); 

– on odd sample.  

For Disturbance recording frequency, Hz, 1,200 Hz and 2,400 Hz are available, for devices with 

a DSP operation cycle – 1,200 Hz, 1,000 Hz and 2,000 Hz, for a device with a DSP operation cycle – 

1,000 Hz. 

 

Supply parameters (figure 178, item 6) 

In the Object name field, select the energy facility to which the IED will be supplied. 

The IED functionality code field indicates the relation of the IED to the functions performed: 

– Protection Int; 

– Bay Controller Int. 

 

Binary input process time compensation (figure 178, item 7) 

In the Enable time correction field compensation of the processing time of binary inputs is ena-

bled. 

The On switch to 1, ms field specifies the time in milliseconds that will be compensated upon 

switching from logic 0 to 1. 

The On switch to 0, ms field specifies the time in milliseconds that will be compensated upon 

switching from logic 1 to 0. 
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Analog value display mode (used only in IED) (figure 178, item 8) 

Available modes of analog value display: 

– Secondary; 

– Primary. 

 

5.3.6  Ethernet redundancy settings 

Ethernet redundancy is configured in two ways: 

– when adding a controller module with two Ethernet interfaces and in the absence of a network 

redundancy board (Hirschmann); 

– by adding a controller module with a network redundancy board (Hirschmann). 

 

5.3.6.1 Configuration of Ethernet redundancy (with a network redundancy board (Hirschmann)) 

Select the System parameters section in the project tree and go to the Ethernet redundancy 

settings tab. 

Set the required Ethernet redundancy protocol – Redundancy parameter (figure 179). 

 

Figure 179 – Ethernet redundancy settings tab 

The description of general parameters for all redundancy protocols is given in table 111. 

Table 111 – Description of general parameters for all redundancy protocols  

Group Parameter Description 

Network  
parameters 

Address IP address of the redundancy module  

Mask Subnet mask of the redundancy module 

Gateway Subnet gateway of the redundancy module 

Management 
VLAN 

Virtual network, which provides access to redundancy module settings. It affects 
all protocols of remote access to the redundancy module. For correct operation, 
VLAN, when set to a value other than 0, will be registered in the VLAN table on 
external ports of the module 

 

When selecting network redundancy options, the program sets the following default values: 

– network redundancy none (absent) (figure 179); 

– network redundancy PRP (figure 180);  
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– network redundancy RSTP (figure 181); 

– network redundancy LinkBackup (figure 182); 

– network redundancy mrp (figure 183); 

 

Figure 180 – Configuration of redundancy via PRP protocol 

The description of redundancy settings via PRP protocol is given in table 112. 

Table 112 – Description of redundancy settings via PRP protocol 

Group Parameter Description 

prp 

Reception of 
supervision packets 

Enabling tracking of supervision packets. Reception of packets is required to  
collect statistics and diagnose the PRP network 

Transmission of 
supervision packets 

Enabling generation of supervision packets from this redundancy module. 
Transmission of packets is required to collect statistics and diagnose the PRP 
network 

Transmission of 
VDAN packets 

Enabling transmission of supervision VDAN packets. These packets contain 
additional diagnostic information about network devices connected to the PRP 
network through the IED redundancy module. Supervision VDAN packets are 
transmitted only if the Transmit supervision packets parameter is enabled 

  

Figure 181 – Configuration of redundancy via RSTP protocol 
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 The description of redundancy settings via RSTP protocol is given in table 113. 

Table 113 – Description of redundancy settings via RSTP protocol 

Group Parameter Description 

Stp 

Max age 6..40 
Maximum distance of the extreme switch from the root switch of the network, 
within which the protocol is applied. For STP protocol it is expressed in  
seconds 

Priority 

Device priority 
One of the components, as well as part of the MAC address, when added  
together, a numerical sequence is formed that affects the ranking of switches 
at the stage of selecting the root switch, selecting the destination path when 
building a network connection tree from the root switch. 
The lower the number, the higher the priority. 
Default value – 32,768. Range of permissible values – from 0 to 65,536 

Stp port 
½ 

Port1/2 cost 
0..200,000,000 

Path “cost” (value, inversely proportional to path throughput). 
The result of the path cost sum of the current switch and the port cost is the 
path cost for the next switch. The port with the least cost is selected as the root 
port – port with the cheapest path to the root switch 

Port1/2 auto-
edge 

Automatic assignment of port role. 
It turns on automatic detection of the end device. If there are no BPDU packets 
from the device, connected to the port, the transmit mode is turned on. Then 
this port does not participate in the RSTP topology 

Port1/2 guard-tcn 

The function of port protection from distribution of messages on network  
topology change. 
Enable protection against attack by false BPDU messages on topology change 
that do not contain information about a better path 

Port1/2 priority 
Port priority. The lower the number, the higher the priority. 
If the port cost turned out to be the same, the selection will be made by priority.  
Range of permissible values – from 0 to 240 in increments of 16 

 

Figure 182 – Configuration of redundancy via LinkBackUp protocol 

  

Figure 183 – Configuration of redundancy via mrp protocol 

The description of redundancy settings via mrp protocol is given in table 114. 
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Table 114 – Description of redundancy settings via mrp protocol 

 

5.3.7 Diagnostics parameters 

This tab is designed for viewing device failures (figure 184). The description of parameters of the 

Diagnostics parameters tab is given in table 115. 

 

Figure 184 – Diagnostics parameters tab 

Table 115 – Parameters of the Diagnostics parameters tab 

Parameter Description 

Name Flag name 

Individual failure parameters 
Individual parameters of the failure allow you to change the signal type and 
latching flag (by default, the box is unchecked, parameters “Signal type” 
and “Latching” are highlighted in gray and not editable) 

Signal type 
Alarm, warning, information 

Latch 
Latching flag allows you to latch the appearance of signals in the IED and 
reset on user reset 

 

5.3.8 Control mode 

This tab is designed to select the control mode and bind the operation of the "Reset" and "Start" 

signals from a binary input or a device logic signal (figure 185). 

IED Local/Remote switching methods: 

– Not selected (hotkeys Fn+2 on the front panel are used); 

– ES 1 (electronic switch №1); 

– Logic signal. 

Group Parameter Description 

mrp 

Extended mode 
In this mode, a connection failure is detected using the “Link-down”  
message about a broken connection. This message can be generated by 
the device that has detected the break 

VLAN ID Number of the virtual network 
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Figure 185 – Control Mode tab 

Binding of signals occurs by pressing a button  (figure 185, pos. 1). 

The description of parameters of the Linking input is given in table 116. 

Table 116 – Description of parameters of the Linking input 

Parameter Description 

Block The name of inputs module 

Input Bit number in inputs module  

Logic signal Logic signal number from logic of device. Logic signal selection is not available if an 
inputs module is selected. 

Note – The "Start" signal binding is displayed only for the "Communication Device" functional pur pose 

and is used to enable the receiver to be put into the "Run" state. 

 

5.3.9 Security parameters 

This tab is designed to select the level of security of the Modbus protocol (figure 186). 

Modbus protocol security level options: 

– Off: 

1) Modbus protocol security is not used; 

– Low: 

1) CRC32 hash algorithm; 

2) absence of MAC in IED messages; 

3) username in client messages (SmartMonitor) is transmitted in clear text; 

– Medium: 

1) MD5 hash algorithm; 

2) absence of MAC in IED messages; 

3) username in the client message is transmitted in clear text; 

1 
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– High; 

1) MD5 hash algorithm; 

2) presence of MAC in IED messages; 

3) username in the client message is transmitted as MD5. 

 

Figure 186 – Security parameters tab 

5.4 Logic part 

5.4.1 Measuring elements and functions 

The Measuring elements and functions window, device tree menu Logic part → Measuring 

elements and functions (figure 187), allows you to configure measuring elements and functions for the 

IED. In figure 187, item 1 there is a list of measuring elements and functions available in the project, in 

figure 187, item 2 – parameters and settings of the selected measuring element. 

Measuring element grouping is designed to group measuring elements by logical groups.  

  

Figure 187 – Measuring elements and functions window 

5.4.1.1 Common features  

 

Figure 188 – General properties section  

The description of parameters of the General properties section (figure 188) is given in table 117. 

2 1 
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Table 117 – Description of parameters of the General properties section 

Parameter Description 

Designation Designation of the measuring element or function in the configuration (editable) 

Library name Name of the measuring element or function in the library 

Functional group Name of the group to which the measuring element or function belongs 

Description Description of the measuring element or function (editable) 

 

5.4.1.2 Enable/disable 

 

Figure 189 – Enable/disable section 

The description of parameters of the Enable/disable section (figure 189) is given in table 118. 

Table 118 – Description of parameters of the Enable/disable section 

Parameter Description 

Logic signal enable Setting the logic signal to enable the measuring element or function 

Enable condition 
If the checkbox is cheked, than the measuring element or function can be acti-
vated using a logic signal or the Enabled setting (see 5.4.1.4). Otherwise 
measuring element or function can be activated only via the Enabled setting. 

LED enable/disable  Setting the measuring element or function status LED (enable/disable) 

 

5.4.1.3 Inputs  

 

Figure 190 – Inputs section 

The description of parameters of the Inputs section (figure 190) is given in table 119. 

Table 119 – Description of parameters of the Inputs section 

Parameter Description 

Input name List of measuring element or function inputs 

Binding Binding of the sensor module circuit to the measuring element or function input 

 

Note  If you want to set a name consisting of special characters, you should make sure that they are 

included in the set of permitted special characters: “Σ Ω Ψ € ∞ ≥ ≈ ÷ ± ≤ °C ° ● Λ V … ≠ Δ © ® { }”. To set special 

characters, go to the menu View → Special characters table. 
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5.4.1.4 Settings  

 

Figure 191 – Settings section 

The description of parameters of the Settings section (figure 191) is given in table 120. 

Table 120 – Settings 

Parameter Description 

Setting List of measuring element or function settings 

Setting group Value of the setting  

Minimum Minimum value of the setting 

Maximum Maximum value of the setting 

Unit Measurement unit (absolute/relative value) 

Unique range Indicator of enabling assignment of the unique setting range 

Description 
Description of the measuring element or function setting. By default, this field is empty. 
Edited by user if necessary 

Enabled Setting of measuring element or function activation  

          
 * The quantity of columns depends on the quantity of setting groups in the configuration. 

 

5.4.1.5 Outputs  

  

Figure 192 – Outputs section 

The description of parameters of the Outputs section (figure 192) is given in table 121. 

Table 121 – Outputs 

Parameter Description 

Name List of measuring element or function outputs 

Use 
Using the output in the logic (whether or not to use the measuring element or function output 
in the logic of the IED, when used, it is added to the logic diagram and the signal table of the 
IED) 
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5.4.2 Calculated parameters  

Calculated parameters are internal variables of the measuring element or function algorithm with 

their possible disturbance recording (figure 193).  

 

Figure 193 – Calculated parameters section 

The description of parameters of the Calculated parameters section given in table 122. 

Table 122 – Calculated parameters 

Parameter Description 

Number Number of the parameter 

Name Name of the parameter 

Unit Measurement unit of the parameter 

Dist. Disturbance recording of the parameter 

 

5.4.3 Programmable logic 

To ensure the correct logic of the IED, the Configurator has a visual editor of logic that allows you 

creating logic, emulate the operation of logic (simulate the supply of signals to the logic and check the 

correct execution of the logic), and compile it (a compiled logic file is created that is used in the logic of 

the IED). 

The following signals can be input data for the logic: 

– signals received via physical binary inputs and via digital protocols; 

– measuring element signals; 

– signals of keyboard events; 

– service signals; 

– system events; 

– outputs of specialized buffers; 

– results of logic functions of the Calculated values section. 

Logic signals that are supposed to be used to influence the relay of the IED, assign to local alarm, 

in digital data transmission protocols, calculations should be displayed in the “Matrix inputs” element. 

You can move around the window either by hovering the mouse or using the mouse wheel (verti-

cally). 

The Logic section has subsections Logic elements and System events. 
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5.4.3.1 Opening of programmable logic diagram  

To open the diagram, go to device tree menu Logic part → Logic. The Logic window is shown in 

figure 194. 

 

Figure 194 – Programmable logic diagram 

The presence of programmable logic in the configuration is indicated by the red glow of the Pro-

grammable logic button (the Programmable logic button is active).  

 

5.4.3.2 Editing of programmable logic diagram 

In the programmable logic, elements without settings in the Library tab (figure 195, item 1) or with 

settings in the Reserved elements of additional logic tab (figure 195, item 2) can be used. The use of 

logic elements with settings, as well as R_Trig and F_Trig triggers, is strictly limited. These elements are 

available in the special Reserved elements of additional logic window. The maximum number of ele-

ments is indicated in brackets, and the available quantity is outside the brackets (figure 195, item 3). 

When you hover the mouse cursor over the Logic library tab, a window appears with logic ele-

ments (figure 196) used in the programmable logic. 

By default, in addition to the logic container, there are elements of matrix outputs (16 reserved 

outputs) and matrix inputs (128 reserved inputs). Matrix inputs are used to assign signals to output relays 

or to the LED display with possible assignment for event and disturbance recording. 

The signals to matrix outputs are assigned by means of the tripping matrix in the configuration. 
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Figure 195 – Editing of programmable logic diagram 

 

Figure 196 – Programmable logic library 
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2 
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Setting logic connections between elements inside the programmable logic container is performed 

using lines or logic markers. 

Setting logic connections using logic markers is performed as follows: 

а) using combination CTRL+SHIFT and left mouse button select the element output marker (output 

is colored green (figure 197)); 

 

Figure 197 – Setting logic connections 

б) using combination CTRL+SHIFT and left mouse button select the necessary element input 

marker. The marker is bound (figure 198). 

 

Figure 198 – Binding of programmable logic markers 

Logic connections of inputs of logical elements of programmable logic with outputs of hard logic 

elements can be set using logic markers.  

To use a reserved programmable logic element, you must capture its image and drag it with the 

mouse into the programmable logic container. When you drag reserved items into the programmable logic 

container, the available quantity of items dynamically changes. Also, in the container of programmable 

logic, you can use common elements from the logic library – these are elements of type AND, OR, NOT, 

etc. Placement of logic elements outside the programmable logic container is not available. 

If necessary, you can delete elements of the flexible logic diagram with the DELETE button on the 

keyboard or the Delete command in the context menu, which is called by right-clicking on the element. 

 

5.4.3.3 Logic compilation 

After editing the programmable logic, it is necessary to check the correctness of the logic using the 

function of logic compilation. Logic compilation checks for unused outputs of logic elements and the 

memory footprint of the logic. Logic compilation is started by pressing the Compile button on the toolbar 

(figure 199). 

 

Figure 199 – Location of the Compile button 
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If unused outputs of logic elements are found during compilation, the program informs the user 

about it and displays a list of unbound outputs on a separate panel (figure 200). To eliminate errors, bind 

unbound outputs, or mark them as unused outputs (check the box in the Unused outputs field). 

After eliminating the errors, it is necessary to recompile the logic diagram. 

 

Figure 200 – Location of the list of unbound outputs 

In case of successful compilation of the logic, a corresponding message will be displayed (fig-

ure 201). 

 

Figure 201 – Compilation complete window 

5.4.3.4 Assigning settings of programmable logic elements  

To open the Logic elements window, select device tree menu item Logic part → Logic → Logic 

elements (figure 202). 

The reserved programmable logic elements have the following settings: 

– time delays; 

– program switches; 

– pulse former; 

– stage counters; 

– pulse generators. 

 Logic elements used in programmable logic are labeled “programmable logic” in the Belongs to 

column.  



 

EKRASMS-SP software package manual   173 
EKRA.00019-01 34 02, Edition 05.2023 

 

Figure 202 – Logic elements window  

To save the configuration, select main menu item File → Save. All setting groups are saved in one 

configuration file. 

 

5.4.3.5 Logic elements 

The Logic elements window, device tree menu Logic part → Logic → Logic elements (fig-

ure 202), is designed for editing the settings of logic elements present in the logic diagram. Types of logic 

elements are sorted by tabs. 

 

1) Time delays 

Figure 202 shows the form for setting the time delay parameters. 

The description of columns of the time delays table is given in table 123. 

Table 123 – Description of columns of the time delays table 

Parameter Description 

Measuring element Belonging of the logic element to the measuring element 

Name Name of the element in the logic diagram 

Type Type of time delay (operate or release) 

Minimum, s Minimum value of the setting in seconds 

Maximum, s Maximum value of the setting in seconds 

Editable via Smart Monitor and IED 
menu 

Parameter specifying the possibility to record the settings of this element  
in the Smart Monitor program 

Description in Russian Description of the element in Russian 

Description in English Description of the element in English 

Setting group Name of the setting group 

Setting, s Value of the setting in seconds 
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2) Program switches 

Figure 203 shows the form for setting the parameters of program switches. 

 

 Figure 203 – Program switches tab 

The description of columns of the time program switches table is given in table 124. 

Table 124 – Description of columns of the time delays table 

Parameter Description 

Measuring element Belonging of the logic element to the measuring element 

Name Name of the element in the logic diagram 

Editable via Smart Monitor and IED 
menu 

Parameter specifying the possibility to record the settings of  
this element in the Smart Monitor program 

Belongs to 
Type of logic to which the logic element belongs  
(hard or programmable logic) 

Description in Russian Description of the element in Russian 

Description in English Description of the element in English 

Setting group Name of the setting group 

Setting State of program switches  

 

3) Pulse shapers 

Figure 204 shows the form for setting the parameters of pulse shapers. 

 

Figure 204 – Pulse shapers tab 
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The description of columns of the pulse shapers table is given in table 125. 

Table 125 – Description of columns of the pulse shapers table 

Parameter Description 

Measuring element Belonging of the logic element to a measuring element 

Name Name of the element in the logic diagram 

Minimum, s Minimum value of the setting in seconds 

Maximum, s Maximum value of the setting in seconds 

Editable via Smart Monitor and 
IED menu 

Parameter specifying the possibility to record the settings of this element  
in the Smart Monitor program and IED menu 

Belongs to 
Type of logic to which the logic element belongs  
(hard or programmable logic) 

Description in Russian Description of the element in Russian 

Description in English Description of the element in English 

Setting group Name of the setting group 

Setting, s Pulse length in seconds 

 
4) Pulse shapers with interruption 

Figure 205 shows the form for setting the parameters of pulse shapers with interruption. 

 

Figure 205 – Pulse shapers with interruption tab 

The description of columns of the table of pulse shapers with interruption is given in table 126. 

Table 126 – Description of columns of the pulse shapers table 

Parameter Description 

Measuring element Belonging of the logic element to the measuring element 

Name Name of the element in the logic diagram 

Minimum, s Minimum value of the setting in seconds 

Maximum, s Maximum value of the setting in seconds 

Editable via Smart Monitor  
and IED menu 

Parameter specifying the possibility to record the settings of this element  
in the Smart Monitor program and IED menu 

Belongs to Type of logic to which the logic element belongs (hard or programmable logic) 

Description in Russian Description of the element in Russian 

Description in English Description of the element in English 
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Parameter Description 

Setting group Name of the setting group 

Setting, s Pulse length in seconds 

 

5.4.3.6 Logic simulation and compilation  

Logic emulation is used to test the operation of the logic. The simulation mode is started and 

stopped by pressing the Simulate button (figure 206) in the toolbar of the Logic form. The current logic 

simulation speed is taken as a factor of 1, the logic execution speed can be adjusted from 0.01 to 60. 

 

 Figure 206 – Location of the Simulate button 

Before the logic is simulated, the logic is automatically compiled. To compile the logic manually, 

use the Compile button (figure 199). 

5.4.3.7 System events 

The System events window, device tree menu Logic part → Logic → System events (fig-

ure 207), is designed for transmitting system events to the logic. It consists of a list of events of the com-

munication (CP) and functional (FP) processors. 

 

Figure 207 – System events window 
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Parameters of system events are shown in table 127. 

Table 127 – Parameters of system events 

Parameter Description 

Name List of system events 

Transmit to logic Transmission of events to the logic (transmit or not a system event to the IED logic) 

 

5.4.4 IED signals table 

The IED signals table window, device tree menu Logic part → IED signals table (figure 208), is 

designed for configuring matrix inputs. It consists of a list of service signals, measuring element signals, 

input circuits, logic signals. For the measuring element signal or input circuit, you can create corresponding 

calculated signals using the context menu. 

 

Figure 208 – IED signals table window 

Parameters of the list of IED signals table are shown in Table 128. 

Table 128 – List parameters  

Parameter Description 

Number Number of the signal input 

Address Address of the signal 

Description Description of the signal in the configuration 

Name as per IEC 61850 Name of the signal in the configuration according to IEC 61850-8-1 

Event rec. Indicator of signal event recording 

Disturb. rec. Indicator of signal disturbance recording 

Disturb. rec. edge-trig. start Start of the disturbance recorder on signal rise 

Disturb. rec. fall-trig. start Start of the disturbance recorder on signal fall 

Latch. in PCS 
Latching the signal for transmission to PCS via ModbusRTU/TCP.  
Signals are reset after alarm removal 
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Parameter Description 

Warning alarm 
If the box is checked, then when the signal switches from 0 to 1,  
the service signal “Warning alarm” will be set 

Emergency alarm 
If the box is checked, then when the signal switches from 0 to 1,  
the service signal “Emergency alarm” will be set 

 

5.4.5 Matrix of binary outputs 

The Matrix of binary outputs window, device tree menu Logic part → Matrix of binary outputs 

(figure 209), is designed for configuring binary outputs. Each tab of the form corresponds to the output 

module specified in the Modules section. The columns of the matrix correspond to the bits of output mod-

ules, and the rows correspond to binary outputs of the IED. A mouse click on a table cell sets the corre-

spondence between the output signal and the bit of the output module. The tabs at the top of the form 

allow you to switch between output modules of the IED. 

For each bit of the output module, the “Latching” mode can be set. This mode ensures that the 

logical “1” signal is latched at the relay output until the alarm reset command is executed. 

Setting indicator “Changing signal assignment” allows you to change the effect on the module out-

put. 

 

Figure 209 – Output circuits matrix window 

5.4.6 Indication matrix 

The Indication matrix window, device tree menu Logic part → Indication matrix (figure 210), is 

designed for configuring the indication module of the IED. 

Tabs allow you to switch between groups of bits of the indication module. The LED color is specified 

in the indication table (red or green). The columns of the table correspond to the names of indication 

module bits. The names can be edited using the Modules menu. 

For each bit of the indication module, “Latching” mode can be specified. This mode ensures that 

the logical “1” signal is latched on the LED until the alarm reset command is executed. 
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Setting indicator “Changing signal assignment” allows you to change the effect on the LED of the 

indication module. 

 

Figure 210 – Indication matrix window 
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5.4.7 Event recorder 

The Event recorder window, device tree menu Logic part → Event recorder (figure 211), is de-

signed to configure the event recorder. 

 

Figure 211 – Event recorder window 

The contents of signal tables of recorder groups depend on the selected list item. Each event has 

the following options: 

– Permission – allows setting checkboxes for the parameters "Registration" and "Shown on dis-

play"; 

– Recording  enables signal recording; 

– Display – indicator of signal display on the IED. 
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5.4.8 Disturbance recording 

The Disturbance recorder window, device tree menu Logic part → Disturbance recorder (fig-

ure 212), is designed for setting the disturbance recorder. 

 

Figure 212 – Disturbance recording window 

The Signal groups panel provides a choice between binary and analog signals for disturbance 

recording. To enable disturbance recording, check the box next to the desired signal in the table. 

Parameters of disturbance recording are shown in table 129. 

Table 129 – Parameters of disturbance recorder 

Parameter Description 

Pre-fault time, s 
Time before fault, which will be included in the disturbance record  
in seconds 

Maximum fault time, s Fault time, which will be included in the disturbance record in seconds 

Post-fault time, s 
Time after fault, which will be included in the disturbance record  
in seconds 

Maximum dist. record duration, s 
Display of maximum possible duration of the disturbance record  
in seconds 

Quantity of dist. recorder 
Quantity of disturbance records that can be recorded (not greater than the 
value in Max. quantity of dist. recorder) 

Max. quantity of dist. recorder Maximum quantity of disturbance records that can be recorded 
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5.4.9 Measurements for indication 

The Measurements for indication window, device tree menu Logic part → Measurements for 

indication (figure 213), is designed to create a list of measurements displayed on the device when a signal 

is applied to the binary input “Call”.  

 

Figure 213 – Measurements for indication window 

In order to add a measurement, you need to drag it from the All measurements tree to the Meas-

urements for indication section. Measurement parameters can be specified in the drop-down list.  

1) Analog inputs 

The description of measurement parameters is shown in table 130. 

Table 130 – Description of measurement parameters 

Measurement type Description 

Absolute value Converted primary value of the analog input relative to sensor rating 

Rated value Relative value of the analog input to its rating 

Primary value Signal value released from the protection facility (transformer, generator) 

Angle Phase angle of the corresponding input signal in degrees 

Frequency Input frequency in Hertzes 

 

2) Measuring elements 

This group of measurements combines all configuration measuring elements. The measuring ele-

mentcontains measurements of inputs, outputs, phasors and calculated measurements. The phase and 

the type of measurement are specified for measuring elementinputs according to table 130. The type of 

measurement is specified for phasors according to table 130. 

 

3) Calculated values 

The current value of calculated measurements set in the configuration is specified. 

 

4) Mimic diagram 

The page of the graphical diagram, which will be displayed on the IED. 
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5.4.10 Mimic diagram 

The Mimic diagram window, device tree menu Logic part → Mimic diagram (figure 214), is de-

signed to create a graphical diagram that will be displayed on the IED. 

The mimic diagram consists of two parts: a library of elements (figure 214, item 1) and a workspace 

(figure 214, item 2). 

 

Figure 214 – Mimic diagram window 

In the center of the workspace there is an image of the IED display. To create a mimic diagram, 

you need to move the elements from the library to the workspace. On the workspace panel there are 

buttons for managing the pages of the mimic diagram. With their help, you can navigate between pages, 

as well as add and delete pages using the  and  buttons, respectively. 

In the Configurator program, it is possible to preview the mimic diagram in the form in which it will 

be displayed on the IED panel. To do this, press button  on the workspace panel, after which the 

window shown in figure 215 will appear. 

2 1 
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Figure 215 – Viewing the mimic diagram background 

There are two types of elements – static and dynamic. Static elements are unchangeable, while 

dynamic elements can change their state during the operation of the IED. Elements Disconnector, Cir-

cuit-breaker, Trolley, Lock change their graphical representation based on the selected calculated meas-

urement. To customize these elements, drag them to the workspace and click on them with the right mouse 

button (figure 216). 

 

Figure 216 – Setting the Circuit-breaker element 

It is possible to select a measurement, which actuates the element and the actuation mechanism 

in the Properties group. The measurement corresponds to calculated measurements of the corresponding 

menu item. Disconnector, Circuit-breaker type elements can have only two statuses: closed and tripped. 

To create a circuit-breaker with four or more statuses, a user dynamic element is used. The impact of the 

signal on the element is adjusted through the context menu item of the same name. 

The Measurement element is designed to display the calculated measurement on the mimic dia-

gram window. 

In the properties of this element, you can specify the calculated measurement, position, set the 

designation manually, as well as the accuracy with which it will be displayed on the screen of the mimic 

diagram.  
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The Link element is designed for switching between the pages of the mimic diagram (figure 217). 

 

Figure 217 – Setting the Link element 

In the properties of this element, you must specify the number of the mimic diagram page.  

It is possible to create a user element with an adjustable quantity of statuses (figure 218). 

 

Figure 218 – Properties of the element with an adjustable quantity of statuses 

The properties of the user element set the quantity of statuses. Currently, the IED supports a user 

element with two statuses. For the bay controller, you can also create four statuses in this element. To 

add a status to the drop-down list, press the “+” button, to delete it “-”. In order to set the status activation 

condition, select a signal from the drop-down list and set the activation signal status using the Element 

status measurement (figure 219). Activation signals are measurements from the Calculated measure-

ments section. For each status of the dynamic element, you must create its graphical representation, 

otherwise the dynamic element will look empty. To create a picture of the status, it is necessary to select 
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the desired state from the drop-down list from the context menu of the Image element, and then select the 

Edit menu item. While in edit mode, you can drag elements from the library inside the dynamic element, 

thus creating a graphical representation of the current status. To finish editing the status, click the Save 

button from the context menu of the element. 

 

Figure 219 – Element properties with an option to set the activation signal status 

The “+” button adds a new status, “x” – deletes the signal. 

There are common actions for all elements of the mimic diagram: 

– Rotate by 90° – element rotation by 90°. 

Note  The “connecting line” element can be rotated to any angle. To rotate the line, pull the edge of its 

bounding rectangle by pressing the CTRL key; 

– Group – joining a group of selected elements; 

– Add to library – adding the current selected element (or several grouped elements) to the library 

(the element is saved to the project file). 

5.4.10.1 Mimic diagram dialogs 

It is possible to set dialogs when controlling through the mimic diagram. This feature is needed 

when confirming or refusing user actions when setting control actions through the mimic diagram of the 

IED. Dialogs can be linked in a chain of two dialogs, i.e. when you click on the button in the first dialog, 

the second dialog appears. Dialogs are used to configure bay controller projects (figure 220). 
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Figure 220 – Mimic diagram dialogs 

By default, in the left part of the window there is a standard dialog box, which can be used as a 

base for creating your own dialog boxes. To do this, it is necesary to move the basic dialog box to the 

workspace with a mouse. Each dialog box contains a set of properties, which are available through the 

context menu (figure 221). With Add to library button, a dialog box can be added to the user library of 

dialog boxes. You can add up to two additional buttons using the Add button button. The maximum quan-

tity of buttons in the dialog box is three. The Delete button button removes additional buttons one by one. 

There must be at least one ESC button left in the dialog. 
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Figure 221 – Element properties 

The properties of the dialog box are shown in table 131. 

Table 131 – Properties of the dialog box 

Parameter Description 

Element name Dialog identifier 

Width Width of the dialog in the window of the mimic diagram 

Height Height of the dialog in the window of the mimic diagram 

Next Dialog next in the chain 

Title 
Title of the dialog box. Allows you to specify macro substitutions (for example, 
%name% displays the name of the associated control element) 

Font height Height of the font 

Esc Label for the cancel key. By the button located nearby, the button image is specified 

Button Specifies the key for an additional button 

Close Label of the button 

 

To use dialog boxes in the properties of control elements on the mimic diagram, it is necessary to 

bind the dialog box to the right mouse button (figure 222).  
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Figure 222 

5.4.11 Control 

5.4.11.1 Switching devices 

The Switching devices window, device tree menu Logic part → Control → Switching devices 

(figures 223, 224, 225) is designed for viewing and editing the settings of switching devices.  

  

Figure 223 – Switching devices window 

The description of switching devices is shown in table 132. 
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Table 132 – Description of columns of switching devices 

Parameter Function 

No. Number of the switching device 

Name Name of the switching device 

Type 

Types of switching devices: 

– Circuit-breaker; 

– Disconnector 

Position signaling 

Subtypes of the switching device: 

– Single-phase; 

– Three-phase with a common drive 

Communication interface Interface of communication 

Program protocol Used program protocol 

Control model 
Type of the model for control of the switching device according to 
IEC 61850-8-1 

Remaining life calculation type 

Type of calculation of the service life: 
– Switching; 
– Mechanical; 
– None 

 

 

Figure 224 – Parameters of switching devices 

Parameters of switching devices are shown in table 133. 

Table 133 – Parameters of switching devices 

Parameter Function 

Parameter Name of the parameter 

Source Source 

Value Tripping/closing state 
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Figure 225 – Service life of switching devices 

Parameters of the remaining life of switching devices areshown in table 134. 
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Table 134 – Parameters of the remaining life of switching devices 

Parameter Function 

Current 
Selection of the current circuit based on the control of which the remaining life 
of the switching device will be calculated 

Openings table 

Current, kA Specified openings current 

Quantity of openings Specified quantity of openings at a given openings current 

Initial quantity of openings Quantity of initial openings of each phase 

Closings table 

Current, kA Specified closing current 

Quantity of closings Specified quantity of closings at a given closing current 

Initial quantity of closings Quantity of initial closings of each phase 

Remaining life calculation start 

Remaining life calculation start 

Start of remaining life calculation: 

– By control signal; 

– By change of position 

Phase Phase A, phase B, phase C 

Start signal at opening Signal upon supply of which the remaining life will be calculated when opened 

Start signal at closing Signal upon supply of which the remaining life will be calculated when closed 

Current hold time relative to start signals 

At opening, ms 
Time from the moment the circuit-breaker is tripped until the device  
receives the signal of the opened position of contacts 

At closing, ms 
Time from the moment the circuit-breaker is closed until the device  
receives the signal of the closed position of contacts 

 

Commands of the switching device panel are shown in table 135. 

Table 135 – Toolbar commands  

Icon Command 

 Add 

 Delete 

 Move up 

 Move down 
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5.4.11.2 Electronic switches 

The Electronic switches window, device tree menu Logic part → Control → Electronic 

switches (figure 226) is designed to configure electronic switches. 

 

Figure 226 – Electronic switches window 

The description of window columns is given in table 136. 

Table 136 – Description of columns of the Electronic switches window 

Parameter Function 

Number Number of the electronic switch according to the list 

Name Name of the electronic switch 

Status at first start Value of the electronic switch at the first start of the IED 

Active status Active state of the electronic switch 

Inactive status Inactive state of the electronic switch 

 

5.4.11.3 Administration of management 

The Administration of management window, device tree menu Logic part → Control → Ad-

ministration of management (figure 227) , is designed for adding/deleting IP addresses. 

 

Figure 227 – Administration of management window 

The description of window columns is given in table 137. 
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Table 137 – Description of columns of the Administration of management window 

Parameter Function 

Number  Sequence number of the IP address 

IP address IP address of the computer 

Name Name of the element 

Control level 

Level of control: 

– Dispatching; 

– Station 

 

5.4.12 Differences by setting groups 

The Differences by setting groups window, device tree menu Logic part → Differences by 

setting groups (figure 228), is designed to display parameters that differ in various setting groups. 

 

Figure 228 – Differences by setting groups window 

The description of window columns is given in table 138. 

Table 138 – Description of columns of the Differences by setting groups window 

Parameter Function 

Parameter Name of the parameter 

Settings group Value of the setting 

Units Measurement unit of the parameter 

Description Description of the parameter 
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5.5 IEC 61850 

This node is available, if the configuration has the IEC 61850 Ethernet protocol (see Ethernet 

protocols for details).  

5.5.1 Outgoing GOOSE 

The Outgoing GOOSE window, device tree menu IEC61850 → Outgoing GOOSE (figure 229), 

is designed to configure outgoing GOOSE messages for IEC 61850. Adding outgoing GOOSE to the list 

is done by pressing button , and deleting by using button .  

 

Figure 229 – Outgoing GOOSE window 

Parameters of outgoing GOOSE messages are shown in table 139. 

Table 139 – Parameters of outgoing GOOSE messages for IEC 61850 

Parameter Description 

GOOSE message class 

Class of the GOOSE message: 

– none; 

– I (Type 1A); 

– II (Type 1B); 

– III (Type 1B) 

Multicast MAC address Broadcast address to which GOOSE will be sent 

Application identifier (AppID, 
hex) 

Identifier of the application that uses a multicast (hexadecimal presentation) 

Application identifier (AppID, 
dec) 

Identifier of the application that uses a multicast (decima presentation: numeric 
value, recommended value is 16383) 
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Parameter Description 

Control block (GoCBRef) 
Name of the control block responsible for the GOOSE multicast (recommended 
value is Goose_Out) 

Data set (DataSet) Name of the data set transmitted via GOOSE 

ID GOOSE (GoID) 
Identifier of the device that transmits the GOOSE packet to the general multicast 
(recommended value is ekraN, where N = (1,2,3…)) 

GOOSE configuration version 
(ConfRef) 

Number of the current version of GOOSE configuration 

Standard period for GOOSE 
transmission, ms 

Time intervals (in milliseconds) between the transmission of GOOSE messages 
in the absence of signal changes. Periodic sending is used to control  
the presence of communication. Permissible value range is 100 to 65,000 ms 

Minimal period for GOOSE 
transmission, ms 

Minimum period of cyclic sending in the absence of signal changes. Permissible 
value range is 4 to 10,000 ms 

Quantity of messages with a 
minimal period for transmis-
sion, pcs 

Quantity of messages with a minimum transmission period. Permissible value 
range is 2 to 10 

Doubled period until period 
standard transmission 

If the box is checked, the transmission period is doubled until it reaches the 
standard sending period. 
If the box is not checked, the transmission period is doubled for the number of 
messages specified in the “Quantity of messages with a doubled period transmis-
sion” parameter, after which the transmission period is immediately taken equal 
to the standard 

Quantity of messages with a 
doubled period transmission, 
pcs 

Quantity of messages with a doubled transmission period. Permissible value 
range is 1 to 10 

Enable VLAN Enabling the use of VLAN in outgoing GOOSE messages 

ID VLAN (VlanID) Integer value, which is used in VLAN for identification 

VLAN priority Integer priority value for outgoing GOOSE messages using VLAN  

Network interface Ethernet interface, through which GOOSE message is sent 

Fixed coding checkbox Enables fixed coding mode for GOOSE packets 

 

5.5.2 Incoming GOOSE 

The Incoming GOOSE window, device tree menu IEC61850 → Incoming GOOSE (figure 230), 

is for configuring incoming GOOSE messages for IEC 61850. 

It consists of two components: list of incoming GOOSE and parameters of the selected GOOSE. 
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Figure 230 – Incoming GOOSE window 

GOOSE_INPUT_1, GOOSE_INPUT_2 are virtual input modules for receiving GOOSE messages, 

which are added in the Modules tab. 

An incoming GOOSE is added to the list by pressing button , and deleted by using button . 

Parameters of the incoming GOOSE packet are shown in table 140. 

Table 140 – Parameters of the incoming GOOSE packet 

Parameter Description 

Name Name of incoming GOOSE messages 

Multicast MAC address Broadcast receiving address 

AppID (hex) Identifier of the application that uses a multicast (hexadecimal representation) 

AppID (dec) Identifier of the application that uses a multicast (decimal representation) 

Control block Name of the control block responsible for GOOSE multicast 

Data set (DataSet) Name of the data set transmitted via GOOSE 

ID GOOSE (GoID) Device identifier from which GOOSE must be received 

GOOSE configuration version 
Version of the GOOSE configuration on the device from which we receive a 
signal 

Enable VLAN Enabling the use of VLAN in incoming GOOSE messages 

ID VLAN  Integer value, which is used in VLAN for identification 

Value for no connection / bad 
quality / TEST label in  
non-TEST mode 

Value to which the signal is set when there is no connection (GOOSE  
packets are not received) or when the data quality is poor (invalid, failure)  

Fixed coding checkbox Enables fixed coding mode for GOOSE packets 

 

The packet parameters also include generation of packet data. The quantity of data objects in the 

packet is specified in the Data count item. Data objects can be of the following types: 
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– none (no data); 

– bool (logical type, assigned to virtual inputs via data index); 

– int (integer value); 

– bitstring (string value); 

– bitstring2 (two-bit value); 

– float (data type with floating point); 

– quality (data quality); 

– timestamp; 

– sps (structure, which contains a logical type,data quality and a time stamp). 

 

5.5.3 Data sets 

The Data sets window, device tree menu IEC61850 → Data sets (figure 231), allows you to specify 

several data sets with various binary and analog signals, which can then be used for transmission on the 

Report blocks form. 

The form allows you to configure the IEC 61850 data sets. The main components of the form are 

the list of data sets and parameters of the selected data set. 

 

Figure 231 – Data sets window 

Adding a new data set to the list is done by pressing button , and deleting by using button . 

The type of data set is selected when adding it by pressing button . 

Parameters of the data set consist of a name, a set type and a structure type. 

To select signals for transmission, you need to drag the signals from the left list to the right one. 
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5.5.4 Report blocks 

The Report blocks window, device tree menu IEC61850 → Report blocks (figure 232), is de-

signed for configuring the IEC 61850 report blocks. It consists of two components: a list of report blocks 

and parameters. 

 

Figure 232 – Report blocks window 

Parameters of the report are shown in table 141. 

Table 141 – Parameters of the report 

Parameter Description 

Name Identifier of the report block (only available under IEC 61850) 

Type 
(Unbuffered binary) 
(Buffered binary) 
(Unbuffered analog) 
(Buffered analog) 
(Unbuffered service) 
(Buffered service) 
(Unbuffered mixed) 
(Buffered mixed) 

Unbuffered – in the absence of connection, the transmitted data is lost 
Buffered – during the time of connection failure, data is accumulated, 
when communication is restored, data is transmitted 

Data set Link to the data set created in menu item Data sets 

Report send period, ms Time of periodic sending of current values in milliseconds 

Data buffering time, ms Time of data collection before sending in milliseconds 

Report block configuration version Setting and displaying the version of report block configuration 

Quantity of copies of report block Quantity of identical report blocks, integer in the range of 1 to 60 

Report block identifier Text designation of the data report block 
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The list of fields (to choose from) that are transmitted in the report is given in table 142. 

Table 142 – List of transmitted fields 

Field Description 

ENTRYID Entry identifier 

BFOVFL Buffer overflow sign 

DATREF Data reference 

DSNAME Data set name 

RSNINC Reason for including to report 

REPTTM Report transmission time 

SEQNUM Sequence number 

CNFREV Configuration revision 

 

The list of transmission modes is given in table 143. 

Table 143 – List of transmission modes 

Mode Description 

GI General interrogation 

INTEGRT Periodic transmission 

DATUPD Sending data updates 

QLTCNG Sending on data quality changes 

DATCNG Sending on data changes 

 

5.5.5 Data model 

The Data model window, device tree menu IEC61850 → Data model (figure 233), allows the user 

to add new and edit existing logical nodes of the 61850 data model and bind binary signals to them. 
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Figure 233 – Data model window 

5.6 Modbus client 

The Modbus client here means configuring the device for reading data (both analog and binary) 

using the Modbus RTU or Modbus TCP protocol via serial or network communication interfaces from an-

other similar device. Typically, this function is used when configuring bay controllers.  

Let's focus on the configuration process. In order to configure Modbus clients, the Modbus client 

protocol must be added in the Hardware → System parameters window in the Ethernet protocols tab 

or in the Serial protocols tab, otherwise this menu item is missing. 

After adding the Modbus client protocol, a new node will be added to the project tree Modbus client 

(figure 234). 

 

Figure 234 – Modbus client tab in the device tree 

To edit settings of Modbus clients, open the Modbus client window (see figure 235). 
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Figure 235 – Modbus client window 

The window is divided into two areas. In figure 235, item 1 the hierarchical structure of requests of 

Modbus clients is shown, and in figure 235, item 2 – parameters of the selected node in the hierarchy. The 

hierarchical structure is represented as a tree and consists of four levels: 

а) Servers – contains a list of interrogated servers via Modbus client protocol; 

b) Server – interrogated device;  

A new server can be added or deleted via context menu of the tree.  

Server parameters are specified in table 144. 

Table 144  Server parameters 

Parameter Description 

Server name Name of the interrogated device 

Device address Address of the interrogated device 

Response wait time, ms Time to wait for a response from the device to a request in milliseconds 

Reconnect time, s 
Period of reconnection to the device when the connection is broken  
in seconds 

Q-ty of errors before disconnect 
Quantity of consecutive erroneous requests, after which the connection  
to the device is broken 

Endian Byte order in the memory map (0 – little endian, 1 – big endian) 

 

c) Data set – logically grouped data obtained when interrogating devices. When a data set is se-

lected, parameters of the data set are displayed in the right part of the window (figure 236). A data set can 

be added or deleted via context menu of the tree; 

 

Figure 236 – Data set 

2 1 
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Parameters of the data set are shown in table 145. 

Table 145  Parameters of the data set 

Parameter Description 

Data set name Name of the data set 

Retry period, ms Period of device interrogation in seconds 

Q-ty of repeat requests in case of error Quantity of request retries in case of error 

 

d) Requests are Modbus protocol functions that are performed when interrogating devices. Re-

quests are added and deleted through the context menu of the tree (figure 237). 

 

Figure 237 – Requests 

Each request can consist of several data elements, which are added and deleted using correspond-

ing buttons (figure 238). 

 

Figure 238 – Data elements 

Each request element consists of several parameters. Numbers can be displayed in two formats:  

– hex – hexadecimal number format; 

– dec – decimal number format. 

Parameters of data elements in the request are show in table 146. 
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Table 146  Parameters of data elements in the request 

Parameter name Description 

Parameter number 
Direct number of the data element. Represents a service field that is required  
when setting formulas in calculated values 

Element type 

It specifies the type of the data element. There can be several types: 

– bit; 

– bit in register; 

– DPI; 

– int8; 

– int16; 

– int32; 

– int64; 

– uint8; 

– uint16; 

– uint32; 

– uint64; 

– float32; 

– double64 

Name Name of the data element 

Mask Mask of the data received from the interrogated device 

Text for logical 0 For functions 3 and 4 it sets an offset. For other functions it will be a text value for logical 0 

Text for logical 1 
For functions 3 and 4 it sets a multiplier. For other functions it will be a text value for logi-
cal 1 

Source address Source address on the interrogated device 

Receiver 

Receiver type. There are several types:  
binary module; 
memory card 
If you do not specify the type of receiver, then the data is not saved anywhere. There is a 
special type of VinputModbus binary module – it is used to display data received via  
the Modbus client protocol 

Receiver address 
It specifies the receiver address. For the binary module it is the module number, and for the 
memory map it is the address in the IED's memory card 

 

5.7 Calculated values 

The Calculated values window (figures 239 – 241) is designed to create a list of measurements 

that are the result of calculations on IED signals. The calculated values are available for viewing through 

the IED menu, and they can also be placed on the mimic diagram. 
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Figure 239 – Calculated values window 

The continuation of the window is given in figure 240. 

 

Figure 240 – Continuation of the Calculated values window 

 

Figure 241 – Parameters of calculated values 

The list of calculated values and their description are given in table 147. 
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Table 147 – List of calculated values and their description 

Parameter Description 

Number Sequence number of the calculated value is entered automatically 

Name Name of the calculated value is specified 

Meas. unit 
It is required to select a measurement unit. Logic value is selected for binary 
signals 

Formula Formula is specified by which calculation will be carried out. Entered formulas 

are checked, in case of an error, the cell will be marked with . A detailed 

guide on creating formulas can be received by pressing the Help button. 

Format It is specified, in which format the value is displayed on the IED screen. Format 
string syntax (optional parameters in square brackets): 
%[flags][width][.accuracy][size]type 
Flags: “-” – left alignment, “+” – always specify the character, “space” – place a 
space, if the first symbol is not a character, “0” – complement the field with zeros 
up to the width 
Width: (decimal number or a star symbol) specifies the minimum field width (in-
cluding a character for numbers) 
Accuracy is set as a dot followed by a decimal number or an asterisk (*). If there 
is no number or asterisk (only a dot is present), then the number is assumed to 
be zero. 
Size field allows you to specify the size of the data. 
Type specifies not only the type of the value (from the point of view of the C pro-
gramming language), but also the specific representation of the output value (for 
example, numbers can be displayed in decimal or hexadecimal form). Written as 
a single character. Unlike other fields, this field is required. 
Type values: 
d, i – decimal signed number; 
o – octal unsigned number; 
u – decimal unsigned number; 
x and X – hexadecimal number; 
f and F – floating point numbers. 
e and E – floating point numbers in the exponential record form (1.1e+44 type); 
e displays “e” character in the lowercase, E displays it in the uppercase (3.14E+0); 
g and G – floating point number; the representation form depends on a value (f or 
e); 
a and A – floating point number in hexadecimal form; 
Example: %05.1f 

Display calculated value Enabling display of the calculated value in the Smart Monitor software and in the 
IED menu 

Transmit to FP Enabling transmission of results to the functional processor. This parameter is 
available only for values with the logic type. When checking the box, this signal 
appears on the logic diagram 

Disturbance recording Enabling disturbance recording 

Use alarm and validity 
thresholds 

Enabling use of thresholds 

Alarm and validity thresholds Description of settings of the analog calculated value range 

Parameter Parameter of the calculated value 

Value Calculated value 
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5.7.1 Calculated values settings 

The Calculated values ettings window, device tree menu Calculated values → Calculated val-

ues ettings (figure 242), is designed for editing the settings of calculated values. 

 

 

Figure 242 – Calculated values ettings window 

The settings of calculated values are added to the list by pressing button , and deleted by using 

button . The setting parameters of calculated values are shown in table 148. 

Table 148 – Parameters of calculated values 

Parameter Description 

Number Number of the calculated value setting 

Name Name of the calculated value setting 

Setting group 1 Setting of the calculated value 

Unit Measurement unit of the calculated value setting 

Min. value Minimum value of the calculated value setting 

Max. value Maximum value of the calculated value setting 

Description (Ru) Comment in Russian 

Description (En) Comment in English 

 
* The quantity of columns depends on the quantity of setting groups in the configuration. 

 

5.8 User data 

The User data window (figure 243) is designed for adding user data. 

 

 

Figure 243 – User data window 

The description of columns of the user data table is given in table 149. 
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Table 149 – Description of columns of the user data table 

Column Function 

Number Number of the user data element 

Group Group to which the user data element belongs 

Signal Signal based on which the user data element will be generated 

Source data type Type of the source signal data 

Destination data type Data type of the user data element 

Address Address of the user data element in the ModBus memory map 

Name Name of the user data element 

 

5.9 103 Protocol Master 

The 103 Protocol Master window is shown in figure 244.  

The table of variables consists of two components: slave devices and parameters of IEC103Slave. 

 

 

Figure 244 – 103 Protocol Master window 

Note – The window is displayed if the IEC103Master protocol is available in menu item System parame-

ters → Serial protocols. 

The slave device and variables are added to the list by pressing button , and deleting by using 

button . Parameters of the slave device are shown in table 150. 
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Table 150 – Parameters of slave devices 

Parameter Description 

Name in Russian Slave device in Russian 

Name in English Slave device in English 

Network address Address of the slave device 

Reconnect interval, s Interval between reconnection commands in seconds 

GI interval, s Interval between general interrogation commands in seconds 

Polling interval, ms Interval between data requests in milliseconds 

Confirmation timeout, ms Maximum time to wait for confirmation in milliseconds 

Response timeout, s Maximum time to wait for a slave response in seconds 

Retry count Maximum quantity of connection retries 

 

Parameters of variables are shown in table 151. 

Table 151 – Parameters of variables 

Parameter Description 

# Sequence number of the variable for the current device 

Ru name Russian name of the slave device 

En name English name of the slave device 

Variable type Variable type of the slave device 

Address type Address type of the slave device 

Parameters Parameters of the slave device 

 

5.10 Configuration parameters 

The configuration parameters describe main parameters of the configuration file. 

5.10.1 Versions  

Description of versions of files and libraries (figure 245) included in the configuration: 

– Configuration; 

– Library; 

– Dist. record file; 

– Event recorder file; 

– DSP program; 

– Firmware; 

– Program assembly. 
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Figure 245 – Versions tab 

5.10.2 Project files 

The list of project files (figure 246) is given in table 152. 

Table 152 – List of project files 

File Description 

CZG file  File of the project configuration 

Logic file File of the project logic 

Flexible logic file File of the project flexible logic 

IEC61850 model file File of the project IEC61850 model 

 

 

Figure 246 – Project files tab 
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5.10.3 Customer 

 

Figure 247 – Customer tab 

Main parameters in the Customer tab (figure 247) are shown in table 153. 

Table 153 – Customer 

Name Description 

Client 

Object electric energy industry 
Protected object 
Cabinet name 
Cabinet serial number 
IED name 
IED serial number 
Set 
Functional diagram version 
Comments to FD in Ru 
Comments to FD in En 
Configuration version 
Hardware configuration 
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Name Description 

Protected objects List of protected objects 

Protected subobjects List of protected subobjects 

 

5.11 Possible failures 

5.11.1 Errors when opening the configuration in the Configurator program 

The main error when opening the configuration file  is opening a corrupted configuration file. If the 

configuration file is corrupted or has an unsupported version, the following message will be displayed: 

“Error in the application. CZG version is not supported!”. In addition, there may be an error within the 

configuration, which will be reported in the Errors in configuration tab (figure 248). 

 

Figure 248 – Errors in configuration 

5.11.2 Errors when working with logic in the Configurator program 

Before starting or compiling the logic, make sure that all logic outputs are connected or discon-

nected. Otherwise, a message will be displayed at start: “Logic compilation failed. Your logic diagram has 

unused outputs! Disable or connect them” (figure 249). Next, a list of unconnected outputs will be offered 

with the option to disable them (figure 250). 

 

Figure 249 – Message about failure to compile logic 
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Figure 250 – Unused outputs in the logic 
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6 Description of Health Monitor interface 

5.1 Start 

The program is started via the PC Start menu. 

 
5.2 Program shutdown 

Closing the program with the ALT+F4 key combination or by clicking  on the title bar of the 

main window minimizes the program to the system tray by default. To completely close the program, you 

need to open the system tray, move the cursor over the program and open the context menu by clicking 

the right mouse button. In order for the application to be closed using the above actions, it is necessary to 

check the box “Shutdown program when closing window” in the General tab in the program settings. 

 
5.3 General view 

The standard window of the Health Monitor program includes the following: 

– title containing the name and version of the program (figure 251, item 1); 

– Menu (figure 251, item 2); 

– IED states (figure 251, item 3); 

– Event log (figure 251, item 4). 

 

Figure 251 – Standard Health Monitor window 

The Menu tab contains a tree of objects designed for viewing and editing the list of connected 

devices.  

The IED statuses tab displays a list of connected devices. The device status bar displays device 

state indicators: In servise, Error, Operate and Connection. Possible states of indicators: 

 “green” – normal (operational) state; the indicator is green; 

 “red” – emergency state; the indicator is red; 

 “orange” – warning failure; the indicator is orange; 

 “grey” – undefined state; the indicator is grey. 

1 

2 

3 

4 
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Available states of indicators are given in table 154. 

Table 154 – States of indicators 

Indicator Indicator color Description 

Operation Green Normal operation mode of the IED. No failure. The IED is in the “Operation (On)” 
mode 

Red Emergency failure of the IED or the IED is in a mode other than the “Operation 
(On)” mode 

Grey Connection to the IED is not available 

Error Green Normal operation mode of the IED. No failure 

Red Emergency failure of the IED. Requires immediate intervention to disable the IED 
and troubleshooting. In this case, the IED does not perform the intended functions 
or performs them in a limited amount in accordance with the functional diagram 

Orange Emergency failure of the IED. 
At the same time, the IED remains in operation, i.e. performs the assigned func-
tions in accordance with the functional diagram. Further operation of the IED with 
troubleshooting is possible at any convenient time 

Grey Connection to the IED not available 

Operate Green No operate 

Red There are signals that are configured for alarm 

Grey Connection to the IED not available 

Connection Green Informs about the available connection to the IED 

Red Connection to the IED is not available. In this case, the first three indicators 
change color to grey 

 

Examples of device states: 

а) connection to the device is not available (figure 252); 

 

Figure 252 – Connection to the device is not available 

b) connection to the device is available; the device is in normal operation state (figure 253); 

 

Figure 253 – Connection to the device is available 
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c) functions have operated or signals have appeared that affect the emergency alarm signal (fig-

ure 254); 

 

Figure 254 – Operation of functions or appearance of signals 

d) device is in non-operating state, not ready for operation and there is a failure (figure 255); 

 

Figure 255 – Device is not ready for operation and there is a failure 

e) device is in non-operating state, not ready for operation (figure 256). 

 

Figure 256 – Device is not ready for operation 

If there is a connection to the device, you can start the Smart Monitor program by clicking on the 

button  (figure 257). 
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Figure 257 – Start of the Smart Monitor program 

Also in the IED statuses tab, you can change the font size by moving the scale slider (figure 258). 

 

Figure 258 – IED statuses tab 

5.3.1 Toolbar 

The toolbar of the Menu tab is given in figure 259. 

  

Figure 259 – Toolbar of the Menu tab 

The description of the toolbar buttons is given in table 155. 

Table 155 – Description of toolbar buttons 

Button Description 

 
Adding a connection 

 
Search for IEDs in the local network 

 
Program settings 

 
Manual merging 

 

The description of the windows and tabs that are displayed when the button is clicked is given 

below. 
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1) Adding a connection . 

The General tab is given in figure 260. 

 

Figure 260 – Adding a connection 

The description of parameters for adding a connection is given in table 156. 

Table 156 – Description of parameters for adding a connection 

Parameter Description 

Connection type: - TCP/IP; 
- USB; 
- COM 

 

Adding a TCP/IP connection (General tab) (figure 261). 
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Figure 261 – Adding a TCP/IP connection 

The description of window parameters is given in table 157. 

Table 157 – Description of parameters for adding a TCP/IP connection 

Parameter Description 

Set name: Checked box allows you to set the name of the connection 

Name: 
Field for entering the name of the IED. The field is available after checking 
the “Set name” box 

Search for IEDs in local network Possibility to search for IEDs in the local network 

IED IP address: Field for entering the IP address of the IED manually 

Port: Connection port 

Use gateway: Checked box allows using the gateway 

Gateway IP address: Entering the gateway IP address manually 

Gateway port: Field for entering the connection gateway port 

 

The window for IED search in the local network is given in figure 262. 
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 Figure 262 – IED search in local network  

The description of search parameters for IEDs in the local network is given in table 158. 

Table 158 – Description of search parameters for IEDs in the local network 

Parameter Description 

Network adapter: Selecting a network interface for automatic search for IEDs 

Name IED name 

IP address IP address of the IED 

Port Connection port 

Modbus address Modbus address of the IED 

 

Adding a USB connection (General tab) (figure 263). 

 

Figure 263 – Adding a USB connection 
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The description of window parameters is given in table 159. 

Table 159 – Description of parameters for adding a USB connection 

Parameter Description 

Set name: Checked box allows you to set the name 

Name: Connection name 

USB device: Selecting the device for connection 

 

Adding a COM connection (General tab) (figure 264). 

 

Figure 264 – Adding a COM connection 

The description of window parameters is given in table 160. 

Table 160 – Description of parameters for adding a COM connection 

Parameter Description 

Set name: Checked box allows you to set the name 

Name: Connection name 

COM port: Selecting the COM port 

Speed 

Selecting the COM port speed from the drop-down list (bps): 
- 110; 
- 300; 
- 1,200; 
- 2,400; 
- 4,800; 
- 9,600; 
- 19,200; 
- 38,400; 
- 57,600; 
- 115,200; 
- 230,400; 
- 460,800; 
- 921,600 

IED address Entering the Modbus address of the IED   
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To select the parameters for auto-download of disturbance records, go to the Auto-download dist. 

records tab and check the “Auto-download” box (figure 265). 

 

Figure 265 – Auto-download dist. records tab 

The parameters of the Auto-download dist. records tab are given in table 161. 

Table 161 – Parameters for auto-download of disturbance records 

Parameter Description 

Auto-download Checked box indicates automatic download of disturbance records 

Period, ms: Period of download of disturbance records 

Name format 

Name format: 

– By default (the names of automatically downloaded disturbance 
record files will have the Oscil_oXXXX format, where <Oscil> is the 
name of the configuration file;  
 

 <XXXX> – sequence number of the disturbance record, the “_” 
symbol means space); 
Example – kp200 o0134; 
– Date, Time, Timecode, Object, Source, Subject (the names of au-
tomatically downloaded disturbance record files will have the format 
Date, Time, Timecode, Object, Source, Subject according to 
STO 59012820.29.020.006-2015, where <Object> (object of power 
industry) is the name of the substation or power plant, <Source> – 
name of ER, <Subject> (subject of power industry) – name of the 
legal entity. The date and time of generation of the disturbance rec-
ord are added to the end of the name automatically). Example – 

22.09.23, 23.06.30.000, 0t, CHP-3, GT-12; 
 
– Set manually (the name of the automatically downloaded file will 
have the format <Name>_<Date>_<Time>, where <Name> is the 
name of the disturbance record. The date and time of generation of 
the disturbance record are added automatically).  
Example – te1 23.08.2016. 10.28.24 
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Parameter Description 

Sending disturbance records by E-mail 

Sending by E-mail: Checked box indicates sending disturbance records by E-mail 

Logging 

Write to log: Checked box indicates writing to the log 

Mode: 

– Errors only (writes additional data to the log when errors occur); 
– By default (informs about the downloaded disturbance records: 
time of downloading the disturbance record, sending via 
mail); 
– Advanced (informs the download of the disturbance record in 
step-by-step mode: the beginning of downloading the disturbance 
record, conversion, all movements of disturbance records) 

 

The Mail client settings window is given in figure 266. 

 

Figure 266 – Mail client settings window 

The description of parameters of the Mail client settings window is given in table 162. 
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Table 162 – Description of mail client settings 

Parameter Description 

Subject 

Subject of the e-mail to be sent in the format <Object>/<Device> 
<Time> <Date> 
Allowed tags: 
<Object> – <Object name>; 
<Location> – <Installation location>; 
<Device> – <Device name>; 
<Date>; 
<Time>; 
<Osc> – <Name of disturbance record> 

Text Text of the message informing about the disturbance record 

Mail server 

Mail server address: 
Mail server address is configured for each device individually. The 
data is requested from the administrator of the organization's mail 
server 

Mail server port: 
Port on which the mail server is running. The data is requested 
from the mail server administrator 

Authentication: Authentication (user data and password are entered) 

Encryption (SSL): 
Using encryption when sending e-mail messages. The data is re-
quested from the mail server administrator 

Server check 
Checking server operation (it is recommended to perform this oper-
ation after editing the mail client settings) 

Mail addresses 

E-mail of sender: String for entering the e-mail address of the sender 

E-mail of recipients of disturbance records 
(separated by commas): 

String for entering the email address of the recipient(s) 

 

2) Add a connection  (figure 267). 

The command allows you finding devices in the local network. When you select a command, a list 

of available devices is displayed. 

 

Figure 267 – IED search window 

Multiple devices can be selected from the list by checking the boxes in the Select column. It is also 

possible to select all IEDs or deselect all by clicking on the title of the Select column. 

If necessary, you can connect or disconnect all added devices. To do this, right-click the mouse 

and select Connect all or Disconnect all from the context menu of the object tree (figure 268). 
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Figure 268 – Context menu of the tree of objects 

3) Settings of the program  (figures 269 – 271).  

 

Figure 269 – General settings of the program 

The description of general settings of the program (Figure 269) is given in table 163. 

Table 163 – Description of general settings of the program 

Parameter Description 

Autostart at system start Checked box indicates an automatic start of the program at system start 

Shutdown program when closing 
window 

Selected box indicates that the program will be shutdown when closing 
the window. If this box is not checked, the program will be hidden in the 
system tray 

Disable advanced Modbus file 
transfer features 

Checked box indicates that advanced features of file transfer via Modbus 
are disabled 

Send statistics and errors to devel-
opers 

Checked box allows sending statistics and program errors to developers 

Display disturbance record down-
load statistics 

Checked box indicates the display of disturbance record download statis-
tics 

Program language: 
Selecting the program language from the drop-down list: 
- ru; 
- en 

Interface scale, %: Setting the interface scale 
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Parameter Description 

Disturbance record viewer: Path to disturbance record viewer 

Interval between connections in 
queue, ms: 

Set the interval between connections in the queue in milliseconds 

Connection retry interval after con-
nection loss, ms: 

Set connection retry interval after connection loss in milliseconds 

 

The Dist. record directory parameters tab (Figure 270) allows you to configure the template of 

the directory for saving disturbance records downloaded from devices. Configuration consists of selecting 

a base directory, defining a directory tree hierarchy, defining the method for constructing the “Device lo-

cation” node, and defining the method for constructing the “Start date” node. The location of the default 

base directory is determined by the operating system to store application data. Changing the settings 

changes the display of this template. 

 

Figure 270 – Dist. record directory parameters tab 

The description of disturbance record directory parameters is given in table 164. 

Table 164 – Description of general settings of the program 

Parameter Description 

Base directory Path of the base directory 

Directory tree hierarchy Selecting the directory tree hierarchy: 
– <Start date>+<Device location>; 
– <Device location>+<Start date> 
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Parameter Description 

<Device location> node construction 
method 

Selecting the method for constructing the <Device location> node (multiple 
positions can be selected): 
– add the name of the object; 
– add the location for installation; 
– add the name of the device 

<Start date> node construction 
method 

Selecting the method for constructing the <Start date> node: 
– split into subnodes <YearMonth>+<Day>; 
– split into subnodes <Year>+<Month>+<Day>; 
– do not split into subnodes (<YearMonth_Day> directory) 

Disturbance record storage direc-
tory 

Displaying the storage path of disturbance records by selected parameters 

 

 

Figure 271 – Dist. records auto merge tab 

The Dist. records auto merge tab is designed to merge disturbance records that belong to the 

same event into a single disturbance record according to a specified template. The checked box enables 

automatic merging of disturbance records. 

To set automatic merging of disturbance records press the Settings button.  
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Figure 272 – Auto merge settings window 

The description of parameters of the Auto merge settings window (Figure 272) is given in ta-

ble 165. 

Table 165 – Description of parameters of the Auto merge settings window 

Parameter Description 

Template count, pcs: Number of templates added 

Select setting template: 

Selecting created templates from the drop-down list: 
– Template_1; 
– Template_2; 
– Template_3, etc. 

Setting selected template 

Template name: Name for the selected template 

Add devices, pcs: Adding a device for the selected template in the range of values 1 to 999 

Permissible start signal divergence 
time, ms: 

Permissible range of values is 0 to 5,000 ms in 1 ms increments 

Disturbance record wait period, s: Permissible range of values is 10 to 86,400 s in 1 s increments 

Encoding 

Encoding for saving disturbance records from the drop-down list: 
– UTF8; 
– Windows1251; 
– OEM866 

Save format 

Saving merged disturbance records in COMTRADE format from the drop-
down list: 
– .cfg + .dat; 
– cff 

Merge by min. frequency 

Checked box allows merging of disturbance records by the minimum fre-
quency. For merging, the program selects the minimum sample fre-
quency of converted disturbance records, which is applied to all disturb-
ance records 
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Parameter Description 

Devices List of added devices 

Disturbance record directory 1, 2, 3... Directory of the selected disturbance record 

Signal name prefix 
Possibility to add a corresponding prefix in front of the names of signals 
in the merged disturbance record to identify signals of the same name 
from different devices 

Merged disturbance record storage 
directory 

Directory with merged disturbance records 

 

The user manually sets one or more templates for the operation of the automatic disturbance record 

merging function (hereinafter referred to as the function). Each template specifies the directories that re-

ceive disturbance records in COMTRADE format from RPA devices. The function checks the directories 

specified in the templates for new disturbance records from the moment the function is enabled. 

When new disturbance records appear, the function extracts the start date and time (start label) 

from each disturbance record. Based on the received start labels, which are included in the range of the 

“Permissible start signal divergence time” parameter, the function determines the list of disturbance rec-

ords for subsequent merging. Merging of disturbance records is carried out immediately after finding all 

the disturbance records in the directories that belong to one event, or after the “Disturbance record wait 

period” time has elapsed (when two or more disturbance records are found).   

4) Manual merge  (figure 273).  

 

Figure 273 – Dist. records manual merge window 
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The description of parameters of the Manual merge window is given in table 166. 

Table 166 – Parameters of the Manual merge window 

Parameter Description 

Add disturbance records Adding a disturbance record file 

Clear selected fields Clearing selected fields 

Clear all fields Clearing all fields 

Disturbance records 

Disturbance record Disturbance record file name 

Start moment Date and time of disturbance record start 

Device Device name 

Installation location Object of power industry 

Signal name prefix 
Possibility to add a corresponding prefix in front of the names of signals in the 
merged disturbance record to identify signals of the same name from different 
devices 

Merge settings 

Permissible start signal diver-
gence time, ms 

Permissible range of values is 0 to 5,000 ms in 1 ms increments 

Encoding 

Encoding for saving disturbance records from the drop-down list: 
– UTF8; 
– Windows1251; 
– OEM866 

Save format 
Format for saving merged disturbance records from the drop-down list: 
– .cfg + .dat; 
– cff 

Merge by min. frequency Checked box allows merging by the minimum frequency 

Merged disturbance record 
storage directory 

Location of the directory with merged disturbance records 

 

Each device has its own toolbar.  

Possible device connection states are given in table 167. 

Table 167 – Device connection states 

Command Description 

Connection error 

 

Possible connection errors: 
– TCP/IP is not installed; 
– IP address of the PC is not specified when setting the 
TCP/IP protocol on the local PC; 
– device is not available (turned off or not connected to 
the local network) 

Connected 

 

Device is connected 

Reconnection 

 

Reconnecting the device 

Lost connection The device is not available (problems in the local network 
or the device is disconnected from the network) 
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Command Description 

 
 

The description of the device toolbar commands is given in table 168. 

Table 168 – Description of the device toolbar 

Command Description 

Connect Reconnecting the device 

 Disconnect 
 Disconnecting the device 

Settings Editing general device settings, auto-download of disturbance records 

Remove Removing the device from the list 

 

5.4 Messages to operator 

At program start and execution stages errors may appear. The reasons for such situations can be 

incorrect user actions, incorrect program setting, incorrect configuration of the operating environment. As 

a rule, the program itself detects errors and if possible troubleshoots them autonomously, otherwise the 

user will be provided with detailed information about the error and its troubleshooting. 

This section provides a description of the most common errors, indicating the messages generated 

by the program, and ways of troubleshooting. 

When establishing a connection with the device, an error situation may occur for several reasons: 

1) the OS does not have the Modbus TCP/IP protocol installed. In this case, you need to close the 

program, open the Control Panel, select the Network shortcut and install the Modbus TCP/IP protocol; 

2) it may turn out that the PC at the specified name or IP address is found, but the PC is using a 

different TCP port than that specified in the program. In this case, you need to determine which TCP port 

is used to connect to the program. 

If there are any difficulties, you should contact the administrator of the local network of the enter-

prise. 
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Annex A 

Logical elements and their designation  

Main logical elements used to configure the IED, their principle of operation and purpose are shown 

in table A.1. The operation principle is shown on the example of truth tables or timing diagrams. 

Table A.1 – Main logical elements 

Logical element Name Description Operation principle Notes 

1

2

3

&

DX

 

DXi,  
where i is el-
ement num-

ber 

Logical  
AND 

Input 1 Input 2 Output Logical element that performs 
the function of logical multipli-
cation. There will be one at 
the output only when one ap-
pears at all inputs.  
Number of element inputs 
cannot exceed 30. It has no 
settings 

0 0 0 

0 1 0 

1 0 0 

1 1 1 

DX

1

2

3

&

 

DXi, 
where i is el-
ement num-

ber 

Logical 
AND – NO 

0 0 1 
Logical element that works 
like an AND element, but with 
an inverted output signal. 
There will be one at the ele-
ment output when zero ap-
pears at one of its inputs. 
Number of element inputs 
cannot exceed 30. It has no 
settings 

0 1 1 

1 0 1 

1 1 0 

DW

1

2

3

1

 

DWi, 
where i is el-
ement num-

ber 

Logical  
OR 

0 0 0 
Logical element that performs 
the function of logical addi-
tion. There will be one at the 
element output when one ap-
pears at least at one of its in-
puts. 
Number of element inputs 
cannot exceed 30. It has no 
settings 

0 1 1 

1 0 1 

1 1 1 

DW

11

2

3

 

DWi, 
where i is el-
ement num-

ber 

Logical  
OR – NO 

0 0 1 
Logical element that works 
like an OR element, but with 
an inverted output signal. 
There will be one at the ele-
ment output only when zeros 
appear at all inputs. 
Number of element inputs 
cannot exceed 30. It has no 
settings 

0 1 0 

1 0 0 

1 1 0 

XOR

1

1

2

3

 

XORi, 
where i is ele-
ment number 

Logical Ex-
clusive OR 

0 0 0 
Logical element that gener-
ates one at the output, if there 
is one, at least at one of the 
inputs, when one appears at 
both inputs, a zero signal is 
generated at the output. 
This element always has ex-
actly two inputs. It has no set-
tings 

 

   

0 1 1 

1 0 1 

1 1 0 
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1 2

F_TRIG

CLK Q

 

F_TRIGi, 
where i is ele-
ment number 

Determining 
falling edge 

In

Out

1 ms 1 ms 1 ms
t

 

Logical element is designed 
to determine switching of the 
signal at the element input 
from “1” to “0” and issue a 
pulse at the output. 
If the CLK signal changes at 
the F_TRIG element input 
from “1” to “0”, a pulse with 
duration of 1 ms is generated 
at output Q. 
It has no settings 

1 2

R_TRIG

CLK Q

 

R_TRIGi*, 
where i is ele-
ment number 

Determining 
rising edge 

In

Out

1 ms 1 ms 1 ms
t

 

Logical element is designed 
to determine switching of the 
signal at the element input 
from “0” to “1” and issue a 
pulse at the output. 
If the CLK signal changes at 
the R_TRIG element input 
from “0” to “1”, a pulse with 
duration of 1 ms is generated 
at output Q. 
It has no settings 

DS

R

S
T

1

2

3

 
 

DSi, 
where i is ele-
ment number 

RS trigger 
with S prior-

ity 

1

3

2

t

t

t

In2

In1

Out

 

Logical element that has the 
ability to stay in one of two 
stable states for a long time. 
Designed to record and store 
information.  
If there is one at input S (set), 
one appears at the output, re-
gardless of the signal at input 
R. The trigger remembers the 
signal and holds it. When 
S=0, the presence of one at 
input R (reset) sets the output 
to state 0.    
It has no settings. With R=1 
and S=1 there will be “1” at 
the output 

DS

R

S
Tr

1

2

3

 

DSi, 
where i is ele-
ment number 

RS trigger 
with R prior-

ity 

1

3

2

t

t

t

In2

In1

Out

 

Logical element that has the 
ability to stay in one of two 
stable states for a long time. 
Designed to record and store 
information.  
With R=0, when one arrives at 
input S (set), one appears at 
the output. The trigger re-
members the signal and holds 
it. When one appears at input 
R (reset), the output signal is 
reset, regardless of the signal 
at input S. 
It has no settings. With R=1 
and S=1 there will be “0” at 
the output 

DS

R

S
Trom

1

2

3

 

DSi, 
where i is ele-
ment number 

Non-volatile 
RS trigger 

with R prior-
ity 

 

1

3

2

t

t

t

In2

In1

Out

 

Logical element maintaining 
its state when the operating 
power supply of the IED is 
turned off and recovering 
when the power supply is re-
stored.  
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The principle of operation is 
similar to the operation princi-
ple of the trigger with R prior-
ity. 
It has no settings. With R=1 
and S=1 there will be “0” at 
the output 

DC

R

C
CT

1

2

3

 

DCi, 
where i is ele-
ment number 

Pulse  
counter 

1

3

2
t

t

t

In2

In1

Out

Number of pulses N=3 (setting)

N

 

Logical element that counts 
pulses received at input С. 
When the number of pulses 
N, specified by the setting, is 
exceeded, one is generated 
at the counter output and is 
held until a reset signal is re-
ceived at input R (reset). If the 
reset signal appears before 
operate setting is reached, 
the counted number of pulses 
is reset, and the count starts 
again.  
The value of counter setting is 
within the range from 1 to 
9,999.000 pulses 

VSX
1

2

3

4

 

VSXi, 
where i is ele-
ment number 

Input switch 

Input 
1 

Input 
2 

Input 
3 

Out-
put 

Logical element containing 
three inputs and one output 
and having an option to switch 
between two inputs by the sig-
nal of the third input. 
When the signal of input 3 is 
zero, output signal equals to 
the signal at input 1, and 
when the signal of input 3 is 
one, output signal equals to 
the signal at input 2. 
It has no settings 

0 0 0 0 

1 0 0 1 

1 0 1 0 

0 1 0 0 

0 0 1 0 

1 1 0 1 

0 1 1 1 

1 1 1 1 

DT

1 2

 

DT

1 2

 

DTi, 
where i is ele-
ment number 

Operate 
time delay 

(non-adjust-
able) 1

2

In

Out

t

t

t < T

T

T – time delay setting

 

Logical element that delays 
the signal. 
Time delays are divided into 
adjustable and non-adjusta-
ble. 
The value of adjustable time 
delay is editable in the range 
from 0 to 9,999.000 s, the 
change step is 1 ms. 
The value of non-adjustable 
time delay is not editable 

Operate 
time delay 

(adjustable) 

DT

1 2

 

DTi, 
where i is ele-
ment number 

 
Reset time 

delay  
(non-adjust-

able) 
 

1

2

In

Out

t

t

T

T – time delay setting

 

Reset time 
delay (ad-
justable)  
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DT

1 2

 

TMOC

1 2

 

TMOCi, 
where i is ele-
ment number 

Pulse 
former 

t

tT T

1

2

In

Out

T – pulse duration (setting)

 

Logical element that gener-
ates an output pulse with a 
duration of T, determined by 
the setting, when the state at 
the input changes from zero 
to one.  
The value of time delay for 
these elements is within the 
range from 0.001 to 
9,999.000 s, the change step 
is 1 ms 

TMOI

1 2

 

TMOIi, 
where i is ele-
ment number 

Pulse for-
mer with in-
terruption 

 

1

2

In

Out

t

tT

T – pulse duration (setting)

 

 

Logical element that gener-
ates an output pulse with a 
duration of T, determined by 
the setting, when the state at 
the input changes from zero 
to one. The output is reset to 
logical “0” if the input is set to 
“0” before the end of the 
pulse. 
The value of time delay for 
these elements is within the 
range from 0.001 to 
9,999.000 s, the change step 
is 1 ms 

Gen

1 2

 

Geni, 
where i is ele-
ment number 

Rectangular 
pulse gen-

erator 

 

t

tt

Settings: T – pulse period;

1

2

In

Out

T

t – pulse length (t < T)

 

 

Logical element that gener-
ates pulses with a duration of 
t in the presence of a signal at 
the input. It has two settings: 
T signal period and t pulse du-
ration. 
The signal period is in the 
range from 0 to 
27 s, the change step is 1 ms. 
The pulse duration is always 
less than the signal period 

VXN

 

VXNi, 
where i is ele-
ment number 

Program 
switch 

Changeable parameter de-
termined when specifying 

the settings 

It can take two values: 
opened (“0”), closed (“1”) 
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С+

С-

R

min

max

D

СH

rom

СHrom

 

CHromi, 
where i is ele-
ment number 

Counter of 
OLTC drive 

steps 

Counted by adding 
(Ncurr=Ncurr+1) (sub-
tracting (Ncurr=Ncurr-1)) 
with each appearance of 
adjustment signal “Add 
(C+)” (“Subtract (C-)”). 
Counted relative to the ini-
tial value of the OLTC step 
(Ninit) specified by the 
user. When the maximum 
(Nmax) (minimum (Nmin)) 
step is reached, the “Max-
imum step” (max) (“Mini-
mum step” (min)) signal is 
generated. 
It is possible to determine 
“dead” OLTC steps – 
steps which the OLTC 
drive skips without adjust-
ment. The numbers of 
“dead” step are specified 
using settings. When the 
number of the current step 
(Ncurr) is equal to the 
number of the dead step, 
the “Dead step” (D) signal 
is generated. 
Ncurr – state of step coun-
ter 
X – previously formed step 
R signal “return to initial 
step” 

t

t

Ncurr

R

X Ninit

 
C+ signal “add” 

t

t

Ncurr

C+

1 2

 
C- signal “subtract” 

t

t

Ncurr

C-

2 1

 
State of logic outputs for 
settings: 
Minimum step 2 
Dead steps  5 
Maximum step 7 
  

Logical element designed to 
determine the number of the 
current step and issue block-
ing commands in case of 
reaching the maximum and 
minimum OLTC steps. It is 
possible to determine the 
“dead” steps.  
It has the following settings:  
- Maximum value of OLTC 
step 
(Nmax = 1…64, Nmax ≥ 
Nmin); 
- Minimum value of OLTC 
step 
(Nmin = 1…64, Nmax ≥ 
Nmin);  
- Initial value of OLTC step 
(Ninit = 1…64, Nmin ≤ Ninit ≤ 
Nmax, Nmax ≥ Nmin); 
- List of dead step 
(from range Nmin…Nmax) 
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t

t

Ncurr

min

2 ... 5 ... 7

t

max

t

D

 

Cnst

«1»

 

Cnsti, 
where i is ele-
ment number 

Constant “1” 

 

1

Unchangeable parameter  
 

Logical element, at the output 
of which there is always a log-
ical one 

Cnst

«0»

 

 
Cnsti, 

where i is ele-
ment number Constant “0” 

 

0
Unchangeable parameter

 

 

Logical element, at the output 
of which there is always a log-
ical zero 

 

- 
Transfer 
(connector) 

Provides a logical connec-
tion between elements 

It has no settings 

 

 

 


